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Purpose

This guide provides the information that you need to build OLAP models. It
explainsal Hyperion® Integration Server™ OLAP model features and options,
and contains the concepts, processes, procedures, formats, tasks, and examples
that you need to use the Hyperion Integration Server Desktop software.

Audience

Thisguideisfor Hyperion Integration Server database administrators who are
responsible for installing, implementing, and deploying the system.

To use the information in this book, you need the following skills:

Knowledge of where the datafor your business resides; for example, in a
relational database.

Knowledge of how to create and maintain Open Database Connectivity
(ODBC) data sources.

Knowledge of the data requirements for your business, so you can apply the
Hyperion Integration Server product family to your specific application.

A fundamental understanding of Microsoft Windows and basic Microsoft
Windows terminology, such asdialog box, list box, and button. See Microsoft
Windows documentation for more information on these terms.

Experience with the setup and operation of Hyperion® Essbase® OLAP Server.

A basic understanding of multidimensional concepts.

Hyperion Integration Server Desktop OLAP Model User’s Guide M ix
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Document Structure

x H

This document contains the following information:

Chapter 1, “About Hyperion Integration Server,” introduces basic OLAP and
multidimensional concepts and describes how to use the desktop to create OLAP
models.

Chapter 2, “Preparing Relational Data Sources,” describes how to prepare
relational data for transfer to a Hyperion Essbase database.

Chapter 3, “ Creating and Working with OLAP Models,” describes how to openan
OLAP model, connect to OLAP Metadata Catalog and to arelational data source,
and create, save, delete, and print an OLAP model.

Chapter 4, “ Creating the Fact Table, Accounts Dimension, and Time Dimension,”
describes how to create afact table, an accounts dimension, and atime dimension
from one or more tablesin the relational data source.

Chapter 5, “ Creating and Working with Dimensions,” describes how to create and
edit dimensions.

Chapter 6, “Editing Columnsin Dimension Tables and the Fact Table,” describes
how to view and change column properties.

Chapter 7, “Transforming Columns,” describes how to create columns, change
column properties, and transform columns.

Chapter 8, “Joining Dimension Tables,” describes how to create, view, modify,
and delete joins to dimension tables.

Chapter 9, “Creating and Working with Hierarchies,” describes how to create and
edit hierarchies, from defining hierarchy filtersto sorting and transforming datain
ahierarchy.

Glossary, lists and defines key Hyperion Integration Server terms.

Index, lists and defines Hyperion I ntegration Server termsand their page numbers.
In the PDF version of this guide, select an index entry to view the relevant page.

Hyperion Integration Server Desktop OLAP Model User’s Guide
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Sample Applications

The examples used in this book are based on two sample databases provided with
Hyperion Integration Server. The databases are called TBC (external data source)
and TBC_MD (OLAP Metadata Catalog). The TBC_MD OLAP Metadata
Catalog contains a sample OLAP model and a sample metaoutline. The OLAP
model is called TBC Model, and the metaoutline is called TBC Metaoutline.

Note: The capitalization of column and table names in the sample
applications depends on the relational database management
system (RDBMS) that you use.

The person who installs Hyperion I ntegration Server isresponsible for making the
sample databases, the OLAP model, and the metaoutline available to end users. If
any of thefollowing problems occur when you launch Hyperion Integration Server
Desktop, contact the Hyperion Integration Server administrator:

e You cannot find the sample databases, the OLAP model, or the metaoutline.

e You do not have adequate access to the sample databases, the OLAP model,
or the metaoutline.

e You do not see any data in the sample databases.

Related Documentation

Hyperion provides the following documentation for this product:
Hyperion Integration Server documents;

e Hyperion Integration Server Desktop OLAP Metaoutline User’s Guide, for
information about basic multidimensional conceptsand how to design, create,
and maintain one or more metaoutlines based on an OLAP model.

e Hyperion Integration Server System Administrator’s Guide, for information
about how to use OLAP Integration Server, OLAP Metadata Catalog, and
OLAP Command Interface, and about how to create and manage ODBC
connections.

e Hyperion Integration Server Installation Guide, for information about
installing the software, about Hyperion Integration Server directories and
files, and about connecting relational data sourcesto an OLAP Metadata
Catalog.

Hyperion Integration Server Desktop OLAP Model User’s Guide M xi
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Hyperion Essbase OLAP Server documents:

Hyperion Essbase Database Administrator’s Guide, for information about
basic multidimensional concepts and descriptions of how to design, create,
and maintain a Hyperion Essbase database.

Hyperion Essbase QL Interface Guide, for information about the data
sources supported through Hyperion Essbase SQL Interface.

Hyperion Essbase Sporeadsheet Add-in User’s Guide for Excel, for
information about how to use Hyperion Essbase Spreadsheet Add-in with
Microsoft Excel.

Hyperion Essbase Soreadsheet Add-in User’s Guide for 1-2-3, for
information about how to use Hyperion Essbase Spreadsheet Add-in with
Lotus 1-2-3 for Windows.

The online Technical Reference in the pocs directory for information about
Hyperion Essbase calculation and report commands and functions.

Online Help

» To access online help:

1.
2.

Inadialog box, click Help.
In the help dialog box, to display information about an item, click the item.

» To print an online help topic, display the topic and select File > Print.

Online Guides

The online guides are electronic versions of the printed documentation.

xii

» Todisplay an online guide, select Help > Help Topics.

Hyperion Integration Server Desktop OLAP Model User’s Guide
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The following table shows the conventions used in this document:

Table i: Conventions Used in This Document

Item Meaning

> Arrows indicate the beginning of a procedure consisting
of sequential steps.

Brackets|] In examples, brackets indicate that the enclosed elements
are optional.

Bold Bold text indicates words or characters that you type

exactly asthey appear on the page. Bold in procedural
steps highlights major interface elements.

CAPITAL LETTERS

Capital letters denote commands and various IDs.
(Example: LOADALL command)

Example text

Courier font indicates that the material shown isacode or
syntax example.

Ctrl +0

Keystroke combinations shown with the plus symbol (+)
indicate that you should press the first key and hold it
while you press the next key. Do not type the + symbol.

Courier italics

Courier italic text indicates avariable field in command
syntax. Substitute avalue in place of the variable shownin
Courier italics.

Italics Italicsin a product-related term indicates that the term is
also included in the glossary of the book.
Ellipses(...) Ellipsis points indicate that text has been omitted from an

example.

Mouse orientation

This document provides examples and procedures using
aright-handed mouse. If you use a left-handed mouse,
adjust the procedures accordingly.

Hyperion Integration Server Desktop OLAP Model User’s Guide
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Table i: Conventions Used in This Document (Continued)

Item Meaning

Menu options Options in menus are shown in the following format:
Menu name > Menu command > Extended menu command
For example:

Connections > OLAP Metadata Catalog > Connect

n, X The variable n indicates that you must supply ageneric
number; the variable x indicates that you must supply a
generic letter.

Note: Theterm right-click, used throughout this guide, means to click the
secondary mouse button to open a pop-up menu.

Additional Support

In addition to providing documentation and online help, Hyperion offers the
following support for product information:

Ordering Documentation

Y ou can order additional copies of printed documentation through your local
support office.

xiv Hyperion Integration Server Desktop OLAP Model User’s Guide
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Training Services

Hyperion offers avariety of training options, including instructor-led training,
custom training, and multimedia training. Thistraining covers all Hyperion
applications and technologies and is geared to end users, administrators, and
information systems (1S) professionals.

Instructor-led training isdelivered in formats and in locations suited to Hyperion's
diverse, global customers. Hyperion Authorized Training Centers offer courses
that they develop, as well as those developed by Hyperion. Custom training—
training on the configured and tailored applications that employees use on the
job—is another option to enhance user productivity and to ensure smooth
day-to-day operations. Multimedia trai ning—including computer-based training,
Web-based training, and interactive distance learning—provides a cost-effective
means of giving users a hands-on introduction to product features and functions.
Computer-based training (CBT) provides high-quality interactive training at the
user’s convenience, regardless of location.

For more information about training, contact your local training services
representative.

Consulting Services

Hyperion Consulting Services assists customersin maximizing the use of, and the
return on investment in, Hyperion products. Experienced Hyperion consultants
and Hyperion Alliance Partners assist organizations in tailoring solutions to their
particular requirements, such as reporting, analysis, modeling, and planning.
Specific services include implementation consulting, custom business solutions,
dataintegration, and technical consulting. Additionally, Hyperion offersavariety
of Services Packages and Reviews.

For more information about Consulting Services, Services Packages, and
Reviews, as well as the services offered by Alliance Partners, contact your loca
consulting services representative.

Hyperion Integration Server Desktop OLAP Model User’s Guide H xv



Preface

Technical Support

Hyperion provides tel ephone and Web-based support to ensure that clientsresolve
product issues quickly and accurately. This support is available for all Hyperion
products at no additional cost to clients with a current maintenance agreement.

When standard support does not meet specific requirements, a Hyperion support
package that meets your needs usually can be designed. For more information,
contact your local support office.

xvi l Hyperion Integration Server Desktop OLAP Model User’s Guide



About Hyperion
Integration Server

Hyperion Integration Server provides a suite of graphical tools that you use to
create OLAP models and metaoutlines. Y ou usetablesin arelational data source
to define alogical model that representsthe datain an online analytical processing
(OLAP) context. Y ou then usethe OL AP model to create ametaoutlinethat serves
as atemplate for a Hyperion Essbase database outline.

This chapter explains basic OL AP concepts, provides an overview of Hyperion
Integration Server, describes OL AP models, and definesthe workflow for creating
OLAP models.

This chapter contains the following topics:

e “About OLAP’ on page 1-2

e “About Multidimensional Databases’ on page 1-3
e “About Hyperion Integration Server” on page 1-5
e “About OLAP Models’ on page 1-10

Hyperion Integration Server Desktop OLAP Model User’s Guide m 11



About Hyperion Integration Server

About OLAP

1-2 |

OLAP isadecision-support computing environment for business managers who
need to analyze consolidated enterprise datain real time. OLAP enables usersto
answer complex “what if” questions and to create sales and marketing scenariosto
test budgeting, sales promotion, and sales planning strategies. Hyperion Essbase
OLAP Server supports amultidimensional, multi-user database that enterprise
users can access using standard retrieval tools, such as spreadsheets.

Hyperion Essbase OLAP Server supports multipleviews of datasetsfor userswho
need to analyze relationships between data categories. For example, a
decision-support user might ask the following questions:

e How did Product A sell last month? How does this figure compareto salesin
the same month over the last five years? How did Product A sell by branch,
region, and territory? How will Product A sell next month, next quarter, and
next year?

e Did Product A sell better in particular regions? Do regional trends exist?

e Did customers return Product A last year? Were returns due to product
defects? Did the company manufacture defective products in a specific plant?

e Did commissions and pricing affect how salespeople sold Product A? Did
particular salespeople do a better job of selling the product?

Y ou can use Hyperion Integration Server to create a Hyperion Essbase database
that enables users to answer these types of questions quickly and easily.

Y ou can use Hyperion Integration Server Desktop to create alogical data model
that represents the relational database that contains the data that you want to
analyze. Thus, you take the first step in advancing from arelational database to
a Hyperion Essbase database.

Hyperion Integration Server Desktop OLAP Model User’s Guide
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About Multidimensional Databases

A multidimensional database stores consolidated data at the intersections of its
members and dimensions. For example, if acompany sellsatotal of 20 unitsof all
products in the East region in the first quarter, Hyperion Esshase stores 20 at the
intersection of Product, East, Quarterl, and Unit Sales.

Dimensions represent the core components of a business plan and often relate to
business functions. Product, Region, and Y ear are typical dimensions. In most
databases, dimensions are static, rarely changing over the life of the application.

A member is an individual component of a dimension. For example, Product A,
Product B, and Product C might be members of the Product dimension. Each
member has a unique name. A dimension can contain an unlimited number of
members. In some dimensions, members change frequently over the life of the
application.

Simultaneously, members can be parents of some members and children of other
members. The Hyperion Essbase outline indents members below one another to
indicate a consolidation relationship. For example, sales totals for the Products
dimension might betotalled by product description, broken down by product code,
and further broken down by product ID.

User Interactions with Data

Hyperion Essbase OL AP Server consolidates and calcul ates data to provide
different views of the data. With amultidimensional database, users can do all of
the following:

Consolidate (aggregate or roll up) data

The consolidation process computes the data relationships for all parent and child
combinations within adimension. For example, the consolidation for the Y ear
dimensionisasfollows:

Year = Quarterl + Quarter2 + Quarter3 + Quarter4

A consolidation is typically additive, but it can be any type of calculation.

Hyperion Integration Server Desktop OLAP Model User’s Guide m 13
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1-4 1

Create sophisticated “what if” scenarios

Assumethat you set asalesgoal of ten percent growth for the upcoming year on all
product lines. With Hyperion Essbhase, you can compare sales forecasts estimated
by plannerswith actual salesdata (retrieved from the online transaction processing
(OLTP) database) to see how close you are to achieving your sales goals. If actual
sales run lower than projected sales for a given period, salespeopl e can access the
forecast data, input new product sales scenarios (for example, What if | sell 2000
widgetsto our biggest corporate customer?), update the forecast data, and provide
revised figures to headquarters.

I nput strategic planning assumptions

Assume that your company is planning for 50 percent growth over the next three
years. Y ou have afairly good idea of how many new products you need, but how
do you know how many new engineers, salespeople, and support personnel you
can afford to add while still optimizing profits and gross margin?

With Hyperion Essbase, you can input projected sales and expenses for each
product and calculate downward to determine the cost of goods sold. Thus, you
obtain arealistic picture of the bottom line. If the picture does not look practical,
you can create different scenarios with different mixes of products, people, and
expenses until you produce the profit picture that you require.

Spreadsheet operations

Drilling down or drilling up on data retrieves progressively more detailed or
progressively more generalized datarelative to a selected dimension. Drilling
down on a database dimension provides you with greater detail on the dimension.
Drilling up provides you with a higher level (more summarized) view of the
dimension. For example, you can drill down on the Y ear dimension to view the
values for each quarter. Then you can drill down on Quarterl to view the values
for each month of Quarterl. Y ou can view Quarterl sales for the Chicago office
and then drill up to view salestotals for the entire East region.

Pivoting data alters the data perspective. When Hyperion Essbase retrieves a
dimension, it displays a configuration of rows and columns. A user can pivot
(rearrange) the data to obtain a different viewpoint.

For more information about spreadsheet operations, such as drill down and pivaot,
see the Hyperion Essbase Spreadsheet Add-in User’s Guide for Excel or the
Hyperion Essbase Soreadsheet Add-in User’s Guide for 1-2-3.
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Sources of Data

The datain a multidimensional database can originate from avariety of sources,
such as OL TP databases, text files, and spreadsheet files. OL TP databases contain
awealth of operational data, such as the following:

e How many units of Product A are on hand?
e What isthe current customer’s name, address, and billing status?

e What isan employee's saary, job title, and address?

Datain an OL TP database must be up to date and easy to change and must use as
little space as possible. The datais stored in rows and columnsin relational
database tables.

Hyperion Integration Server enables you to access data for an OLAP model from
adata sourcethat is configured for Open Database Connectivity (ODBC) and that
supports SQL 89 or later.

About Hyperion Integration Server

Hyperion Integration Server transfers data from relational tables to a Hyperion
Essbase database quickly. To perform the transfer, you must determine which
datato transfer and consolidate the selected data into aform that is useful for
decision-support users. Then you must identify the tables, rows, or columns
that contain the data and determine how they map to the structure of the
multidimensional database.

Asillustrated in Figure 1-1, Hyperion Integration Server provides graphical tools
to help you to do the following tasks:

e Usethetables, views, and columnsin arelational databaseto create an OLAP
model. An OLAP model isalogical star schemaconsisting of afact table that
is surrounded by related dimension tables.

e Usethe OLAPmodel to createametaoutline, an outlinetemplate that contains
the structure and the rules required to generate a Hyperion Essbase outline.
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e Usethe metaoutline to create and populate a Hyperion Essbase database.

Relational Data Source

CLAP MWodel
—
- — Metaoutline
— 1 T —
B 5 MARKETS

—1
I MARKETS
B 5 ACCOUNTS

O PROFIT

O RATIOS ‘

Hyperion Essbase Database

Figure 1-1: Workflow for Creating a Hyperion Essbase Database
from a Relational Data Source
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Components of Hyperion Integration Server

Hyperion Integration Server, pictured in Figure 1-2, consists of two major
components: Hyperion Integration Server Desktop and OLAP Integration Server.

Hyperion Integration Server

Hyperion Integration Server Desktop
OLAP Model OLAP Metaoutline
L Assistarts and | S.gk;;HKET.HEGIDN
— —r— | Standard User | 5 55 measures
Interface O Prafit
— —l o Ratios
TCRIP
OLAP Integration TCRIP
Server 0

| Hyperion
Esshase Server

TCPRAP

Relational
Data Source

OLAP Command
Interface

I

OLAP Metadata

Catalog Hyperion Essbase

Database

Figure 1-2: Hyperion Integration Server

Hyperion Integration Server Desktop

Hyperion Integration Server Desktop, a graphical user interface, is used for
creating OLAP models and metatoutlines. Hyperion Integration Server Desktop
includes the following subcomponents:

e OLAP Model Assistant: A wizard for building centralized and reusable
OLAP models that are based on arelational data source. The relational data
source consists of the tables and views in asingle relational database and
contains the data that you want to report in Hyperion Essbase.
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Use OLAP Model Assistant to create abasic OL AP model. For more complex
model-building functions, such as recursive self-joins, use the standard
Hyperion Integration Server Desktop user interface. Use the OLAP models
that you create from information in the relational data source to build one or
more metaoutlines.

e OLAP Metaoutline Assistant: A wizard for creating one or more
metaoutlines from an OLAP model. A metaoutline determines the structure
and content of the final Hyperion Essbase database outline.

Use OLAP Metaoutline Assistant to create a basic metaoutline. For more
complex metaoutline functions, such as scheduling member loads, use the
standard Hyperion Integration Server Desktop user interface. After you create
ametaoutline, you can build a Hyperion Esshase database and |oad data from
the relational data source directly into the Hyperion Essbase database.

Note: Thisuser’'s guide provides detailed procedures for creating and
editing an OLAP model using the standard user interface. To
create an OLAP model using OLAP Model Assistant, refer to
“Working in OLAP Model Assistant” on page 3-7 (or click
Overview in the Welcome dialog box), the assistant online help,
and the inline help that appears within each assistant tab.

e Hyperion Integration Server Desktop standard user interface: A
graphical user interface for creating OLAP models and metaoutlines. Use the
standard user interface to perform advanced functions, such as performing
recursive self-joinsin an OLAP model or scheduling member loads for a
metaoutline.

To create an OLAP model using the standard user interface, you must connect
to OLAP Metadata Catalog and the relational data source. For more
information, see Chapter 3, “ Creating and Working with OLAP Models.”
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OLAP Integration Server

OLAP Integration Server isthe primary component of Hyperion Integration
Server. OLAP Integration Server is software that uses the information stored in
OLAP Metadata Catal og to extract from the relational data source the dimension
and member names needed to build an associated Hyperion Essbase outline. When
the Hyperion Essbase outline is complete, OLAP Integration Server extracts data
fromtherelational data source, performs the operations specified in the associated
metaoutline, and loads the data into the Hyperion Essbase database. For more
information about OL AP Integration Server, see the Hyperion Integration Server
System Administrator’s Guide.

OLAP Integration Server includes the following subcomponents, asillustrated in
Figure 1-2:

e OLAP Metadata Catalog: An SQL relational database that contains the
following information:

— Maetadata describing the nature, source, location, and type of datato
retrieve from the relational data source

— Maetadata describing the information required to generate a Hyperion
Essbase outline

— OLAP models and metaoutlines

Y ou can create more than one OLAP Metadata Catalog to store OLAP
models and metaoutlines. However, you cannot move OLAP modelsand
metaoutlines to a different OLAP Metadata Catal og after you have
created and saved them to a specific catal og.

The OLAP Metadata Catalog is adata source that is configured for Open
Database Connectivity (ODBC). If you do not know how to create an ODBC
data source, see the Hyperion Integration Server Installation Guide or the
ODBC user documentation.

e OLAP Command Interface: A command-line tool used to access OLAP
Integration Server to perform operations on the Hyperion Essbase outline and
the datain the Hyperion Essbase database. For more information, see the
Hyperion Integration Server System Administrator’s Guide.
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Workflow for Using Hyperion Integration Server

Figure 1-2 provides an overview of the Hyperion Integration Server components
that you use to prepare the relational datafor OLAP reporting through Hyperion
Essbase OLAP Server.

To create a Hyperion Essbase database from arelational data source:

1. Buildan OLAP model that is based on the tablesin the relational data source.
OLAP Integration Server stores the OLAP model and the information
necessary to retrieve the relevant tables in OLAP Metadata Catal og.

2. Create ametaoutline from the OLAP model. OLAP Integration Server stores
the metaoutline in OLAP Metadata Catal og.

Load members and data into the Hyperion Essbhase database.
4. Update the Hyperion Essbase database with new members and data.

About OLAP Models

An OLAP model contains astar schema. OLAP models are based on the idea that
valuesin arelationa database can be categorized as either facts or dimensions of
facts. Facts are the numeric, variable values in the database, such as sales figures
and numbers of units sold. Associated with facts are related data values that
provide additional information, such as store locations and product 1Ds of units
sold. An OLAP model contains afact table, one or more dimension tables, and one
or more dimension branches. An OLAP model may contain time and accounts
dimensions.

About Hyperion Integration Server OLAP Models

Unlike other integration products, Hyperion Integration Server creates an OLAP
model that isalogical model, not aphysical star schema. The OLAP model is
alogical representation of the data values that you select from the tablesin the
relational database and that you want to report in Hyperion Essbase.
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The OLAP model included with Hyperion Integration Server, TBC Model,
contains the components shown in Figure 1-3.

* . Hyperion Integration Server Desktop - [TBC Model] M= 3
::= File Edit “iew Connections Toolz ‘Window Help _|ﬁ||1|
DEE| &= @ L 2

TBCATTRIBUTE_PACKAGE
TBCATTRIBUTE_REGION
TBCATTRIBUTE_SIZE

TBCATTRIBUTE_STATE |
TBL.FACT_TABLE
@ vear |

TBC.LOOKUP_MARKET
TEC.LOOKUP_PRODUCT M
&-E3 TEC.LOOKUP_SCENARID
&-EJ TBC.LOOKUP_TIME

1 FACT_TABLE

[ Product _____|

TBCATTRIBUTE_OUNCES j

8 Accounts

.

| Drata Source: the
Faor Help, press F1 |DLAF' Catalog: TBC_MD i

Dimension Table Fact Table Join

Figure 1-3: Sample OLAP Model

About OLAP Models and Metaoutlines

Y ou use an OLAP model to create one or more metaoutlines. A metaoutline
contains the basic structure required to build aHyperion Essbase outline and load
datainto Hyperion Essbase. Y ou can use one OLAP model asthe basisfor another
OLAP model by saving the original OLAP model under a different name and
editing it as needed to meet reporting requirements. Y ou can create any number of
OLAP models for use in building metaoutlines. However, each metaoutline is
based on one, specific OLAP model.
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OLAP models have the following features:

e Theyarereusable. You can usethe same OLAP model asthe basisfor multiple
metaoutlines.

e They provide alayer of abstraction that insulates the Hyperion Essbase
database outline from changesin the relational database.

e They enable you to create hierarchies to structure and summarize datafrom a
relational database. You can use the hierarchies in multiple metaoutlines.

About the Fact Table

The fact table serves as a container for al numeric facts (for the measures
datavaluesthat vary over time). In the OLAP model shownin Figure 1-3, the fact
table consists of the FACT_TABLE relationa table, atable that contains sales
figures, cost of goods sold figures, opening and ending inventory quantities, and
other variable measures data columns.

About Dimension Tables

Dimension tables, such as the Market and Product dimension tables shown in
Figure 1-3, serve ascontainersfor relational tables. Each dimension table contains
datathat isrelated to the factsin thefact table. For example, the Product dimension
table in the sample OLAP model contains arelationa table in which the
PRODUCTID, PRODUCT_GROUP_ID, PRODUCT_DESC (description), and
PRODUCT_GROUP_DESC (product group description) are related to the sales
figures and inventory quantitiesin the fact table.

When a dimension table joins to the fact table, the dimension table and all
dimension tables joined to it form adimension. A dimension in an OLAP model
represents a dimension that you want to report in Hyperion Essbase. For more
information on Hyperion Esshase dimensions, see “ About Multidimensional
Databases’ on page 1-3.

When you create adimension in an OLAP model, the dimension becomes
available for use in creating a dimension in an associated metaoutline. Y ou can
drag a predefined OLAP model dimension directly into the metaoutline to create
adimension. The newly created metaoutline dimension then becomes adimension
in the Hyperion Essbase outline that you create when you perform a member or
dataload.
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When you build ametaoutline, you can create user-defined dimensions that do not
exist in the associated OLAP model. Use this option when you need a dimension,
such as Scenario, that does not exist in the relational data source. If you create a
Scenario dimension, you can add both Actual and Budget members to track
measures, such as actual and projected revenue and profit, that may not be stored
in the relational data source. For more information on user-defined dimensions,
see the Hyperion Integration Server Desktop OLAP Metaoutline User’s Guide.

Workflow for Creating an OLAP Model

Before you can create an OLAP model, you must have the following in place:
e A running and properly prepared external data source

e The OLAP Metadata Catalog where you want to store the model that you
create

e A server that isrunning OLAP Integration Server
See the Hyperion Integration Server System Administrator’s Guide.

For more information on making the appropriate connections, see “Working with
OLAP Models’” on page 3-3.

After you make the necessary connections, use the following workflow as
illustrated in Figure 1-4 to create an OLAP model:

1. Start Hyperion Integration Server Desktop and use OLAP Model Assistant or
the standard user interface to create an OLAP model.

See “ Starting Hyperion Integration Server Desktop” on page 3-3 and
“Creating or Editing OLAP Models’ on page 3-4.

2. View alist of sourcetablesin the relational database and select the ones that
you want to use in the OLAP model.

See “Working in the OLAP Model Standard User Interface” on page 3-11.

3. To create an OLAP model that contains a fact table; dimension tables;
dimension branches; and optional time, accounts, and standard dimensions,
drag source tables from the left frame to the right frame.

See Chapter 4, “Creating the Fact Table, Accounts Dimension, and Time
Dimension” and Chapter 5, “ Creating and Working with Dimensions.”
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If required, edit existing dimensions and dimension tables by moving,
renaming, or deleting them.

See Chapter 5, “Creating and Working with Dimensions.”

If required, edit existing columns by creating, transforming, or changing
properties, or by deleting the columns.

See Chapter 6, “Editing Columns in Dimension Tables and the Fact Table”
and Chapter 7, “ Transforming Columns.”

Asnecessary, perform joins, including joining each dimension table to the fact
table and joining each additional dimension table to a primary dimension
table, and, for recursive dimensions, joining adimension table to itself. If
tables are properly joined in the data source, you may not need to specify the
joins again.

See Chapter 8, “Joining Dimension Tables.”

As necessary, organize dimension table columns into hierarchies to define
how Hyperion Essbase consolidates dimensions. When you create ahierarchy,
you can filter, sort, and transform the data in the hierarchy.

See Chapter 9, “Creating and Working with Hierarchies.”
Validate and save the OLAP mode.
See “Validating OLAP Models Manually” on page 3-18.
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When you are finished, you have a completed OLAP model stored in an OLAP
Metadata Catalog. Y ou use the OLAP model to create a metaoutline, as described
in the Hyperion Integration Server Desktop OLAP Metaoutline User’s Guide.
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Figure 1-4: OLAP Model Workflow
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Preparing Relational
Data Sources

An OLAP model isadimensional model of relational datain the form of a star
schema. Before you can create an effective OLAP model, you need to understand
and define the business needs and data sources that you have available. Y ou may

need to modify some data sources to make the transition from relational to

multidimensional as easy and efficient as possible.

For information about creating an OLAP model, see Chapter 3, “ Creating and

Working with OLAP Models.”

This chapter contains the following topics to help you prepare relational data:

“Defining User Needs’ on page 2-2

“Defining Data Sources’ on page 2-3

“Consolidating Data into a Single Data Source” on page 2-4
“Cleansing Data’ on page 2-6

“Creating Views and Tables’ on page 2-6

“Joining Tables’ on page 2-13

“Creating Indexes’ on page 2-14

“Transforming Data’ on page 2-14

“Deciding Which Tables Are Available to OLAP Model Creators’ on
page 2-16

“Creating Time and Accounts Dimensions’ on page 2-20
“Accessing Tablesin OLAP Metadata Catalog” on page 2-23
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Defining User Needs

22

Before you start to design an OLAP model, consider the questions in this topic.
By carefully defining answers to these questions, you begin to create an effective
OLAP model.

Remember that, when you create an OLAP model, the ultimate goal isto create a
multidimensional Hyperion Essbase database. This topic assumes that you are
familiar with the design principles for a multidimensional database. For more
information, see“ About OLAP” on page 1-2 and the Hyperion Essbase Database
Administrator’s Guide.

What information (data) do userswant to seein the Hyperion Essbase
database?

Examples of types of information are orders, sales, invoices, and the general
ledger. Select data by combining an understanding of the business with an
understanding of what datais available. After reviewing the data that you select,
you decide whether to create one or multiple Hyperion Essbase databases.

What isthe maximum level of detail of data that userswant to seein the
Hyperion Essbase database?

Select the level of detail by combining an understanding of the business with an
understanding of the performance requirements of the Hyperion Essbase database.
(In general, the less detail stored in the Hyperion Essbase database, the faster the
performance.) For example, you can opt to store datathat is aggregated by quarter
or by month. The level of detail that you select isthe basic level of detail that you
represent in the fact table. In an OLAP model, the fact table is where the numeric
measurements of the business are represented.

What dimensions apply to each fact table row?

A dimension is a data category. Typical dimensions are Product, Geography, and
Time. Base the selection of dimensions on an understanding of how users want to
view data. Each dimension hasanumber of members. For exampl e, the Geography
dimension can include members representing New Y ork, Boston, San Francisco,
and Los Angeles. Each row in the fact table represents a combination of members,
one from each dimension. For example, arow in the fact table can store the sales
for Product A in New York in February.
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What measures do you want to represent in the fact table?

Measures are numeric quantities that vary over time. Examples of measures are
guantity sold, cost of goods sold, and profit. Not all numeric values are measures.
For example, although product size is a numeric value, you probably prefer to
represent it as amember of a product dimension rather than as a member of a
measures dimension because users do not want to compare product size over time.

Defining Data Sources

Now that you have defined what data users want to see in the Hyperion Essbase
database, you need to define the data sources. Consider the following questions:

e Isthedataclean? Consider the quality and integrity of the source data. For
more information, see “ Cleansing Data’ on page 2-6.

e Isthedatacalculated by a procedure and not stored; for example, a discount
figurethat is calculated for a specific product at a specific time? You need to
create such information as tables in the chosen relational database
management system (RDBMS). Consider creating a staging areato perform
this task. See “ Deciding Whether to Create a Staging Area” on page 2-4.

e Isthedatain asingle structured query language (SQL) database?

e Isthedatain multiple SQL data sources? OLAP Integration Server does not
access multiple SQL sources; you must consolidate SQL tablesinto asingle
SQL data source in the chosen RDBMS.

e Isthedatainflat files? OLAP Integration Server does not accessflat files; you
need to create flat files as tables in the chosen RDBMS. Consider creating a
staging areato perform this task. See “ Deciding Whether to Create a Staging
Area’ on page 2-4.
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Consolidating Data into a Single Data Source

When you create an OLAP model, al the data that you need must bein asingle
SQL data source.

If al datais not in asingle data source, you need to take the following steps:

1. Select atarget RDBMS to connect to the server running OLAP Integration
Server. For alist of supported RDBM Ss, seethe Hyperion Integration Server
Installation Guide.

2. Create any datathat does not exist as an SQL data source; for example, create
relational tablesin the chosen RDBM Sfor any information that iscurrently in
flat files.

3. Consolidate the data source tables into a single database in the chosen
RDBMS.

When you consolidate the data, you may want to create a staging area.

Deciding Whether to Create a Staging Area

2-4 1

A staging area is an RDBMS database that you create to meet the needs of a
specific application. Typically, a staging areais small (a maximum of 1-2 GB)
in comparison to a data warehouse or online transaction processing (OLTP)
application. It is a snapshot of data. In other words, it is not constantly updated
with new data but is refreshed periodically from source data.

Using a staging area provides advantages because you can use a staging areato do
any of the following:

e Combine data from heterogeneous platforms without changing the original
datain the RDBMS. For example, you can combine data from various
RDBMSs and flat files.

e Fine-tune datafor a specific application. For example, you can calculate a
subset of the RDBM S data and store the calculated datain astaging area. You
can then run faster queries on the pre-calcul ated data in the staging area.

e Create tables or views to denormalize the data so that it maps more easily to
an OLAP model (see“Creating Views and Tables’ on page 2-6).
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e Transform datathat isnot consistently described (see” Transforming Data’ on
page 2-14).
e Prepare datain the staging areafor issues related to the year 2000. Year-2000

issues may occur if the RDBM S storesthe year astwo digits (for example, 99)
and not four digits (for example, 1999).

The disadvantage of using astaging areais that the data in the staging areaisa
snapshot and may not represent the current data.

Figure 2-1 shows astaging area as part of adatawarehouse. Datais copied into the
staging areafrom the RDBM S source data and converted from flat files and other

RDBMS sources.
RDEMS RDEMS

9: 9:

Data Cleansing

$

Data Consistency

Staging Area

OLAP Integration Server <:>

Hyperion Essbase Database

Figure 2-1: Data Warehouse with Staging Area
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Cleansing Data

OLAP Integration Server does not cleanse invalid data for you. Data needs
cleansing if it isinconsistent. Inconsistent data may include values that are
incorrect, are not of the correct data type, or do not match integrity constraints
(containing rowsthat do not have entriesfor the required key columns). Also, data
may be inconsistent because the same valueis entered in different forms. Such an
inconsistency occurs, for example, when datais drawn from more than one source
or when users enter data incorrectly.

If source datais inconsistent, you need to fix, or cleanse, the data. Cleansing
data may be a simple process, such as making suspect datainto nulls, or amore
complex processthat requiresthe use of adatacleansing tool. Similar datarequires
similar cleansing rules.

Creating Views and Tables

26

OLAP Integration Server does not distinguish between the tables and the views of
an RDBMS; you can use either tablesor viewsto create an OLAP model. Y ou may
want to create views or tables specifically for use with OLAP Integration Server
to provide security and convenience and to make the transition from relational to
multidimensional as efficient as possible.

Consider creating views or new tables if you want do either of the following:

e Build aHyperion Essbase hierarchy down to a specific level in arecursive
table. See“Building Hyperion Essbase Hierarchiesfrom Recursive Tables’ on

page 2-8.
e Create diasesin the Hyperion Essbase database from data stored in multiple

columns in the source data tables. See “Creating Aliases for Dimension and
Member Names” on page 2-19.

Also consider creating views or tablesif the source tables meet any of the
following criteria

e Contain any unions. OLAP Integration Server does not generate SQL for
unions. See “Removing Unions’ on page 2-10.

e Havecolumnsthat you want to transpose to rows. See “ Transposing Columns
and Rows’ on page 2-10.
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e Areinapackaged application. If the source tables are in a packaged
application, you may not know which tables contain the data that you need
because table names may not be meaningful in business terms. You probably
need to ask an application specialist to create the required tables and views
(with meaningful names) in a staging area in the target RDBMS. See
“Deciding Whether to Create a Staging Area’ on page 2-4.

e Arehighly normalized. Normalized datais appropriately grouped and does
not include redundant data. Consider denormalizing data to facilitate the
transition of the data to a Hyperion Essbase database. See “Denormalizing
Source Data Tables’ on page 2-12.

Deciding Whether to Create a View or a
New Table

In most cases, you create views of the relational data (instead of new tables)
because views ensure that dataiis current and efficiently stored and that you do not
need to maintain two sets of the same data.

When deciding whether to create a view and or whether to create a new table
consider the following questions:

e Doesthedataaready exist? If the datadoes not exist, you need to create anew
table. See “ Consolidating Datainto a Single Data Source” on page 2-4.

e Do youwant to index columns that are not indexed in the source RDBM S
table? You need to create a new table because you cannot index columnsin a
view. See “Creating Indexes’ on page 2-14.

e Do youwant to index columns that contain data that you need to
transform? Because many RDBM Ss ignhore indexes on columns that have
transformations, you probably need to create anew table. See “ Transforming
Data’ on page 2-14.

If you are using astaging area, you create tables and viewsin the staging area. See
“Deciding Whether to Create a Staging Ared’ on page 2-4.
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Building Hyperion Essbase Hierarchies from
Recursive Tables

28

A recursive table contains information in one row that is a parent or child of
information in a second row. OLAP Integration Server can build Hyperion
Essbase outline hierarchies from a recursive source table.

When creating a Hyperion Esshase hierarchy from arecursive table, use the
following guidelines:

e To associate aliases or user-defined attributes (UDAS) with members created
from arecursive table, ensure that the column with which you will associate
the alias or UDA, isfully defined. See “Creating Aliases or UDAsfor
Membersin a Recursive Table” on page 2-8.

e When creating an OLAP model, join the recursive table to itself. For more
information and for an example of arecursive source table, see “ About
Recursive Tables’ on page 9-4 and “ Defining a Recursive Table” on
page 8-15.

e When creating a metaoutline, select the parent or child column that you want
tofilter on asamember level inthe metaputline. See the Hyperion Integration
Server Desktop OLAP Metaoutline User’s Guide.

Building a Hierarchy Down to a Specific Level

To build the Hyperion Essbase outline down to a specific level, you need to create
aview that contains data for only the levels that you want to build.

Creating Aliases or UDAs for Members in a
Recursive Table

When you create a Hyperion Essbase outline, you can associate aliases or UDAS
with members in the outline.

If you are working with arecursive source table and you want to associate aliases
or UDAswith members created from the recursive source table, you may need to
preparethe data. The stepsthat you need to taketo associate aliasesor UDAsvary,
depending on whether the alias or UDA datais contained in the recursive source
table or in a separate table.
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If thealias or UDA dataisin a separatetable, you need to complete specific
stepswhen creating an OLAP model. The stepsthat you complete vary, depending
on whether the column, with which you are associating the alias or UDA, isfully
defined (see Table 2-1 and Table 2-2). For more information on the specific steps,
see “Preparing Recursive Tables to Be Used with Aliases and User-Defined
Attributes’ on page 8-16.

If thealiasor UDA dataisin therecursive sourcetable, you need to complete
specific steps when creating the OLAP model. The column with which you
associatethealiasor UDA must befully defined, and all aliasor UDA information
must relate to the fully defined column:

I f you want to associatean aliasor UDA with theparent column of arecursive
table, the parent column must be fully defined. A recursive table parent column
is fully defined when the parent column contains every value (every member
proposed for the Hyperion Essbase hierarchy). Thus the parent column contains
the lowest-level value in the hierarchy with aNULL value in the child column.
In Table 2-1, the GEO_PARENT column is fully defined because the
GEO_PARENT column contains the lowest-level value, 01010, withaNULL
child in the GEO_CHILD column.

Table 2-1: Fully Defined Parent Column

GEO_CHILD GEO_PARENT
East USA

Maine East

Bangor Maine

01010 Bangor
<NULL> 01010

If you want to associate an aliasor UDA with the child column in arecursive
table, the child column must be fully defined. A recursive table child column is
fully defined when the child column contains every value (every member proposed
for the Hyperion Essbase hierarchy). Thus the child column contains the
highest-level value in the hierarchy, with aNULL valuein the parent column.
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In Table 2-2, the GEO_CHILD columnisfully defined becausethe GEO_CHILD
column contains the highest-level value, USA, with aNULL parent in the
GEO_PARENT column.

Table 2-2: Fully Defined Child Column

GEO_CHILD GEO_PARENT
USA <NULL>

East USA

Maine East

Bangor Maine

01010 Bangor

For more information on the specific steps that you need to perform, see
“Preparing Recursive Tables to Be Used with Aliases and User-Defined
Attributes’ on page 8-16.

Removing Unions

OLAP Integration Server does not generate SQL for unions. A union is atype of
join that combinesthe results of two SELECT statements. A unionis often used to
merge lists of values that are contained in two tables. If the source tables use
unions, you need to create aview (or views) of the datathat does not use the unions
before you can start to work with the datain OLAP Integration Server. For more
information on unions, see the RDBM S documentation.

Transposing Columns and Rows
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If you need to transpose columns and rows so that you can more easily transition
data from a data source to a Hyperion Essbase database, transpose the columns
before you start to work with the datain OLAP Integration Server. For example,
if you want to create multiple Hyperion Essbase members from asingle relational
database column, you can create anew table or view that transposes row valuesto
column values.

Consider the following example in which you want to create multiple Hyperion
Essbase measures (Init_Sales, Subsequent_Sales, and Return_Sales) fromasingle
database column (SALESTY PE).
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The SALESACTUAL S table contains the following columns:

Table 2-3: SALESACTUALS Table

PRODID | MKTID TIMEID MONTH SALESTYPE PRODID
100 2 01-01-1999 100.00 | Sales 100
100 2 01-02-1999 10.00 | Returns 100
100 2 01-03-1999 50.00 | Subsequent 100
100 2 01-04-1999 20.00 | Returns 100
100 2 01-01-1999 100.00 | Sales 100

Y ou want to create the Hyperion Essbase outline in the hierarchy illustrated in
Figure 2-2:

[~ Accounts Accounts
[~]Sales

Init_Sales
Subseguent_Sales

Return_Sales

Figure 2-2: Accounts Hierarchy

Y ou want each SALESTY PE value to form the Hyperion Essbase member:
SALES to form the Init_Sales member, RETURNS to form the Return_Sales
member, and SUBSEQUENT to form the Subsequent_Sales member. To achieve
these goals, create aview or anew table that transposes row values into column
values. This example produces the following table:

Table 2-4: View of SALESACTUALS Table with Transposed Columns

PRODID | MKTID | TIMEID INITSALES | RETURNS | SUBSEQUENT

100 2 01-01-1999 100.00 0.00 0.00
100 2 01-02-1999 0.00 10.00 0.00
100 2 01-03-1999 0.00 0.00 50.00
100 2 01-04-1999 0.00 20.00 0.00
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The following example of Oracle SQL defines the view shown in Table 2-4:

Create view SalesActuals_vw as
(Select ProdId, MktId, Timeld,
decode (SalesType, ’'Sales’, Sales, 0) "InitSales",
decode (SalesType, ’'Returns’, Sales, 0) "Returns",
decode (SalesType, ’Subsequent’, Sales, 0)"Subsequent" from
SalesActuals

For moreinformation on using SQL to define views, seethe documentation for the
RDBMS that you use.

When you have defined a new table or view, useit to create an OLAP model.

Denormalizing Source Data Tables

If datais highly normalized, it may not map clearly to an OLAP model.
Normalized datais appropriately grouped and does not include redundant data.
Even though you can use normalized source tables to create an OLAP model by
specifying joins (see Chapter 8, “Joining Dimension Tables"), it may be more
efficient to create a new table of denormalized datain the RDBMS.

Consider thefollowing example. Inthefirst three tables, dataishighly normalized
so that redundant data is minimized:

Table 2-5: Normalized Product Family Data

FAMILYID FAMILYDESC
100 Colas
200 Root Beer

Table 2-6: Normalized Product Data

PRODID FAMILYID
100-10 100
100-20 100
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Table 2-7: Normalized Product Description Data

PRODID PRODDESC
100-10 Cola
100-20 Diet Cola

The following table shows the denormalized data in one table:

Table 2-8: Denormalized Product Data

FAMILYID FAMILYDESC PRODID PRODDESC

100 Colas 100-10 Cola

100 Colas 100-20 Diet Cola

100 Colas 100-30 Caffeine Free Cola
100 Colas 100-10 Cola

If you use the denormalized data source, OLAP Integration Server does not need
to compute the joins when it builds the OLAP model.

Joining Tables

In the data source tables, set up primary and foreign keys to join each of the

following:

e Tablesthat form the fact table. See “ Selecting Tables for the Fact Table” on

page 2-17.

e Tableswithin each dimension branch. See*“ Selecting Tablesfor Dimensions’

on page 2-18.

e Dimension tablesto the tablesin the fact table.

When you join tablesin the RDBMS, OLAP Integration Server automatically
detects the join when it builds the OLAP model.
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Creating Indexes

OLAP Integration Server detects indexes (including bitmapped indexes) that you
have defined on the source tables and uses them to create a Hyperion Essbase
outline and to load data. Indexes are pointers that are logically arranged by the
values of akey. Indexes optimize accessto relational data. Bitmapped indexes are
specialized indexes that may improve performance during analysis of numeric
data.

Y ou can significantly improve performance by defining indexes on the appropriate
datain the source tables.

Consider taking the following actions to improve performance:

e Defineindexeson columnsthat you useto filter datain the RDBM S source or
inthe OLAP model. For example, if the source database contains columnsfor
city and state and you filter on city or state (for example, SELECT * FROM
Region WHERE State = Ca$%), then index the columns on which you are
filtering (in this example, the columns Region and State). If you are creating
alias names and you filter on alias names, index the column containing alias
names. For more information on alias names, see the Hyperion Essbase
Database Administrator’s Guide.

e Define bitmapped indexes on numeric data that you use to filter the
database. For example, if you filter on sales values (for example, SELECT
Product FROM ProdSales GROUPBY Product ORDERBY ProdId HAVING
SUM (Sales) >15000), then consider defining a bitmapped index on sales
values. Most RDBM Ss support bitmapped indexes. For more information on
bitmapped indexes, see the documentation for the RDBM S you are using.

Transforming Data

2-14 1

Y ou may heed to transform some of the data, for example, to change date formats
or to ensure that data is described consistently. Assume that you want to create an
OLAP model that combines data from the sales databases and data from the
financial databases. If the sales databases specify New Y ork asNew_Y ork and the
financial databases specify New York asNY, you cantransformNY to New_Y ork
inthe staging area (see“ Deciding Whether to Create a Staging Area’ on page 2-4)
without changing the datain the original financial databases.
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Y ou can do some data transformations in OLAP models and metatoutlines.

For acomplete list of available transformations, see Chapter 7, “ Transforming
Columns,” and the Hyperion Integration Server Desktop OLAP Metaoutline
User’s Guide. However, if you need to do significant transformations on the data,
you may want to use a data transformation tool before you use the datain OLAP
Integration Server.

Transformations that you need to perform in the RDBMS, and not in Hyperion
Integration Server, include the following:

e The most frequently accessed transformations. For example, assume that
you want the Hyperion Essbase database outline to have members for
Year, Qtr, and Month and that the data source table contains a column
caled TRANSDATE. TRANSDATE holds the transaction date for each row.
Transform the dataahead of time, creating anew sourcetablethat containsthe
columns YEAR, QTR, and MONTH. The new columns contain the data
transformed from the TRANSDATE column. You can thenindex the YEAR,
QTR, and MONTH columns to improve performance.

Note: Many RDBM Ssignore indexes on columns that have
transformations. You need to transform the data and create a
physical table with new columns that can be indexed.

e Transformationsto take the intelligence out of key columns. Some key
columns may include categories of information that you want to split out
before using the datain OLAP Integration Server. For example, if the source
table has a PRODID column containing product identification information,
transform the datain the RDBM S so that it maps to the data categories that
you want to display in the Hyperion Essbase outline. In Figure 2-3, for
example, the categories are CUSTID, STATE and PRODNUM.

C0001-52-95124

CustlD 4 T \— Prodhum

State

Figure 2-3: Transforming a Product Code Stored in a PRODID Column
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Deciding Which Tables Are Availableto
OLAP Model Creators

2-16 W

When you connect to the source database, OL AP Integration Server displaysinthe
left frame all tables to which the RDBM S user ID provides you access (SELECT
permission).

For all RDBMSs, if you have partial accessto atable, OLAP Integration Server
displays the whole table. (For example, if you have SELECT permission for only
half of the columnsin atable, you can seethe wholetable.) However, inthe OLAP
model, do not use a column to which you do not have SELECT permission. OLAP
Integration Server cannot filter, dataload, or member load a column for which you
do not have SELECT permission.

Note: For DB2, OLAP Integration Server displays all tablesthat are in the
database, irrespective of whether you have accessto them. However,
if you do not have access (SELECT permission) to atable, you cannot
view the columns in the table or use the table to build an OLAP
model.

For added security and ease of administration, you may want to define which
tables users can see by doing one or more of the following:

e Creating specific RDBMS user I Dsfor users who are creating OLAP models.

e Creating views of some data and providing users who are creating OLAP
models with access to the views rather than access to the original tables.

e Using conditions to restrict aview so that users who are creating an OLAP
model can see only asubset of the view. For example, you can restrict theview
to show dataonly for the current year although the table contains datafor three
years. For more information on adding restrictive conditions, see the
documentation for the RDBM S that you use.

Note: When you connect to the source database, OLAP Integration Server
provides read-only access to the source database irrespective of the
access provided by the RDBM S user ID. For example, if the RDBMS
user ID has read-write access, you have only read-only access when
creating OLAP models.
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Selecting Tables for the Fact Table

A facttableisalogical container for therelational tablesthat definethe datavalues
(measures) for each dimension intersection in an OLAP model. For more
information, see “ About the Fact Table” on page 1-12. The type of Hyperion
Essbase database that you want to create determines which source tables you need
toincludein the fact table. See “Defining User Needs’ on page 2-2.

When you select source tables to include in the fact table, consider both how the
datais distributed among the tables and how the data relates to the dimensionsin
the Hyperion Essbase database.

Select atable or tablesthat contain all of the measures data that Hyperion Essbase
end users want to see. For example, if the relational database contains the
following ORDERS and ORDERDETAIL Stables, you need to include both tables
if you want the fact table to include data from both tables.

Table 2-9: ORDERS and ORDERDETAILS Tables for the Fact Table

Orders ORDERID TRANSDATE SHIPID EMPTYID

Order Details | ORDERID PRODID NUMUNITS UTPRICE

Select atable or tables that represent al of the dimensions (data categories) on
which the Hyperion Essbase end users want to analyze data. For example, if end
users need to analyze product sales by time, by geography, and by sales channel,
select atable or tables that contain key columns for each of these dimensions.

Table 2-10: Sales Table for the Fact Table

PRODID | SALES | DATESOLD | CITY CHANNEL | UNTSSOLD

Sales

Note: You canimprove performance by setting up primary and foreign keys
and joining the tablesthat form the fact table. See*“ Joining Tables’ on
page 2-13.
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Selecting Tables for Dimensions

A dimension is adata category. Typica dimensions are Product, Geography,
and Time. A dimension tableisalogical container within an OLAP model.

A dimension table includes one or more relational tables that define a potential
Hyperion Essbase dimension. A dimension table can join to other dimension
tables, forming a dimension branch.

The datathat you want to be available for analysisin the Hyperion Essbase
application that you create determines which source tables you use to create
dimensions. See “Defining User Needs’ on page 2-2. When you select source
tablesfor each dimension, select asourcetable or tables that include the maximum
amount of information about the data category (dimension). For example, if you
have the following PRODUCTS and ORDERS source tables, select the
PRODUCTS table to form the Products dimension.

Table 2-11: ORDERS and PRODUCTS Tables for the Dimension Table

Products PRODID PRODNAME | SIZE COLOR

Orders PRODID PRODNAM ORDERID DATE

The ORDERS table contains product information for only those productsthat have
been sold. The PRODUCT Stable contains data for all products. Thus, Hyperion
Esshase end users can use the PRODUCT Stable information to analyze products
that are or are not selling.
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Creating Aliases for Dimension and
Member Names

Aliases are aternative names for the members and dimensions of a Hyperion
Essbase outline. An aliasis often a more easily identifiable product name or
product description for a column in arelational data source. For example, in

the Hyperion Essbase Sample Basic database, the 200-20 member in the Product
dimension has the alias Diet Root Beer.

If the source data contains information that you want to use to create aliasesin a
Hyperion Essbase outline, include the relevant data as a column in the associated
OLAP moddl.

When you create a metaoutline, you can retrieve alias information from only one
column in the OLAP model. If the alias information in the source datais in more
than one column, do one of the following:

e IntheRDBMS, create aview or anew table to concatenate (and, if necessary,
transform) the aliasinformation into asingle column. Creating a view or new
table may bethe easiest method, especially if thealiasinformationisstoredin
three or more columns.

e Inthe OLAP model, concatenate (and, if necessary, transform) the columns
that contain the alias information. For more information on concatenating and
transforming columns, see Chapter 7, “Transforming Columns.”

e Inthe OLAP model, usethe pass-through feature to run a procedure that uses
RDBMS logic to retrieve dias information from the column or columns that
you specify. For example, you can use the pass-through feature to run a
procedure in DB2. The DB2 procedure uses CASE logic to retrieve alias
information from two different columns; if afield in one column is empty, the
proceduretellsthe RDBM Storetrieve the aliasinformation for that field from
adifferent column.

For more information, see “ Defining Pass-Through Transformations” on
page 7-14. For more information on procedures and CA SE logic, see the
RDBM S documentation.

Note: You can associate one diastablefor each Hyperion Essbase database
that you create using Hyperion Integration Server.
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Creating Time and Accounts Dimensions

In an OLAP model, you can create time and accounts dimensions that carry over
directly to the Hyperion Essbase outline as the dimensions tagged as time and
accounts. The time dimension table contains date-related columns from the
relational data source. The accounts dimension table contains measures columns
that duplicate the columns contained in the fact table.

Preparing Data for Time Analysis

If the busi ness application requirestime-rel ated analysis, such as examining trends
over time or making seasonal sales comparisons, include atime dimension in the
Hyperion Essbase outline. A time dimension includes members for the time
periods that you report on; for example, monthly, quarterly, and yearly sales.

To support atime dimension, the data source should include the following
elements:

e One or more time-related columns associated with measures data. For
example, if you want to report on sales per month and per quarter, one of the
tables that you include in the fact table needs adate column to reflect sales by
month and quarter.

e If needed, one or more tables containing user-defined calendars. A
user-defined calendar maps the time-related column in the fact table
to a specific business calendar.

Associating Time Data with Measures Data

2-20 H

To enable OLAP Integration Server to map the data that you are measuring (such
as sales or costs) to specific time periods (such as month, quarter, or year), the
source data for the fact table must contain one or more time-related columns. For
example, from atransaction date column, you can determine the day, week, and
month in which the associated transaction occurred. Or, the transaction data can
include separate columns for each time period. These time periods are potential
members of the dimension tagged as time.

Hyperion Integration Server Desktop OLAP Model User’s Guide



Preparing Relational Data Sources

Working with Summary Data

If the measures columnsin the source data contain summary data, thetime-related
column must indicate the time period for which the data is summarized. For
example, assume that the SALESINVACT table contains measures columns
SALES and COGS, a date-related column, TRANSDATE, and STATE and
PRODCODE columns that categorize by sales date, state, and product code.

Table 2-12: TBC_MD Data in the SALESINVACT Table

STATE | PRODCODE TRANSDATE SALES | COGS
IL 100-10-C001-S0002-P0O01 Jan 4 1999 12:00AM 672.00 | 217.00
IL 100-10-C001-S0002-P0O01 Feb 4 1999 12:00AM 241.00 | 70.00
IL 100-10-C001-S0002-P0O01 Mar 3 1999 12:00AM 287.00 | 84.00
IL 100-10-C001-S0002-P0O01 Apr 7 1999 12:00AM 295.00 | 85.00
IL 100-10-C001-S0002-P0O01 May 3 1999 12:00AM 702.00 | 207.00

Each row in the SALESINVACT table summarizes product sales and costs for a
particular date for customers from a particular state. Instead of summarizing data
by day, arow can summarize data by other periods; for example, by week or by
month.

Formatting the Date

OLAP Integration Server works with three data types: string, numeric, and
datetime. “ About Column Data Types’ on page 6-3 shows how the basic Open
Database Connectivity (ODBC) data types map to string, numeric, and datetime.
The datetime data type is atimestamp that includesthe year, month, day, and time
of day.

The data type of the source data column that contains time-related data does not
matter. For example, the date can be atimestamp in acolumn with adatetime data
type, or it can be keyed datain a numeric column (for example, 09231999 or
19990923). A string column can contain dates with or without separating
characters such as slashes or periods (for example, 09/23/19990r23.09.1999
or 09231999). Portionsof the date (such asthe day, week, month, or quarter) can
be included in the source data as separate string or numeric columns.
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It isimportant that the values in the time-related columns can be mapped to the
time periods that you want in the time dimension. If dates are stored as datetime
data types and you want quarterly totals, OLAP Integration Server can determine
the quarter. If dates are stored in numeric or string columns and you want quarterly
totals, you must have an explicit column containing the associated quarter for the
data that you want to consolidate.

Working with Data in Similar Time Periods

In certain applications, such as general ledger and legacy systems, tables may be
organized so that columnsidentify similar time periods. For example, asinglerow
may include all months of ayear. In this case, each subsequent row includes a
measure category as a data value; for example, a specific account number.

Table 2-13: Example of a Table Where Columns Define the Time Periods

PRODCODE STATE ACCOUNT | JAN FEB MAR

100-10-C001-S002-P001 AZ Sales 672.00 | 241.00 | 287.00
100-10-C001-S002-P001 AZ COGS 403.00 132.00 177.00
100-10-C001-S002-P001 CA Sales 401.00 143.00 | 378.00
100-10-C001-S002-P001 CA COGS 260.00 101.00 | 226.00
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To create adimension of the typetime, OLAP Integration Server requires that all
time identifiers be in one column and that accounts identifiers be in separate

columns, as shown in Table 2-14. If, for example, datais stored with each month
asan individual column, as shown in Table 2-13, you should restructure the data.
Individual months should be data valuesin aMONTH column, and the measure

categories, such as SALES and COGS, should be separate columns.

Table 2-14: Example of a Table Where Time Periods

Are Stored as Data Values

PRODCODE STATE MONTH SALES COGS
100-10-C001-S002-P001 AZ 1 672.00 403.00
100-10-C001-S002-P001 AZ 2 241.00 132.00
100-10-C001-S002-P001 AZ 3 287.00 177.00
100-10-C001-S002-P001 CA 1 401.00 260.00
100-10-C001-S002-P001 CA 2 143.00 101.00
100-10-C001-S002-P001 CA 3 378.00 226.00
100-10-C001-S002-P001 AZ 1 672.00 403.00

Y ou can write a program to convert the data to a table that uses the appropriate
format or use an RDBMS to transpose the columns (see “ Transposing Columns

and Rows’ on page 2-10).

Accessing Tables in OLAP Metadata Catalog

If you log onwith aparticular user ID whenyou create an OL AP Metadata Catal og
and then log on with adifferent user ID, you cannot access thetablesin the OLAP
Metadata Catal og unless you create an alias for the user 1D (Sybase, SQL Server)
or synonymsfor thetables (DB2, Oracle). For moreinformation, seethe Hyperion
Integration Server Installation Guide.

Y ou must perform adifferent procedure when time measures are stored as columns
that include accounts information, as described in “ Switching the Time and
Accounts Dimensions’ on page 4-15.
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Creating and Working with
OLAP Models

Thischapter describes how to create and work with OL AP model s—from opening
or creating an OLAP model through validating and saving an OLAP model. Before
you read this chapter, read Chapter 1, “About Hyperion Integration Server” to
familiarize yourself with the definition and components of an OLAP model.

This chapter contains the following topics:

“Understanding the OLAP Model Workflow” on page 3-2

“Working with OLAP Models’ on page 3-3

“Working in OLAP Model Assistant” on page 3-7

“Working in the OLAP Model Standard User Interface” on page 3-11
“Validating OLAP Models Manually” on page 3-18

“Saving OLAP Models” on page 3-20

“Printing OLAP Models’ on page 3-29

“Deleting OLAP Models’ on page 3-30
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Understanding the OLAP Model Workflow

Figure 3-1 illustrates the workflow for creating an OLAP model. This workflow
includes creating and working with an OLAP model; creating afact table, an
accounts dimension, and atime dimension; creating and working with dimensions;
editing and transforming the columns of dimension tables; joining dimension
tables; and creating and working with hierarchies. This chapter focuses on how to
create an OLAP model and manage existing OLAP models.

Creating and
working with
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Figure 3-1: OLAP Model Workflow
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Working with OLAP Models

Before you start working with an OLAP model, make sure that the OLAP

M etadata Catalog where your OLAP model will be stored, the server on which
OLAP Integration Server is running, and the data source are accessible. These
items can be on servers on a network; they do not need to be on your local
computer to be available to Hyperion Integration Server Desktop. For more
information, see the Hyperion Integration Server System Administrator’s Guide.

To work with an OLAP model, start Hyperion Integration Server Desktop and
choose whether to use OLAP Model Assistant (to be guided through creating or
editing an OLAP model), or to use the OLAP Model standard user interface (to
create or edit an OLAP model without guidance). For more information, see

“ Starting Hyperion Integration Server Desktop” on page 3-3 and “ Creating or
Editing OLAP Models’” on page 3-4.

Starting Hyperion Integration Server Desktop

To start Hyperion Integration Server Desktop, use any of the following methods:
e From the Windows Start menu, select Hyperion Integration Server Desktop.

B
e Double-click the Hyperion Integration Server Desktop icon, &%,

e Onthe command line, type the executable name (olapbldr).

For example, if Hyperion Integration Server Desktop isinstalled in the
\hyperion\is\bin directory, type the following path:

\hyperion\is\bin\olapbldr
Note: The default client directory, which is specified during installation is
\hyperion\is. Your application may have adifferent installation

directory. Consult the person who installed Hyperion Integration
Server at your site if you are not sure of the directory specification.

Now you can start working on an OLAP model. See “Creating or Editing OLAP
Models’ on page 3-4.
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Creating or Editing OLAP Models

To create or edit OLAP models, start Hyperion Integration Server Desktop and
connect to OLAP Integration Server, an OLAP Metadata Catalog, and a data
source.

For more information about connecting to OLAP Integration Server, OLAP

M etadata Catalog or a data source, see the Hyperion Integration Server
Installation Guide. If you have problems connecting, see“ Correcting Connection
Problems” on page 3-6.

If you just started Hyperion Integration Server Desktop, the Welcome dialog box
that you use to choose whether to create or edit an OLAP model opens
automatically.

If you are already running Hyperion Integration Server Desktop and are connected
to OLAP Metadata Catal og, select File> New or File> Open to open the Welcome
dialog box.

Using OLAP Model Assistant is the quickest, easiest way to create basic OLAP
models or to edit OLAP models. If, however, you want to perform more complex
tasks, you must use the OLAP Model standard user interface. For more
information, see “ Tasks That Cannot Be Performed Using OLAP Mode
Assistant” on page 3-10.

» To use OLAP Model Assistant to create a new OLAP model:

Model

1. %I eCl assistant

2. If you want to place write-lock privileges on the OLAP model, select
Exclusive Access.

Exclusive Access enables you to modify and save the OLAP model. If
Exclusive Access is not selectable, another user has write-lock privileges
and you have read-only or no privileges.

3. Click Open.
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» To use OLAP Modéd standard user interface to create anew OLAP model:

1.
2.

3.

Select

If you want to place write-lock privileges on the OLAP model, select
Exclusive Access.

Exclusive Access enables you to modify and save the OLAP model. If
Exclusive Accessis not selectable, another user has write-lock privileges and
you have read-only or no privileges.

Click Open.

» Touse OLAP Model Assistant to edit an OLAP model:

1.
2.

In the Welcome dialog box, select the Existing or Recent tab.

Select the OL AP model name. For more information about the OL AP model,
look in the Details group box.

Make sure that Open with Assistant is selected.

If you want to place write-lock privileges on the OLAP model, select
Exclusive Access.

Exclusive Access enables you to modify and save the OLAP model. If
Exclusive Accessis not selectable, another user has write-lock privileges and
you have read-only or no privileges.

Click Open.

If necessary, log on to the appropriate data source.

» To use OLAP Model standard user interface to edit an OLAP model:

In the Welcome dialog box, select the Existing or Recent tab.

Select the OL AP model name. For more information about the OL AP model,
look in the Details group box.

Make sure that Open with Assistant is not selected.
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4.

5.
6.

If you want to place write-lock privileges on the OLAP model, select
Exclusive Access.

Exclusive Access enables you to modify and save the OLAP model. If
Exclusive Accessis not selectable, another user has write-lock privileges and
you have read-only or no privileges.

Click Open.

If necessary, log on to the appropriate data source.

Correcting Connection Problems

If you have problems connecting from Hyperion Integration Server Desktop to
OLAP Integration Server, OLAP Metadata Catal og, Hyperion Essbase server, or
the data source, use the following checklist to help diagnose the problem:

Was the server temporarily down or not available? Try to connect again.

Did you enter the correct server name? Your network configuration
may require a fully-qualified internet host name; for example,
myserver.mycompany.com.

Did you enter the correct user name and password? Passwords are usually
case-sensitive. Make sure that the Caps Lock key is not activated.

Do you have anetwork connection to the server? Check your network
connection by using the ping command. See Microsoft Windows online help
for more information about using ping.

If the above steps do not resol ve the problem, contact your database administrator
or system administrator. For more information about troubleshooting server
connections, see the Hyperion Integration Server System Administrator’s Guide.
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Working in OLAP Model Assistant

OLAP Model Assistant is awizard that steps you through creating or editing an
OLAPmodel quickly and easily. OLAP Model Assistant contains multipletabs. If
you are creating an OLAP model, you complete the tabs and their tasks in order.

After you complete the required tasks in all tabs, you have avalid OLAP model
that you can use to create one or more metaoutlines. If you are editing an existing
OLAP model, you can work through the tabsin any order to revise the model as

needed.
When you open OLAP Model Assistant, it displays the first tab, as shownin
Figure 3-2.

®.. OLAP Model Assistant - New M= &3

Finizh

1.5elect Fact Table | 2. Select Time

Type a name to describe the table that contains facts and the accounts dimengion.

Mame

Accounts

Select the tables that will be used to create the fact table and the accounts dimergn.
elational Tables

Available Relational Tables Selecte

- TBCATTRIBUTE_OUNCES =]
&-EJ TBCATTRIBUTE_PACKAGE
TBCATTRIBUTE_REGION

TBCATTRIBUTE_SIZE il
TBCATTRIBUTE_STATE

TBC.FACT_TABLE il
TBC.LOOKUP_MARKET

TEC.LOOKUP_PRODUCT
TBC.LOOKUP_SCENARIO

TBC.LOOKUP TIME hd|

B
B
B
B
B
B
B

B

< Back | Mest »

IScreen 1of10 Help | Save | Cancel

Figure 3-2: Select Fact Table Tab in OLAP Model Assistant
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Process Graphics

The process graphics along the top of OLAP Model Assistant represent related
tasks. When you create an OL AP model, the tasks must be completed in order from
left to right. After you complete all the tabs that a process graphic represents, the
next process graphic becomes accessible and you can begin work on the task
within that task group. When you edit an existing OLAP model, all process
graphics are clearly displayed and al tabs are accessible.

Note: For best visibility of the OLAP Model Assistant process buttons, a
color palette of 65536 colorsis recommended. To set this pal ette,
select Start > Settings> Control Panel. Double-click the Display icon,
select 65536 from the Color Palette drop-down list, click Apply, and
then click OK. (Your PC may not support a palette of 65536 colors.)

Inline Help Text

Each tab contains brief descriptions of the tasks that you need to perform. If you
need additional information on atask, click the Help button.

Tasks to Complete

Each tab contains tasks that you must complete to define a particular part of an
OLAP model. In thefirst tab, for example, you must select the table to use as the
fact table. For help on using any tab, click the Help button.

OLAP Model Assistant contains the following tabs:

Table 3-1: OLAP Model Assistant Tabs

Tab Name For more information, see...

Select Fact Table “About the Fact Table” on page 4-3

Select Time “About the Time Dimension” on page 4-9

Name Dimensions “Creating Dimensions” on page 5-3

Select Relational Table “Adding Source Tablesto Create Dimension
Branches’ on page 5-6

Fact Table Joins “About Joins” on page 8-3

Dimension Table Joins “About Joins” on page 8-3
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Table 3-1: OLAP Model Assistant Tabs (Continued)

Tab Name For more information, see...
Edit Tables Chapter 6, “Editing Columns in Dimension
Tables and the Fact Table”
Define Hierarchies “About Hierarchies” on page 9-3
Preview Hierarchies “Previewing the Hyperion Essbase Outline” on
page 9-28
Finish “Saving OLAP Models’ on page 3-20
Buttons
The following buttons are always displayed along the bottom of OLAP Model
Assistant:

e Help button. Click to view detailed help for the selected tab. The help
describes each field in the OLAP Model Assistant tabs and explains what you
must do to compl ete the tasksin the sel ected tab before moving to the next tab.

e Savebutton. Click to savethe OLAP model. You can save an OLAP model in
any tab and then continue to move through the other tabs. Changes that you
made to all previous tabs are saved.

When you save an OLAP model, it is validated automatically. Y ou can save
an OLAP model with validation problems, but you cannot use the OLAP
model to create metaoutlines.

e Cancel button. Click to close the OLAP model without saving. Changes that
you saved in previous tabs are not discarded. Changes in previous tabs that
have not been saved are discarded, as are all changes in the current tab.

e Back button. Click to move to the previous tab. You can move back through
previous tabs and make changes at any time.

e Next button. Click to moveto the next tab. If you are creating an OLAP model
and have not completed all mandatory tasks in atab (such as selecting afact
table), you cannot move to the next tab.
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Tasks That Cannot Be Performed Using OLAP
Model Assistant

Y ou cannot use OLAP Model Assistant to perform thefollowing tasks. If you need
to perform these tasksin an OLAP model, use the OLAP Model standard user
interface.

e Create an OLAP model that contains dimension branches. If you want to add
multiple dimension tables to a dimension, you must combine the tables.

e Create afact table or an accounts dimension from multiple source tables.
e Joinadimension tabletoitself; that is, perform arecursive self-join on atable.

e Manualy validatethe OLAP model at any time during the creation or editing
process.

e Set up to switch the time and accounts dimensions.

e Renameadimension table; that is, give a dimension table a name other than
the source table name.

e Rename an existing dimension.

e Delete columns or rename columns.

e Create drill-through or user-defined columns.

e Defineretrieval optimization preferences for Oracle databases.
e Filter, port, or transform columns in hierarchies.

e View relational source table data.

Note: Thisuser’s guide provides detailed procedures for creating and
editing an OLAP model using the standard user interface. To create
an OLAP model using OLAP Model Assistant, refer to the assistant
overview information (or click overview inthe Welcome dial og box),
to the online help, and to the inline help that appears within each
assistant tab.
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Working in the OLAP Model Standard
User Interface

To create an OLAP model using the standard user interface, you must connect to
OLAP Metadata Catalog and the to relational data source. For more information,
see “Working with OLAP Models’ on page 3-3. After you click the OLAP Model
icon, Hyperion Integration Server Desktop displays the OLAP Model main
window, as shown in Figure 3-3. The window displays source tables in the left
frame and a blank modeling area in the right frame.

* . Hyperion Integration Server Desktop - [DLAP Modell] M= 3
::= File Edit “iew Connections Toolz ‘Window Help _|ﬁ||1|
DEE| &= @ L 2
#-EJ TBCATTRIBUTE_OUMCES -
TECATTRIBUTE_PACKAGE
TECATTRIBUTE_REGION

TBCATTRIBUTE_SIZE
TBCATTRIBUTE_STATE
TBC.FACT_TABLE
TBC.LOOKUP_MARKET
TEC.LOOKUP_PRODUCT
2 TEC.LOOKUP_SCENARIO
TBC.LOOKUP_TIME

| Data Source: TEC
Faor Help, press F1 |DLAF' Catalog: TEC_MD i

Figure 3-3: OLAP Model Main Window
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Left Frame

Theleft frame displays alist of sourcetables. Y ou can use the listed source tables
to create an OLAP model. Y ou can view tables, views, and synonyms in the left
frame. Although you can view tables, views, synonyms, or any combination of
tables, views, and synonymsin the left frame, this guide refers only to tables.
Whenever tablesin the left frame are discussed, synonyms and views areimplied.
To view synonyms, select View > Show Synonyms.

The name of each table in the relational data source is displayed after a plus

symbol, [+, or minus symbol, =

e Theplussymbol, &, indicates that you can expand the table to see the
columnsiit contains. For example, if MARKET is not expanded, clicking
MARKET expands the table to show CITY, CITYID, and so on.

e Theminussymbol, =, indicates that you can collapse the table. For example,
if MARKET is expanded, clicking MARKET collapses the table to show the
table name but not the table columns.

Y ou can view the contents of atable in the left framein the following ways:
e By sdecting the table and selecting View > View Table Data.
e By selecting the table, right-clicking, and selecting View Table Data.

For more information, see “Viewing Table Data’ on page 3-17.

Right Frame
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Theright frameiswhere you build an OLAP model. Y ou drag source tables from
theleft frameto theright frameto create afact table, accounts dimension, optional
time dimension, standard (default) dimensions, and dimension branches.

When you create an OLAP model, the relational tables that you drag to the right
frame become the fact table and the dimension tables. Y ou can add, hide, delete,
transform, and perform other operations on columns in these dimension tablesto
refine the data that you want reported in Hyperion Essbase. After you complete
and save an OLAP model, you open it to create a metaoutline. At that time, the
dimension tables can become dimensions.
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Tools and Toolbars

Use the dual-function Join tool, " , on the toolbar to add joins between tablesin
an OLAP maodel or to move objects in an OLAP model. The default position for
the Join tool is Move mode. To switch between Move mode and Add Joins mode,
click the Join tool.

Use the toolbar to perform commonly used functions. For more information

on individual toolbar buttons, click Help. To hide the toolbar, deselect View >
Toolbar. In the menu, the check mark next to Toolbar is removed, and the tool bar
disappears. To redisplay the toolbar, select View > Toolbar.

Thetoolbar is not attached to the edge of the program window. Y ou can move it
by selecting it and dragging it to a new location. Y ou can aso change the shape
and size of the toolbar.

Menus

Use the menu bar to perform commonly used commands.

Use the pop-up menu that opens when you right-click an object to perform
operations on the selected object.

Status Bar

The status bar identifies the data source and the OLAP M etadata Catal og to which
you are connected and displays other status information. To hide the status bar,
deselect View > Status Bar. In the menu, the check mark next to Status Bar is
removed, and the status bar disappears. To redisplay the status bar, select View >
Status Bar.

Hyperion Integration Server Desktop OLAP Model User’s Guide B 3-13



Creating and Working with OLAP Models

OLAP Model Dimension Table Graphics

The following graphics identify dimension tables in the OLAP model:

E identifies the fact table as the table containing measures values for the
OLAP moddl.

() identifiesatime dimension.
[#z]  identifies an accounts dimension.

fd  identifies a standard dimension table.

For illustrations and explanations of the graphics that identify relational data
source columns, see “Viewing Column Properties’ on page 6-4.

Display of Column Names

Normally, thetablesin therelational data source are displayed in acollapsed view
in the left frame of the OLAP Model main window, as shown in Figure 3-4.

* . Hyperion Integration Server Desktop -

::= File Edit “iew Connections Tools

SCLICIEEIA

TBCATTRIBUTE_OUNCES
TBCATTRIBUTE_PACKAGE
TBCATTRIBUTE_REGION
TBCATTRIBUTE_SIZE
TBCATTRIBUTE_STATE
TBC.FACT_TABLE
TBC.LOOKUP_MARKET
TEC.LOOKUP_PRODUCT
TBC.LOOKUP_SCENARIO
TBC.LOOKUP_TIME

Faor Help, press F1

Figure 3-4: Collapsed Table View in Left Frame
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Asyou create afact table or adimension table, you can display the names of the
source columns that the table contains. Y ou can use thisinformation to ensure that
you have selected the correct table from the relational data source. Display the

contents of the table by selecting the table and then selecting View > View Table

Data or by clicking the plus symbol, [, to the Ieft of the table name.

Note: When you display columnsin the left frame, OLAP Integration
Server displays only certain ODBC data types. For acomplete list,
see “About Column Data Types’ on page 6-3.

The following topics describe the methods that you can use to display column
names and contents:

e “Displaying Column Namesin the Left Frame” on page 3-15 describes how

to display table columns as they are displayed in the origina relational data
source.

e “Viewing Table Data’ on page 3-17 describes how to display the data of the
selected relational table.

e “Displaying Column Namesin the Right Frame” on page 3-18 describes how
to display table columns after you have added the tables to an OLAP model.

Displaying Column Names in the Left Frame

» To display the column names of arelational table:

1. Expand the table by clicking the plus sign, (¥], in front of the table.
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The table expands to include an alphabetical list of columns, as shown in

Figure 3-5. A graphicidentifies each column asacolumn, m, or asaprimary

key, & . In this example, the TBC.LOOKUP_MARKET table is expanded.
Y ou can expand as many tables as you want and scroll through each table to
display column and key names.

* . Hyperion Integration Server Desktop -

::= File Edit “iew Connections Tools
D@85 ) 2]

- TECATTRIBUTE_OUNCES
TBCATTRIBUTE_PACKAGE
TBCATTRIBUTE_REGION

TBCATTRIBUTE_SIZE
TBCATTRIBUTE_STATE
TELC.

+- [ TEC.LOOKUF_PRODUCT
- TBC.LOOKUP_SCENARIO
t- 3 TBC.LOOKUP_TIME

Faor Help, press F1

Figure 3-5: Expanded Columns in the Left Frame

2. Intheleft frame, right-click and select Show Views, Show Tables, or Show
Synonyms to display views, tables, or synonyms (aliases).

e Aviewisalogical table created by combining columns from one or
more tables in the relational data source (see “Creating Views and
Tables” on page 2-6).

e Synonyms are displayed only for RDBM Ss that support synonyms
(aliases).

e Although you can display tables, views, synonyms, or any
combination of tables, views, or synonymsin the left frame, this
guiderefersto tables. Whenever tablesin theleft frame are discussed,
synonyms and views are implied.

3. Click theminussign, =, in front of the table to collapse it.
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Viewing Table Data

» To display the contents of atable that is listed in the |eft frame:
1. Select thetable, right-click, and select View Table Data.

Hyperion Integration Server displaysthe View Table Data dialog box. The
View Table Data dialog box displaysthefirst 100 rows of the selected source

table.
Source |TBE Table |TBE.LDDKUP_MAF|KET
REGION | REGION_TvPE_.. [ STATE | STATE TYPE_ID =
Central B Calorado 1
Central B Ohio B
Central B Wisconsin 7
Central B Calorado 1 e
Central B Calorado 1
Central B llinois B
Central B llinois B
Central B Indiana
Central B Indiana
Central B lowa 7
Central B lowa 7
Central B Karsas
Central B Karsas
Central E Michigan
Central E Michigan
Central B Minnesata
Central B Minnesata
Central B Minnesata
Central B Minnesata T
< J _>l_I
Fows - 5K
Brevious | TdExt | St | Lloze I Help |

Figure 3-6: Viewing Table Data

2. Toview the next 100 rows, click Next.
To display the previous 100 rows, click Previous.

4. Todisplay al rowsinthetable, click Show All. Retrieval may take sometime,
depending on the number of rows the table contains.
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Displaying Column Names in the Right Frame

To display column names after dragging a table to the right frame, use one of the
following methods:

Drag the corner of the dimension table or fact table down until the table is
large enough to display its columns.

Right-click the dimension table or fact table and select View Columns. To
collapse the column list, right-click and select View Columns again.

Select the dimension table or fact table and select View > View Columns. To
collapse the column list, Select View > View Columns again.

To display all columns of al dimension tables (including the fact table)
currently in the right frame, select View > View All Columns.

A scrollable list of column namesis displayed for each dimension table, as
shown in Figure 3-7.

LOOKUP_PRODUCT =]
P: CAFFEINATED
B DIET
B IMTRO_DATE
P.: OUNCES_ID
B PACKAGE_TYPE_ID [ |+

Figure 3-7: View Columns Option

For illustrations and explanations of the graphics that identify columns, see
“Viewing Column Properties’ on page 6-4.

Validating OLAP Models Manually

When you save an OLAP model, OLAP Integration Server automatically validates
it and writes it to OLAP Metadata Catalog. If you prefer, you can manually
validate an OLAP model before saving it. Y ou can save an OLAP model that does
not pass validation, but you cannot use it to create a metaoutline.

To validate an OLAP moded manually, select File > Validate. If the OLAP model
isvalid, adiaog box informs you that the OLAP model contains no errors.
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If the OLAP model isinvalid, Hyperion Integration Server displays a dialog box,
similar to the onein Figure 3-8, that details the errorsin the OLAP model.

OLAP Model ¥alidation Errors [ %]

Errors and ‘Warnings:
ERROR: Mo joins defined between OLAP model tables 'FACT_TABLE' and ‘Time',

Help |

Figure 3-8: Invalid OLAP Model Validation Error Message Listing

If the OLAP model isinvalid, check to make sure that the following conditions
are met:

e The OLAP mode contains afact table. See Chapter 4, “ Creating the Fact
Table, Accounts Dimension, and Time Dimension.”

e The OLAP model contains an accounts dimension with at |east one measures
value; for example, sales amounts, quantities sold, or commissions.

e The OLAP modd contains at least one dimension.

e Each dimension tablein the OLAP model isjoined to the fact table or to
another dimension table.

e If the OLAP model contains a single dimension, the dimension contains at
least one column.
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e Dimensionsinthe OLAP model that are made up of two or more physical
tables have joins defined. See Chapter 8, “Joining Dimension Tables.”

e The OLAP mode contains no dimensions with duplicate names.

To save amodel that does not pass validation, see “ Saving an OLAP Model
Manually” on page 3-22.

Saving OLAP Models
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When you save an OLAP model, Hyperion Integration Server automatically
validatesit and writesit to OL AP Metadata Catalog.Y ou can save an OLAP model
if it does not pass validation, but you cannot use an invalid OLAP modé to create
ametaoutline.

This topic describes how to save an OLAP model. Thistopic contains the
following subtopics:

e “Understanding Exclusive Access’ on page 3-21

e “Saving an OLAP Model Manually” on page 3-22

e “Saving While Closing” on page 3-27

e “Saving an OLAP Model to a Different Name” on page 3-27
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Understanding Exclusive Access

Y ou can save an OLAP model even if multiple users are reading it by selecting
Exclusive Access on the Welcome screen. Opening an existing OLAP model with
Exclusive Access guarantees that no other user can modify the OLAP model.

Figure 3-9: Selecting the Exclusive Access Option
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When opening an existing OLAP model, select Exclusive Access to place
write-lock privileges on the model. This option alows you to do both of the
following:

e Savean existing OLAP model.

e Modify and save an existing OLAP model. If you open aread-only OLAP
model and no other user has Exclusive Access, you can save the OLAP model
to the same name.

If Exclusive Access is not selectable, another user has write-lock privileges, and
you have read-only privileges.

If you want to modify and save an OLAP model but have read-only privileges,
use File > Save Asto save the OLAP model to a different name. See “Saving an
OLAP Model to aDifferent Name” on page 3-27. Also see the Hyperion
Integration Server System Administrator’s Guide for information on unlocking
OLAP models.

Note: You cannot save an OLAP model if other users are reading it. Save it
later or use File > Save Asto save the model with a different name.
See “Saving an OLAP Model to a Different Name” on page 3-27.

Saving an OLAP Model Manually
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If the OLAP model that you want to save has been previously saved and you do
not want to give the OLAP modd adifferent name, select File > Save.

OLAP Integration Server writes the changes to the OL AP Metadata Catal og to
which you are connected.

If you have not previously saved the OLAP model or if you want to savethe OLAP
model to a different name, you must use the Save New OL AP M odel dialog box.
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» To usethe Save New OL AP Model dialog box to save an outline manually:
1. Select one of the following menu options:
e If you are saving aan OLAP model for the first time, select File > Save.

e Ifyouaresavingapreviously saved an OLAP model to anew name, select
File> Save As.

The Save New OLAP Model diaog box, as shown in Figure 3-10, is
displayed.

Save New OLAP Model

OLAP kodel Mame: oK
ITBE_MDDEL_TEST

Cancel
Existing OLAP Models:

TBC_ACTUALS ul=e
TBC_MODEL

aiif

Security:

IAIIDW readAwrite access for other users j

Drescription:
Test version of TEC_MODEL. =]

-

Figure 3-10: Saving an OLAP Model

Note: |f you save an existing model, the Save New OLAP Model
dialog box is not displayed

2. Inthe OLAP Model Name text box, enter the name of the OLAP model.
See “Observing Naming Rules’ on page 3-28.
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3. From the Security drop-down list box, select one of the following options to
determine who can access the OLAP model:

Table 3-2: Read/Write Settings

Choose... To give other users permission to...

Allow read/write access | Both read and write to the OLAP model. This

for other users. setting is the defaullt.

Allow read access for Read the OLAP model but not write to the OLAP

other users. model; that is, another user cannot save changes to
the OLAP model.

Disallow al accessfor | Neither read nor write to the OLAP model. Only

other users. you can read or write to the OLAP model.

Note: To change the permissionsonan OLAP model after you createit,
you must use the tools provided with the relational database that
contains the OLAP Metadata Catalog or use File > Save Asto
save the OLAP model to adifferent name. See the Hyperion
Integration Server System Administrator’s Guide.

4. If you want to describe the OLAP model, in the Description text box, enter a
brief description.

The description can include up to 255 characters. Hyperion Integration Server
displays the description in the following places:

e TheSaveNew OLAP Model dialog box when you select File > Save As
(see “Saving an OLAP Model to a Different Name” on page 3-27)

e The OLAP Model Propertiesdialog box (see “Changing Read/Write
Access’ on page 3-25)

e TheEXxisting tab of the Welcome dialog box (see “Working with OLAP
Models’ on page 3-3)
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5. Click OK.

If the OLAP model isinvalid, Hyperion Integration Server displays an error
message. Y ou can save the OLAP model without correcting the error, but you
cannot use an invalid OLAP model to create a metaoutline.

Note: If you attempt to save an OLAP model that another user currently has
open, adialog box informs you that the OLAP model is currently
locked or open. You must wait to save until al other users close the
OLAP modd.

Changing Read/Write Access
At any time after you save an OLAP model, you can change the access rights that
you originally assigned by using the OLAP Model Properties dialog box.
» To change read/write access to an OLAP model:
1. Inablank space of the right frame, right-click and select Properties.

Hyperion Integration Server displays the General tab of the OLAP Modél
Properties dialog box.

2. Inthe Security drop-down list box, change the user access defined for the
model.

For more information about security settings, see Table 3-2.
3. Click OK.

Specifying Retrieval Optimization Preferences

Oracle users have the option of specifying dataretrieval optimization preferences
in the Optimization tab of the OLAP Model Properties dialog box. Optimization
preferences determine how OLAP Integration Server handles data queries for
individual users. This option exists for Oracle users because Oracle is the only
RDBMS that offers performance options for overall database access. Overall
database information is stored with the OLAP model.
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» To specify optimization preferences for Oracle users:
1. Inablank space of the right frame, right-click and select Properties.
The OLAP Modd Propertiesdialog box is displayed.

Tip:  You can also open the OL AP Model Properties dialog box by
selecting View > Properties > OLAP Model.

2. Click the Optimization tab, shown in Figure 3-11.

OLAP Model Properties E

General Optimization |

Query Optimization

= Best Throughput

" Best Response Time

QK I Cancel | Help |

Figure 3-11: Optimization Tab of the OLAP Model Properties Dialog Box

3. Select one of the following preferences:
e Noneto have no parameters included in user data queries

e Best Throughput to have all userstreated equally, with no high-priority
dataretrieval

e Best Response Timeto have some queries (queriesfrom users who have
this setting) receive a higher priority response than other, concurrent
queries

4. Click OK.
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Saving While Closing

If you try to close an OLAP model without saving it, adialog box promptsyou to
save your changes.

Click Yesto savethe OLAP model or Noto close the OLAP model without saving
the changes. See “Saving an OLAP Model Manually” on page 3-22.

CAUTION: If the OLAP modé that you are closing isanew OLAP
model that has never been saved, you will lose it if you
click No.

Saving an OLAP Model to a Different Name

Savean OLAP model to adifferent nameif you want to take either of thefollowing
actions:

e Change the name of an OLAP model. (The original OLAP model retains the
original name.)

e Makeacopy of an OLAP modd.

Y ou cannot copy an OLAP model using the Copy function that the operating
system provides because the OLAP model residesin an OLAP Metadata
Catalog. Instead, you need to save the OLAP model to a different name.

To save an OLAP model to a different name, select File > Save As. Hyperion
Integration Server displays the Save New OL AP M odel dialog box. For more
information, see “ Saving an OLAP Model Manually” on page 3-22.
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Observing Naming Rules

When naming objects in an OLAP model, follow these rules.
e Do not use more than 80 characters.

e Do use mixed upper case and lowercase characters. Names are not
case-sensitive in Hyperion Essbase unless there is a check mark next to
the Settings > Case Sensitive Members menu item in Hyperion Essbase.

e Do not use the following characters anywhere in a name:

&  (ampersand) < (lessthan sign)
*  (asterisk) () (parenthesis)
@ (atsign) . (period)
\  (backslash) + (plus sign)
{ } (brace) ' (single quotation mark)
, (comma) tabs
- (dash, hyphen, or minus sign) _ (underscore)
(doubl e guotation marks) | (vertical bar)
= (equal sign)

e Do not place spaces at the beginning or end of a name. Hyperion Essbase
ignores spaces at the beginning or end of a name.

e Do not use the following words as dimension or member names:
-  $S$SSUNIVERSESSS
—  #MISSING Or #MI
— Calc script commands, operators, and keywords

For alist of commands, see the online Technical Referencein the
Hyperion Essbase pocs directory.

— Report script commands

For alist of commands, see the online Technical Referencein the
Hyperion Essbase pocs directory.
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— Function names and function arguments

For alist of functions, seethe online Technical Referenceinthe Hyperion
Essbase pocs directory.

— Namesthat are already in the database: nhames of dimensions and
members (unlessthe member is shared), names of generations and levels,
and aliases and combinational aliases.

Note: If you tag members as Dynamic Time Series, do not use the
associated generation names:. History, Year, Season, Period,
Quarter, Month, Week, or Day. See the Hyperion Essbase
Database Administrator’s Guide for more information.

Printing OLAP Models

Y ou can print the OLAP models contained in the right frame of the OLAP Moddl
main window to use as a hard-copy reference or to retain on file. Therelational
tablesin the left frame of the window do not print when you print the OLAP
model.

» To print an OLAP model:

1.

2.

Click in theright frame.

Select File > Print or click the Print toolbar button, 8| to open the standard
print dialog box.

Select the settings that you want.

Click OK.
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Deleting OLAP Models

When you delete an OLAP model, Hyperion Integration Server removes the
OLAP model from OLAP Metadata Catal og.

» To delete one or more OLAP models:

1. Makesurethat you are connected to the OLAP Metadata Catalog in which the
OLAP modd is stored.

If you are connected, the lower-right corner of the OLAP Model main window
contains the appropriate OL AP Metadata Catal og name (for example,
TBC_MD inthe sample TBC database).

If you are not connected, select Connections > OLAP Metadata Catalog >
Connect and log on to the correct OLAP Metadata Catalog.

2. Select File> Delete to display the Delete an OL AP M odel/M etaoutline
dialog box, shown in Figure 3-12.

Delete an OLAP Model/Metaoutline E
% TBC Model Close I
¥ TBC Metaoutline
B 0L4F Modell Delete |
Help |
Drescription:

Figure 3-12: Deleting an OLAP Model
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3. Select the OLAP model to delete; for example, OLAP Model1, and click
Delete.

Note: To select multiple OLAP models, select one OLAP model, hold
down the Ctrl key, and select each additional OLAP model.

Hyperion Integration Server displaysadial og box that promptsyou to confirm
that you want to delete the OLAP model.

CAUTION: Use caution when deleting. You cannot undo the deletion
of an OLAP model.

4. Click Yes.

OLAP Integration Server deletes the selected model from OLAP Metadata
Catalog.

Note: If you attempt to delete an OLAP model that you or another user
currently has open, adialog box informs you that the OLAP model is
currently locked or open. If you haveit open, close the OLAP model
and select Connections > OLAP Metadata Catalog > Delete Locks. If
other users have the OLAP maodel open, you must wait until they
closeit.
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Creating the Fact Table,
Accounts Dimension, and
Time Dimension

Every OLAP model contains afact table. The fact table serves as a container for
al numeric (measures) datavaluesthat you want to track. Measures areitems such
as unit price, units sold, and sales amounts. Y ou must create an OLAP model
accounts dimension to hold the measures. If an application requires analysisto be
performed on atime basis, you should a so create a time dimension.

Thetopics of thischapter describe the role of the fact tablein an OLAP model and
provide procedures for creating a fact table, an accounts dimension, and atime
dimension:

“Understanding the OLAP Model Workflow” on page 4-2
“About the Fact Table” on page 4-3

“Creating the Fact Table” on page 4-5

“About the Accounts Dimension” on page 4-8

“Creating the Accounts Dimension Manually” on page 4-9
“About the Time Dimension” on page 4-9

“Creating the Time Dimension Manually” on page 4-10
“Switching the Time and Accounts Dimensions’ on page 4-15
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Understanding the OLAP Model Workflow

Figure 4-1 illustrates the workflow for creating an OLAP model. This workflow
includes creating and working with an OLAP model; creating afact table, an
accounts dimension, and atime dimension; creating and working with dimensions;
editing and transforming the columns of dimension tables; joining dimension
tables, and creating and working with hierarchies. This chapter focuses on how
to create afact table, an accounts dimension, and a time dimension.

Creating and working
with OLAP models

* . Hyperion Integration Server Desktop - [TBC Model]
::= File Edit “iew Connections Toolz ‘Window Help

DEHE|S|- - |E 22| /
TECATTRIBUTE_OUMCES /
TECATTRIBUTE_PACKAGE

@ Creating a fact

table, an accounts

You Are Here dimension, and a
time dimension

* . Hyperion Integration Server Desktop - [TBC Model]
::= File Edit “iew Connections Toolz ‘Window Help

DEE[&[: [#] 2] 2 | /

[

TECATTRIBUTE_OUMCES -
-E3 TBCATTRIBUTE_PACKAGE | ‘F'ACT—TABLE /

[F Market | [@vear ]|
Creating and working @ FACT TABLE 8 Accounts |
with dimensions [£ Produet___|| [= Scenario ||

Table Properties
General | Columns ~ Physical Joins | Dimensionsl

Mame Table Mame | Colurn Ma... | Hidden | Diill-Thro...
TBC.FAC..  ADDITIO..

Editing and transforming

columns Al
H:-EITY_ID TBC.FAC..  CITY_ID A
Table Properties
General | Columns ~ Physical Joins | Dimensionsl
Table Mame |EOIumn Ma... | Hidden | lI|
_ . . ITION TBC.FAC...  ADDITIO..
Joining dimension tables .OTY_ID TBCFAC.. CITYD v

TBCFAC.. COGS

Edit Hierarchy
Mame:

IYEAH-DUAHTEH-MDNTH

) ) = Year E-%, YEAR-QUARTER-MONTH
C_reat!ng and_ wiorking 25 Time 20 TimeYear
with hierarchies ;3 ot =G Time. Quarter

B¢ Quater | B¢ Time.Month

Figure 4-1: OLAP Model Workflow
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About the Fact Table

A fact table contains detailed measures (data values) for each dimension
intersection of its OLAP model. M easuresincludeitems such as priceor units sold.
For example, if the OLAP model contains Product, Geography, and Time
dimensions, the fact table may contain the number of units of Product A sold in
New York in January.

What Components Are Included in the
Fact Table

The fact table is made up of one or more source tables and contains a compound
key that uniquely identifiestherecordsthat it contains. The compound key consists
of primary and foreign keys and linksto each dimension table of the OLAP maodel,
asillustrated in Figure 4-2. The dimension tables contain columns of related
information from the source tables.

Fact Table (Orders)

Quantity
Froduct_1D
Geography_ID

N\

N

7/

Geography_ID
Froduct_ID Region

Froduct Name

Geography
Product

Figure 4-2: Dimension Tables Joined to the Fact Table with
Primary and Foreign Keys

For example, you might store product ID and geographic information in two or
more tablesin the relational database. Y ou can use the relational tables to create
Product and Geography dimensionsin the OLAP model. Y ou join the dimensions
to the fact table, either manually or through automatic joins. When you create a
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new dimension, OLAP Integration Server creates an automatic join whenever it
detectsanatural join relationship. A natural join exists between two tableswhen a
primary key of one table isidentified as aforeign key in the other table.

Bear in mind that OLAP Integration Server does not create additional structures
for the relational data that you use when creating an OLAP model. Rather, it
reorganizesthe existing datainto aformat that you can useto create ametaoutline.

Why a Fact Table is Required

4-4 A

Every OLAP model that you create must contain afact table. The fact table
contains the values that are later aggregated and reported by Hyperion Essbase.
The first source table that you drag to the right frame automatically becomes the
fact table. Because of its relationship to each dimension that you define, the fact
table becomes the hub (the center) of the OLAP model. After you create the fact
table, you can add other source tablesto it.

Any columnsthat you add to the fact table are added automatically to the accounts
dimension. Likewise, columns that you add to the accounts dimension are added
automatically to the fact table. All measures values that you want reported are
referenced through the fact table and through the accounts dimension, which isan
exact copy of the fact table.
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Creating the Fact Table

Thefirst table that you drag to the right frame of the OLAP Model main window
becomesthe fact table. When you create the fact table, you aso choose whether to
create the time and accounts dimensions automatically.

CAUTION: If therelational database stores accounts measures values
and time values in the same columns, you must use a
non-standard method to create the OLAP model accounts
dimension. This situation is common in some applications,
such as general ledger and legacy systems. See “ Switching
the Time and Accounts Dimensions’ on page 4-15.

For more information on the fact table, see “ About the Fact Table” on page 4-3.
Before creating an OLAP model, be sure to read and follow the proceduresin
Chapter 2, “Preparing Relational Data Sources.”
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» To create afact table;

1. Drag the appropriate source table from the |eft frame to the right frame, as
shown in Figure 4-3.

If you are not sure which tableto use, view the datastored in each sourcetable
by selecting View > View Table Data. For more information, see “Viewing
Table Data” on page 3-17.

* . Hyperion Integration Server Desktop - [DLAP Model3] M= 3
::= File Edit “iew Connections Toolz ‘Window Help = |ﬁ'|1|

DEE| &= @ L 2
- TBCATTRIBUTE_OUNCES
: TBCATTRIBUTE_PACKAGE
TBCATTRIBUTE_REGION
TBCATTRIBUTE_SIZE
TBCATTRIBUTE_STATE
TBC.FACT_TABLE
TBC.LOOKUP_MARKET
TEC.LOOKUP_PRODUCT

+ TBC.LOOKUP_SCENARIO
&-EJ TBC.LOOKUP_TIME

1§ FACT_TABLE |

KU — _>l_I
| Data Source: TEC
Faor Help, press F1 |DLAF' Catalog: TEC_MD i

Figure 4-3: Creating a Fact Table

Thefact table uses the name of the source table that you select to createit. To
rename the fact table, see “Renaming Dimensions and the Fact Table” on
page 5-14.
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2. Decide whether to create the time dimension first, and then the accounts

dimension, by responding to the following prompts:

e WouldyoulikeaTimedimension using avalue from thefact table? Click

Yesor No.

e Would you like to add an Accounts dimension? Click Yes or No.

Create the time dimension
automatically if...

Create the accounts dimension
automatically if...

The table that you select to create the
fact table contains at least one column
with a time value (a shipping date, for
example) and you want to use that
column to create atime dimension.

If you select this option, the time
dimension initially contains the same
columns as the fact table. However,
any columnsthat you later add to the
time dimension are not added
automatically to the fact table;
likewise, if you add columnsto the
fact table, they are not added
automatically to the time dimension.

The source table that you select to
create the fact table contains at least
one column with a measures value
(units sold, for example) and you
want to use that column to create an
accounts dimension.

The accountsdimensioninheritsall of
the columns that the fact table
contains. In an OLAP model, the fact
table and the accounts dimension are
mirror images of each other. The
accounts dimension reflects changes
made in the fact table; likewise, the
fact table reflects changes madein the
accounts dimension.

After you respond to the time and accounts dimension prompts, the fact table

isdisplayed in the right frame.

If you create an accounts dimension automatically, an object is displayed in

the right frame. The object is identified by the “ Accounts’ label and the
graphic. A join line connects the fact table and the accounts dimension.

If you create atime dimension automatically, an object isdisplayed in theright

frame. The object isidentified by the“ Time” label and the & graphic. A join
line connects the fact table and the time dimension.
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3. After you create the fact table, proceed with the following options:;

e Toaddtablesfromtherelational datasourceto thefact table, see“Adding
Tablesto the Fact Table” on page 5-12.

e Toaddtime and accounts dimensions manually, if you opted not to create
time and accounts dimensions automatically along with the fact table, see
“Creating the Time Dimension Manually” on page 4-10 and “ Creating the
Accounts Dimension Manually” on page 4-9.

e To create standard dimensions, see Chapter 5, “ Creating and Working
with Dimensions.”

About the Accounts Dimension

The accounts dimension consists of columns that contain measures. Measures
values are numeric data values that you track over time, such as sales, discounts,
and commissions. In Hyperion Essbase, accountsis adimension type that makes
accounting intelligence available during online analytical processing.

An OLAP model is not complete without an accounts dimension that includes at
least one column from the relational data source that contains a measure.

CAUTION: If the relational database stores accounts measures values
and time values in the same columns, you must use a
non-standard method to create the OLAP model accounts
dimension. This situation is common in some applications,
such as general ledger and legacy systems. See “ Switching
the Time and Accounts Dimensions’ on page 4-15.
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Creating the Accounts Dimension Manually

If you do not create the accounts dimension automatically, you can create it
manually. To add an accounts dimension manually:

1. Right-click the fact table, and select Add Accounts Dimension.
An accounts dimension is displayed in the right frame. The dimension is

identified by the “ Accounts” label and the 2l graphic. A join line connects
the accounts dimension to the fact table.

2. If needed, add one or more source tables to the accounts dimension.

Y ou must add source tables directly to the accounts dimension; you cannot
create adimension branch. For more information, see“ Adding Source Tables
Directly to Dimension Tables’ on page 5-7.

3. If needed, add one or more user-defined columns to the accounts dimension.

Any columnsthat you add to the accounts dimension are al so added to the fact
table. For instructions on how to add new columnsto the accounts dimension,
see “ Creating User-Defined Columns” on page 6-14.

About the Time Dimension

In aHyperion Essbase database, you use the dimension tagged astime to describe
how often you collect and update data. Y ou can usetime dimension members, such
as Y ear and Quarter, to report yearly and quarterly totals for members of other
dimensions; for example, total sales of Diet Colain Boston for the first quarter.

In an OLAP model, you create a dimension tagged as time to provide atime
structure from which to create a specific time dimension in an associated
metaoutline. Y ou cannot create atime dimension in ametaoutline if you did not
create, in the associated OLAP model, a dimension that contains atime value.

It is not mandatory to include atime dimension in an OLAP model. However, if
an application requires analysisto be performed on atimebasis, such asexamining
trends over time or making seasonal sales comparisons, you should include atime
dimension. Y ou can create only one time dimension in an OLAP model, but you
can create as many time dimension hierarchies, within that single time dimension,
as are necessary to meet reporting requirements.
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In an OLAP model, the time dimension includes the following elements:
e Oneor more time-related columns joined to the fact table.

e A time-reated column for every time dimension member that you want to
report on in Hyperion Essbase; for example, a separate column for year, for
guarter, and for month. You use these time-related columns in an associated
metaoutline to define members of the time dimension.

e Asneeded, one or more hierarchiesthat define how to roll up member datain
the time dimension. For example, atime hierarchy can include Month,
Quarter, and Year members whereby monthly totalsroll up to quarterly totals
and quarterly totalsroll up to yearly totals. Creating hierarchiesin an OLAP
model provides a multilevel structure that you can view when creating
dimensionsin metaoutlines.

Y ou may have specific reporting and analysis requirements that are based on
specialized calendar years, such asin amerchant calendar. For more information
on how to prepare the relational data source to meet such requirements, see
“Creating Time and Accounts Dimensions’ on page 2-20.

Creating the Time Dimension Manually

4-10 1

Y ou can create atime dimension either automatically or manually. The procedure
for automatically creating atime dimension is described in “ Creating the Fact
Table” on page 4-5. After automatically creating the time dimension, you can edit
the columns it contains, as described in Chapter 6, “ Editing Columnsin
Dimension Tables and the Fact Table.”

If you do not create atime dimension automatically when you create the fact table,
you can add the time dimension manually. Y ou create the time dimension
manually in one of two ways:

e Based on the fact table, whereby the time dimension table inherits al of the
columns in the fact table. See “Manually Creating a Time Dimension that Is
Based on the Fact Table” on page 4-11.

e Based on another tablein the relational data source, such as a user-defined
calendar. Follow the same procedure that you use for creating standard
dimensions, with some exceptions that are noted in the procedure. See
“Creating Dimensions’ on page 5-3.
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Manually Creating a Time Dimension that Is
Based on the Fact Table

» To add atime dimension that is based on the fact table:
1. Right-click the fact table, and select Add Time Dimension.
A time dimension isdisplayed in the right frame. The dimension isidentified

by the“Time” label and the o graphic. A broken join line connects the time
dimension to the fact table. The time dimension table includes all of the
columnsin thefact table. The brokenjoinlineindicatesthat you need to select
time-related columnsin both tables to define the join rel ationshi p between the
two tables.

2. Define the join between the two tables, as described in Chapter 8, “ Joining
Dimension Tables.”

3. If needed, add one or more source tables to the time dimension.

Y ou must add source tables directly to the time dimension; you cannot create
adimension branch. For more information, see “Adding Source Tables
Directly to Dimension Tables’ on page 5-7.

4. |If needed, add one or more user-defined columns to the time dimension.

Add new columnsto the time dimension to use the columnsaslevelsin atime
hierarchy. If you want monthly and quarterly aggregations in the Hyperion
Essbase database, you need a monthly and a quarterly column in the OLAP
model time dimension.

If the time dimension does not include the needed columns, you must add new,
user-defined columns. Add a column for each level of aggregation that the
OLAP model does not currently include. Y ou derive the values of the new
columns from date columns currently existing in the data; for example, a
transaction or sales date.

For instructions on how to add new columns to the time dimension table,
see “ Creating User-Defined Columns’ on page 6-14.
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Determining if a User-Defined Calendar
Is Needed

OLAPIntegration Server can map adate in asource columnto aday, week, month,
guarter, or year time period in the time dimension.

If you need to analyze data by other time periods or if you use a calendar different
from the standard Gregorian calendar, create a user-defined calendar in the source
data. A user-defined calendar isasourcetablein areational database that mapsa
business calendar to the date information associated with the measures data. If you
answer “Yes’ to any of the following questions, create arelational source table
containing your user-defined calendar to perform the required mapping.

e Doesthefisca year start on adate other than January 1?

e Doesthetime dimension include amember for a period that has no matching
column in the source data for the fact table? For example, do you want to
measure by sales season, but no sales season column existsin the source data
for the fact table?

e Do you measure business cyclesin periods other than the standard Gregorian
calendar months? For example, instead of the standard 12 monthsto the year,
isyour year measured by 13 four-week periods?

Designing a User-Defined Calendar

Assumethat auser-defined calendar islocated in atablein the source database that
you are using to create an OLAP model. This table requires both of the following:

e A column for each potential time period (member) in the time dimension.

e Atime-related key column that mapsto the lowest-level, time-related column
associated with the measures data. See* Associating Time Datawith M easures
Data’ on page 2-20.

4-12 W Hyperion Integration Server Desktop OLAP Model User’s Guide



Creating the Fact Table, Accounts Dimension, and Time Dimension

Table 4-1 is an example of a user-defined calendar.

Table 4-1: A User-Defined Calendar

WK_OF | DAY_OF | DAY_OF
TIMESTAMP YEAR | QTR | MONTH | YEAR YEAR | WEEK | SEASON
Jul 11999 12:00AM 1999 |1 1 1 1 Thurs Summer
Jul 2 1999 12:00AM 1999 |1 1 1 2 Fri Summer
Jul 51999 12:00AM 1999 |1 1 2 5 Mon Summer
Jul 6 1999 12:00AM 1999 |1 1 2 6 Tues Summer
Jul 7 1999 12:00AM 1999 |1 1 2 7 Wed Summer
Jul 8 1999 12:00AM 1999 |1 1 2 8 Thurs Summer
Jul 9 1999 12:00AM 1999 |1 1 2 9 Fri Summer
Sep 11999 12:00AM 1999 |1 3 10 63 Wed Autumn
Sep 2 1999 12:00AM 1999 |1 3 10 64 Thurs Autumn
Sep 31999 12:00AM 1999 |1 3 10 65 Fri Autumn
Sep 6 1999 12:00AM 1999 |1 3 11 66 Mon Autumn

Table 4-1 illustrates several pointsto consider when creating a user-defined

calendar:

e Thefirst column, TIMESTAMP, isthe key column in the user-defined
calendar table. Thiscolumnisjoined to atime-related columninthefact table.
Asjoined columns, the columns must have the same data type. The key
column in a user-defined calendar defines the lowest level of time analysis
that the source data can provide to the fact table.
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e Inorder for themeasuresdata (such as sales) to map to the time members, each
value in the date column of the source data for the fact table must match a
value in the key column of the user-defined calendar table.

TIMESTAMP is acolumn with a datetime data type. Its values include the
time rounded in minutes to 12:00 AM; for example Jul 2 1999 12: 00AM.
TIMESTAMP isthejoin column from the user-defined table to the fact table.
Therefore, not only must the join column in the fact table have a datetime data
type, but also each time value must be rounded to 12 : 0oam. For example, if
asale occurred on July 2, 1999, at 8:30 AM, you must prepare the transaction
dateinthe source data so that the fact table and the user-defined calendar show
the samevalue, Jul 2 1999 12:00AM.

e Representing afiscal calendar starting with July 1, the calendar in Table 4-1
shows the July 1 timestamp value mapping to a 1 value for the quarter,
month, week, and day of the year.

e Table4-1showsonly afew rowsfor July and September. Actually, atable
must contain arow for every potential date in the source data. For example,
Table 4-1 does not include rows for the dates that are Saturdays and Sundays.
Unlessyou are surethat no datais posted with a Saturday or Sunday date, you
should include rows for those days.

e Table4-1lincludestwo columnsrelated to the day: the day of the year and the
day of the week. If you want to analyze whether sales are better on Mondays
than on Wednesdays, you need a column in the user-defined calendar and a
corresponding member in the time dimension for the day of the week.

e Table4-1lincludesaSEASON column. Although Autumn traditionally starts
in mid-September, the example shows Autumn starting on September first. Set
the values in the calendar to correspond to the needs of your company.

A user-defined calendar is as unique as the business regquirements of your
company.
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Switching the Time and Accounts Dimensions

Most databases store time values in rows and measures values in columns, as
shown in Table 4-2. For this type of data, you do not need to switch the time and
accounts dimensions.

Table 4-2: Time Data Stored in Rows

COGS Sales
January 105 127
February 111 214
March 120 189

Some applications, such as general ledger applications, store time valuesin
columns and measuresvaluesin rows, as shown in Table 4-3. For these databases,
you must switch the time and accounts dimensions in the OLAP model and then
set the dimension types correctly in the associated metaoutline. For more
information, see “ Switching the Time and Accounts Dimensions in the OLAP
Model” on page 4-16 and “ Setting Dimension Properties in the Metaoutling” on
page 4-18.

Table 4-3: Time Data Stored in Columns

January February March
COGS 105 111 120
Sales 127 214 189
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Switching the Time and Accounts Dimensions in
the OLAP Model

»  To switch time and accounts dimensionsin the OLAP model:

1. Create and name the fact table using the proceduresin “ Creating the Fact
Table” on page 4-5, with the following exceptions:

To the prompt for creating the time dimension automatically, click No.

To the prompt for creating the accounts dimension automatically, click
Yes.

Right-click the Accounts dimension table and select Propertiesto display
the Dimension Properties dialog box, change the name of the Accounts
dimension to Time, and click OK.

Right-click the newly created Time dimension table and select View
Columns to display the column names.

Right-click the Accounts table in the column view, select Properties to
display the Table Properties dia og box, change the name of the
Accounts dimension to Time, and click OK.

2. Inthe OLAP model main window, drag the source table that you used for the
fact table, for example, FACT_TABLE, to theright frame to create a new
dimension.

3. Whenadialog box promptsyou to renamethetable (becauseit already exists),
click Yes.

Hyperion Integration Server displays the Create New Table dialog box, as
shown in Figure 4-4.

Create Hew Table [ %]
Cancel |

Currertt T ables:

FACT_TABLE
Time

Figure 4-4: Create New Table Dialog Box
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4. Inthe Name text box, type Accounts and click OK to close the dialog box.

Inthe OLAP Model mainwindow, usethejoin tool to join the new dimension
to the fact table.

Click thejointool (or right-click in ablank space of the right frame and select
Add Joins Mode) to activate Add Joins Mode, and drag the tool between the
two tables.

Hyperion Integration Server displaysthe Create New Dimension dialog box
with the dimension name Accounts in the Name text box, as shown in

Figure 4-5.
o o |
Ok
IAccounts _
Cancel |
Dimenzion Type:
IDefauIt j Help |

o)

Time

Figure 4-5: Create New Dimension Dialog Box

6. From the Dimension Type drop-down list, select Default, and click OK to
close the dialog box.

7. Definethe joins completely, using al necessary keys.

8. Create any other dimensions that you need (see“ Creating Dimensions’ on
page 5-3).
9. Savethe OLAP model (see“Saving OLAP Models’ on page 3-20).

Complete the OLAP model before using it to create a metaoutline.
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Setting Dimension Properties in the Metaoutline

4-18 |

» To set properties for the time and accounts dimensions in the metaoutline:

1.

From the newly created OL AP model, create ametaoutline (see the Hyperion
Integration Server Desktop OLAP Metaoutline User’s Guide).

After you add the time dimension to the metaoutline, right-click the time
dimension and select Properties.

Hyperion Integration Server displays the General tab of the Dimension
Properties dialog box.

a. Selectthe Member Info tab.
b. From the Dimension type options, select Time.

c. Completeinformation on the other tabs as needed, and click OK to close
the dialog box.

Asneeded, right-click amember level name within the time dimension, select
the Properties option, complete information on the tabs.

Click OK to close the dialog box.
Right-click the accounts dimension and select Properties.

Hyperion Integration Server displaysthe General tab of the Dimension
Properties dialog box.

a. Selectthe Member Info tab.
b. From the Dimension type options, select Accounts.

c. Completeinformation on the other tabs as needed, and click OK to close
the dialog box.

As needed, right-click amember level name within the accounts dimension,
select the Properties option, and specify on each tab the information required
to define the selected member level.

Click OK to close the dialog box.

Continue with the workflow as described in the Hyperion Integration Server
Desktop OLAP Metaoutline User’s Guide.
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After you create a fact table, you continue building an OLAP model by adding
dimensions. Y ou can create atime dimension, an accounts dimension, and various
other dimensionsin an OLAP model. If you do not create time and accounts
dimensions when you create the fact table, you can add them manually as
described in Chapter 4, “ Creating the Fact Table, Accounts Dimension, and Time
Dimension.”

Y ou may also need to create additional dimensions to provide Hyperion Essbase
with enough information to meet your business analysis requirements. This
chapter describes how to create dimensions other than time and accounts and how
to edit dimensions and the fact table.

This chapter contains the following topics:

e “Understanding the OLAP Model Workflow” on page 5-2

e “Creating Dimensions’ on page 5-3

e “About Dimension Branches’ on page 5-5

e “Viewing Dimension Table and Fact Table Information” on page 5-13
e “Renaming Dimensions and the Fact Table” on page 5-14

e “Renaming Dimension Tables’ on page 5-15

e “Moving Tables’ on page 5-15

e “Deleting Dimension Tables or the Fact Table” on page 5-16
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Understanding the OLAP Model Workflow

52 1

Figure 5-1 illustrates the workflow for creating an OLAP model. This workflow
includes creating and working with an OLAP model; creating afact table, an
accounts dimension, and atime dimension; creating and working with dimensions;
editing and transforming the columns of dimension tables; joining dimension
tables; and creating and working with hierarchies. This chapter focuses on how to
create dimensions other than time and accounts and how to edit dimensions and
the fact table.

Creating and working
with OLAP models

* . Hyperion Integration Server Desktop - [TBC Model]
::= File Edit “iew Connections Toolz ‘Window Help

DEE[&[: [#] 2] 2 | /

TBCATTRIBUTE_OUNCES
TBCATTRIBUTE_PACKAGE

/

* . Hyperion Integration Server Desktop - [TBC Model]
::= File Edit “iew Connections Toolz ‘Window Help

Creating a fact table,
an accounts dimension,
and a time dimension

DEE[&[: [#] 2] 2 | /

=
E1E

AR || /
Creating and =

@ working with B8 Accounts___||
You Are Here dimensions | [EIZIT T [ Scenario |

Table Properties
General | Columns ~ Physical Joins | Dimensionsl

Mame Table Mame | Colurn Ma... | Hidden | Diill-Thro...
] TBC.FAC..  ADDITIO..
TBC.FAC.. CITY_ID e

Editing and transforming
columns

General | Columns ~ Physical Joins | Dimensionsl

Table Mame | Colurnn Ma... | Hidden | lI|
TBC.FAC..  ADDITIO..
TBC.FAC.. CITY_ID e

TBCFAC.. COGS

Joining dimension tables

Edit Hierarchy

Mame:
[VEAR-DUARTER-MONTH
. . =5 Vear % YEAR-GUARTER-MONTH
Creating and working =59 Time 20 TimeYear
i .

with hierarchies

B8 Time Quarter

Figure 5-1: OLAP Model Workflow
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Creating Dimensions

This topic describes how to create a dimension that joins directly with the fact
table. If you have not yet created afact table, see “ Creating the Fact Table” on

page 4-5.

Tip:  You can create two or more dimensions from asingle relational
database table. Each dimension must have a different name. You
should hide all columns that do not contain values that you want to be
reported for the dimension (see “Hiding and Showing Columns’ on

page 6-6).

» To create dimensions:
1. Drag the appropriate source table from the left frame to the right frame.

If you are not sure which table to use, view the data stored in the table by
selecting atable, right-clicking, and then selecting View Table Data. For
information, see “Viewing Table Data” on page 3-17.

e If apredefined primary-foreign key relationship exists between the table
that you are adding and the fact table, Hyperion Integration Server joins
the dimension table to the fact table. Because the dimension table joins
directly to the fact table, the dimension table is aso adimension.

e If apredefined primary-foreign key relationship does not exist between
the table that you are adding and the fact table, Hyperion Integration
Server does not join the dimension table to the fact table. To create the
dimension, join the dimension table to the fact table manually. See
“Joining Dimension Tables Directly to the Fact Table” on page 8-6.
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Hyperion Integration Server displaysthe Create New Dimension dialog box,
as shown in Figure 5-2. By default, the new dimension inherits the name of
the source table you select to createit.

Create Hew Dimension [ %]
Cancel |
Dimenzion Type:
IDefauIt j Help |

Current Dimensions:

Figure 5-2: Creating a New Dimension

2. If youwant to change the dimension name, in the Name text box, enter anew
name.

For naming rules, see “ Observing Naming Rules’ on page 3-28.
3. From the Dimension Type drop-down list, select Default.
4. Click OK.

Adding Tables to Dimension Tables
or to the Fact Table

5-4 H

Y ou can add tables to existing dimension tables or to the fact table by using either
of two methods:

e Youcanadd asourcetableto an existing dimensiontableto createadimension
branch by adding the new sourcetableto the OLAP model andjoining it to the
existing dimension table.

e You can add the new source table directly to an existing dimension table
without creating a branch.

The method used to add a table to a dimension affects both the OLAP model and
the metaoutlines that you create from the OLAP model.
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This topic describes how to add source tables to dimension tables and to the fact
table and explains the reasons to add tables to dimension tables or dimension
branches. This topic contains the following subtopics:

e “About Dimension Branches’ on page 5-5
e “Adding Source Tablesto Create Dimension Branches’ on page 5-6

About Dimension Branches

A dimension branch contains adimension table that joins directly to the fact table
(known as the primary dimension table) and to one or more related dimension
tables. In Figure 5-3, the LOOKUP_PRODUCT and ATTRIBUTE_OUNCES
dimension tables form a dimension branch for the Product dimension.

Dirnension
FACT_TABLE =l LOOKUP_PRODUCT =

f:e ADDITIONS J Pus CAFFEINATED

f:. CITY_ID B DIET

B:. COGS fo INTRO_DATE

Bz« ENDING_INVENTOR Pi: OUNCES_ID

Bre MARKETING 4 Bu: PACKAGE_TYPEID 3 =|| Dimension table

‘ in a dimension

branch

ATTRIEUTE_OUMNCES
P DUNCES
P OUNCES_ID e B

Figure 5-3: A Dimension Branch

Notice that both dimension tables are located in the Product dimension and that
both dimension tables display the name Product in their title bars.

The hierarchical structure of dimension branchesis similar to the consolidation
levels reported in Hyperion Essbase. The fact table in an OLAP model is
considered level 0 (zero). A dimension table joined directly to the fact tableis
level 1. A dimension tablejoined to another dimension table that isjoined directly
tothefact tableislevel 2. A dimensiontablejoinedto alevel 2 tableislevel 3, and
SO on.
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Level numbers are assigned to dimension tables and branches to provide a
hierarchical structure for you to work with as you create a metaoutline.
Viewing ahierarchical structurein an OLAP model helps you to define the
correct consolidation levelsyou require. Level numbersdo not carry over tothe
metaoutline or to the subsequent Hyperion Essbase outline.

Adding Source Tables to Create
Dimension Branches

5-6 H

The use of dimension branches offers some advantages, asillustrated in
Figure 5-4. In both the OLAP model and the metaoutline, it is easy to tell

to which source table each column belongs. In the metaoutline, it is easy to
add columns in the required order—the hierarchical order defined by the
dimension branch in the OLAP model. For example, in the metaoutline, the
columnsin the ATTRIBUTE_OUNCES table must be added before and
positioned above the columns from the LOOKUP_PRODUCT table.

In an OLAP model In a metaoutline
BB Product
=-

LOOKUP_PRODUCT 1 3 ATTRIBUTE_DUNCES
Be: CAFFEINATED H
P.. DIET
By INTRO_DATE =-E3 LOOKUP_PRODUCT
Be: DUNCES_ID
P. PACKAGE_TYPE_ID [ =

ATTRIBUTE_OUNCES
P DUNCES
P OUNCES_ID e B

Figure 5-4: Displaying Table and Column Information in a Dimension Branch

When you join a source table to an existing dimension table to create a dimension
branch, al columns of the table are added to the dimension. Each dimension table
in the dimension branch displays the original dimension table name.
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Y ou cannot create dimension branches for the fact table, for the time dimension,
or for the accounts dimension. To use multiple tables for the time and accounts
dimensions and for the fact table, add the tables directly (see “Adding Source
Tables Directly to Dimension Tables” on page 5-7).

» To add atable and its columns to form a dimension branch:

1. Drag the source table from the left frame to the right frame.

2. Join thetable to the dimension table as described in “ Joining Dimension
Tablesto Create or Expand a Dimension Branch” on page 8-8.

Adding Source Tables Directly to
Dimension Tables

When you add a new table directly to a dimension table, you combine the two
tables. Combining tables offers both advantages and disadvantages, asillustrated
in Figure 5-5.

In both the OLAP model and the metaoutline, the original sources of the columns
are not as clear asthey would beif the new table were part of adimension branch,
but, in the OLAP model, there are fewer tables. In the metaoutline, you can add
columnsin any order (that is, you are not required to duplicate the OLAP model

hierarchy).

In an OLAP model In a metaoutline
= Product

| LOOKEUP PRODUCT =-E3d LOOKUP_PRODUCT

P.: ATTRIBUTE_OUNCES_OUNCES_ID e ATTRIEUTE_DUNCES_OUNCES_ID

P.. CAFFEINATED [ e DIET

OUMCES
P DIET i
.. PRODUCT_DESC
§® ?JSCDEEATE .« PRODUCT_GROUP_DESC
Az

P.: OUNCES_ID

P PACKAGE_TYPE_ID

B... PRODUCT_DESC

B.ec PRODUCT_GROUP_DESC
P.: PRODUCT_GROUFP_ID

B, PRODUCT_ID

B.. PRODUCT_KEY o=

Figure 5-5: Displaying Table and Column Information from Multiple Tables
Combined in a Single Dimension Table
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When you add a new source table directly to an existing dimension table, you
must join columns between the two tables. If a column nameis used in both
tables, the name of the added tableis prefixed to the duplicate name from the
added table. For example, if in Figure 5-5, both the LOOKUP_PRODUCT
and ATTRIBUTES_OUNCES tables contain a column named DIET, the
DIET column of the ATTRIBUTES OUNCES table is renamed as
ATTRIBUTE_OUNCES DIET.

Note: To add tablesto the fact table, the time dimension, and the accounts
dimension, you must combine tables; you cannot create dimension
branches.

» To add a source table to a dimension table:

1. Dragthesourcetablefromtheleft frameto theright frame, positionit directly
over the dimension table to which you want to add it, and rel ease the mouse
button.

A dialog box prompts you to make sure that you want to add the columns to
the existing dimension table.

2. Toaddall columnsof the new dimension tableto the existing dimension table,
click Yes.

Hyperion Integration Server displays the Physical Joinstab in the Table
Properties dialog box, as shown in Figure 5-6.

Table Properties [ %]
Generall Colurnre  Physical Jains |

Tahle Tahle
| TBC.ATTRIBUTE_PACKAGE | [TBCLOOKUP_PRODUCT x|

Column | Calumn | -
PACKAGE_TYPE CAFFEINATED
PACKAGE_TYPE_ID DIET Add
INTRO_DATE | —
OUNCES_ID
PACKAGE_TYPE_ID
PRODUCT_DESC LI
Colurnm 1 | Colurmn 2
TEC.LOOKUP_PRODUCT.PAC.. TBCATTRIBUTE_PACKAGE.P..
Welete, |
Eecursian... |

QK I Cancel | Help |

Figure 5-6: Adding a Table to a Dimension Table
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Theleft Table drop-down list contains the name of the table that you just
added. Theright Table drop-down list contains the names of all tables
currently included within the dimension table, including the name of the
newly added table. The left and right Column lists contain the names of
the columns associated with the two selected tables. If a predefined
primary-foreign key relationship exists between the tables, the join
columns are displayed under Column 1 and Column 2 at the bottom

of the dialog box.

3. If thecolumn joinslisted in the join information box are correct and no joins
are missing, proceed to step 5.

4. If you need to join additional columns or if the column joinslisted in thejoin
information are not correct, complete the following steps:

a. Intheright Tablelist, select the table with which the newly added table
has a relationship.

b. From theleft and right Column lists, select from each table the columns
that you want to join; for example, PACKAGE_TYPE_ID.

Tip: If you double-click acolumnin one list, the column with the
same name is selected in the other list.

c. Tojointhe selected columns, click Add.

The columns that you select are displayed in the box at the bottom of the
dialog box.

d. Asneeded, repeat steps a. through c. to join additional columns from the
selected table.

5. When you finish specifying join information for the selected table, click OK
to return to the right frame of the OLAP Model main window.

If you select the origina dimension table to which you have added the new
dimension table and then right-click and select View Columns, al of the
columns that the new table contains are displayed in the original dimension
table.
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5-10 W

Now isagood time to hide or delete unwanted columns that the dimension table
received from the newly added table and to mark columns as Drill-Through. See
“Hiding and Showing Columns’ on page 6-6, “Deleting Columns’ on page 6-9,
and “Defining Drill-Through Columns” on page 6-12.

Note: Deleted columns are permanently removed from the OLAP model. If
you later decide to include the deleted columns, you must re-create
the OLAP model.

About Adding Tables to the Time Dimension
When adding source tables to the time dimension, remember the following:

e Thetablethat you add must have at least one column with date or time
information; for example, a shipping date. The column can be any data type.

e Thecolumns are not added to the fact table. Likewise, when you add atable
to the fact table, the columns are not added to the time dimension.

For instructions on how to add tables to the time dimension, see “ Adding Source
Tables Directly to Dimension Tables” on page 5-7.

About Adding Tables to the Accounts Dimension
When adding source tables to the accounts dimension, remember the following:

e The source table that you are adding must have at least one measures data
column; for example, COGS (cost of goods sold).

e Thecolumnsare added to the fact table. Likewise, when you add atableto the
fact table, the columns it contains are added to the accounts dimension.

e Intheaccountsdimension, you can hide or delete non-measures columns after
you add atable (see “Hiding and Showing Columns’ on page 6-6 and
“Deleting Columns’ on page 6-9).

e Columnsthat are hidden or deleted in the accounts dimension do not appear
in thefact table; likewise, columns that are hidden or deleted in the fact table
do not appear in the accounts dimension.

Note: Deleted columns are permanently removed from the OLAP model. If

you later decide to include the deleted columns, you must re-create
the OLAP model.
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For instructions on how to add tables to the accounts dimension, see “Adding
Source Tables Directly to Dimension Tables” on page 5-7.

About Adding Tables to the Fact Table

After you create afact table, you can add other tables from the relational data
source to the fact table. For example, assume that you created the fact table from
asdestablein therelational data source. If you want to track inventory and keep
inventory data values in a separate table, you need to add to the fact table the
necessary columns from the relational data source inventory table.

When adding source tables to the fact table, remember the following:

e When you add a source table to the fact table, the source table columns are
added to the accounts dimension. Likewise, when you add atable to the
accounts dimension, the source table columns are added to the fact table.

e You can hide or delete columnsin the fact table after you add atable (see
“Hiding and Showing Columns” on page 6-6 and “Deleting Columns’ on

page 6-9).

e Columnsthat are hidden or deleted in the fact table do not appear in the
accounts dimension; likewise, columns that are hidden or deleted in the
accounts dimension do not appear in the fact table.

e When you add a source table to the time dimension, the source table columns
are not added to the fact table. Likewise, when you add a source table to the
fact table, the source table columns not added to the time dimension.

To ensurethat you select the correct relational sourcetablesto add to thefact table,
view the column names within the tables as described in “ Display of Column
Names’ on page 3-14. If you decide to hide columns after adding atable, check
column names after compl eting the process to make sure that you made the correct
selections.

Note: Deleted columns are permanently removed from the OLAP model.

If you later decide to include those columns, you must re-create the
OLAP modd.
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Adding Tables to the Fact Table

» To add tables to the fact table:

1. Dragthesourcetablefrom theleft frameto theright frame, position it directly
over the fact table, and release the mouse button.

A dialog box prompts you to make sure that you want to add the columnsto
the fact table.

2. To add the new table to the fact table, click Yes.

Hyperion Integration Server displays the Physical Joinstab in the Table
Properties dialog box.

3. Jointhe new tableto the fact table as described in “ Joining Dimension Tables
Directly to the Fact Table” on page 8-6.

Now isagood timeto hide or delete unwanted columnsthat the fact table received
from the newly added table. See “Hiding and Showing Columns’ on page 6-6 and
“Deleting Columns” on page 6-9.

Note: Deleted columns are permanently removed from the OLAP model. If

you later decide to include the deleted columns, you must re-create
the OLAP model.
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Viewing Dimension Table and
Fact Table Information

Theright frame of the OLAP Model main window contains the fact table and the
dimension tablesthat the OLAP model contains. Thistopic describes how to view
information about the fact table and related dimension tables.

» To view properties of a dimension table or of the fact table:

1. Select the dimension table or the fact table, and then select View > Properties
> Table.

Hyperion Integration Server displaysthe Gener al tab of the Table Properties
dialog box, as shown in Figure 5-7. The Gener al tab describes the dimension
table—its name, itsdimension, itslevel, and the names of itsrelational source
tables. The fact table islevel 0. Dimension tables joined to the fact table are
level 1. In adimension branch, dimension tables joined to level 1 dimension
tables are level 2; dimension tablesjoined to level 2 tables are level 3, and
SO on.

Table Properties E

General | Eolumnsl PhysicalJoinsI Dimensionsl

I ame:

Dimension:

Lewvel:

List of Physical Table(z]
TBC.FACT_TABLE

QK I Cancel | Help |

Figure 5-7: General Tab of the Table Properties Dialog Box
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2. Toview thetable propertiesfor the fact table, click the Dimensionstab to see
alist of al dimensionsin the OLAP model, as shown in Figure 5-8.

Table Properties E
Generall Eolumnsl Physical Joing  Dimensions |

Accounts Edit |

Market

Product

Scenario
ear

QK I Cancel | Help |

Figure 5-8: Viewing the Names of Dimensions in an OLAP Model

Renaming Dimensions and the Fact Table

When you create an OLAP model fact table or adimension, the source table name
isused by default. Thistopic describes how to change the name of adimension or
of the fact table. For information on how to change a dimension table name, see
“Renaming Dimension Tables” on page 5-15.

» To rename a dimension or to rename the fact table:

1. Intheright frame of the OLAP Maodel main window, select the dimension or
the fact table, right-click, and select Rename.

2. Enter the new name for the dimension or the fact table; for example,
GEOGRAPHY.

Follow the rules described in “ Observing Naming Rules’ on page 3-28.
3. PressEnter to record the new name.

Hyperion Integration Server displays the new name in the right frame.
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Renaming Dimension Tables

When you create adimension table, the source table name becomes the dimension
table name by default. Thistopic describes how to change the name of adimension
table. For information on how to change the name of a dimension or of the fact
table, see “Renaming Dimensions and the Fact Table” on page 5-14.

» To rename adimension table:

1. Intheright frame of the OLAP Model main window, select the dimension
table.

If the dimension table is not visible, drag the corner of the dimension box
down until the dimension table isvisible.

2. Click thedimension table.
3. Enter the new name.

Follow the rules described in “ Observing Naming Rules’ on page 3-28.
4. Press Enter to record the new name.

Hyperion Integration Server displays the new name in the right frame.

Moving Tables

Y ou can rearrange dimension tables and the fact table in the right frame. For
example, you can move atableto allow room to display al columnsof thetablein
theright frame. Y ou can a so move tables to display the tables more clearly in the
right frame of the OLAP Model main window.

» Tomove atable:

1. Make surethat the join tool isin Move mode, not in Add Joins mode.

In Move mode, the join tool is not indented, -

In Add Joins mode, the join tool isindented, 2 .

If the join tool isin Add Joins mode, click the join tool to change it to
Move mode.
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2.

Select the dimension table and drag it to the new location.

If the dimension table that you move isjoined to another dimension table, the
join line also moves.

Deleting Dimension Tables or the Fact Table

Remember these rules when deleting dimension tables or the fact table:

5-16 W

If you delete atable, its columns are not available for metaoutlines.

Deleting atable in the OLAP model does not affect the tables of the relational
data source.

When you delete atable, you also delete the joins associated withiit.

If you delete atablethat isthe primary dimension table of adimension branch,
the other dimension tables of the branch remain in the OLAP model as
unjoined dimension tables. When you validate or save an OLAP model with
unjoined tables, you receive an error message and you cannot use the model
to create a metaoutline.

You cannot delete tables that are used in hierarchies or metaoutlines.
If you delete the fact table, the accounts dimension is deleted.

If you delete the fact table and you created the time dimension from the fact
table, the time dimension is del eted.

If you delete the fact table, the next source table that you drag to the right
frameis used to create a new fact table.

» To delete adimension table or the fact table:

1.

Inthe right frame of the OL AP model main window, right-click the dimension
table or the fact table, and select Delete.

Hyperion Integration Server displays a delete confirmation dialog box.
Click Yesto confirm the deletion.
The dimension table or fact table is removed from the OLAP modd!.
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Dimension Tables
and the Fact Table

Each source table that you drag to the right frame to create a fact table or
dimension table contains columns. Y ou can perform operations on columns
contained in the tables you create. For example, you can rename, hide, and delete
columns and use them to create time hierarchies. This chapter describes how to
edit columns and how to create user-defined columns. For information on
changing column values, see Chapter 7, “ Transforming Columns.”

This chapter contains the following topics:

“Understanding the OLAP Model Workflow” on page 6-2
“About Column Data Types’ on page 6-3

“Viewing Column Properties’ on page 6-4

“Renaming Columns’ on page 6-6

“Hiding and Showing Columns® on page 6-6

“Working with Multiple Columns” on page 6-8

“Deleting Columns’ on page 6-9

“Using a Column to Create Time Hierarchies’ on page 6-10
“Defining Drill-Through Columns’ on page 6-12

“Creating User-Defined Columns’ on page 6-14
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Understanding the OLAP Model Workflow

Figure 6-1 illustrates the workflow for creating an OLAP model. This workflow
includes creating and working with an OLAP model; creating afact table, an
accounts dimension, and atime dimension; creating and working with dimensions;
editing and transforming the columns of dimension tables; joining dimension
tables; and creating and working with hierarchies. This chapter focuses on editing
columns in dimension tables and the fact table.

Creating and working
with OLAP models

* . Hyperion Integration Server Desktop - [TBC Model]

::= File Edit “iew Connections Toolz ‘Window Help

DEHE|S|- - |E 22| /
TECATTRIBUTE_OUMCES /
TECATTRIBUTE_PACKAGE

* . Hyperion Integration Server Desktop - [TBC Model]
::= File Edit “iew Connections Toolz ‘Window Help

Creating a fact table,
an accounts dimension,
and a time dimension

DEE[&[: [#] 2] 2 | /

+--FJ TBCATTRIBUTE_OUMCES | 5 /
7] TECATTRIBUTE_PACKAGE O FACT_TABLE
|

Creating and working §E FACT TABLE B8 Accounts |
with dimensions
= Product | + Scenario |

Tahle Properties
General | Columns ~ Physical Joins | Dimensionsl
@ Editing and
transforming

Mame Table Mame | Colurn Ma... | Hidden | Diill-Thro...
You Are Here  columns

R

TBCFAC..  ADDITIO..
TBCFAC.. CITY_ID Y

General | Columns ~ Physical Joins | Dimensionsl

[ {

Table Mame | Colurnn Ma... | Hidden
TBC.FAC..  ADDITIO..
TBC.FAC.. CITY_ID e

TBCFAC.. COGS

Joining dimension tables

E% YEAR-QUARTER-MONTH
EH&) Time.v'ear
EH&) Timne. Quarter

----- B¢ Time.Month

Creating and working
with hierarchies

Figure 6-1: OLAP Model Workflow
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About Column Data Types

When you drag asourcetableto theright frameto createafact table or adimension
table, OLAP Integration Server assigns a data type to each column of the table
based on the Open Database Connectivity (ODBC) data type of the column in the
source table. Table 6-1 shows commonly used names for these data types. Some
relational database management systems (RDBM Ss) use different names. Some
RDBMSs do not list all types; see the SQL documentation for the RDBM S that
you are using.

An OLAP model refersto columns as having numeric, string, or datetime
data types.

Table 6-1: Mapping ODBC Data Types to Hyperion
Integration Server Data Types

ODBC Data Type Hyperion Integration Server Data Type

CHAR String. OLAP Integration Server handles CHAR
columns that include up to 80 characters. For aCHAR
column exceeding 80 characters, add a string column
that is based on the CHAR column and use a substring
transformation rule to extract 80or fewer characters (see
“Creating User-Defined Columns” on page 6-14).

VARCHAR String

DECIMAL Numeric

NUMERIC Numeric

TINYINT Numeric

SMALLINT Numeric

BIGINT Numeric

INTEGER Numeric

REAL Numeric

FLOAT Numeric

DOUBLE Numeric

DATE DateTime
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Table 6-1: Mapping ODBC Data Types to Hyperion
Integration Server Data Types (Continued)

ODBC Data Type Hyperion Integration Server Data Type
TIME DateTime
TIMESTAMP DateTime

OLAP Integration Server does not include columns with the following data types:
e LONGVARCHAR

e BIT

e BINARY

e VARBINARY

o LONGVARBINARY

Viewing Column Properties

In the OLAP Model main window, you can view the name and properties of any
column at any time.

» To display the names and properties of columnsin adimension table or in the fact
table:

1. Todisplay ascrollablelist of column names, as shown in Figure 6-2,
right-click the dimension and select View Columns.

LOOKUP_PRODUCT =]
P: CAFFEINATED
B DIET
B IMTRO_DATE
P.: OUNCES_ID
B PACKAGE_TYPE_ID [ |+

Figure 6-2: View Columns Option
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The following graphics identify column properties.

Eﬁac
Bz

woE b fip e &

identifies a string column.

identifies a measures column in the fact table.

identifies a numeric columnin any dimension table other than the fact
table.

identifies a datetime column.
identifies a hidden column.

identifies a Drill-Through column.

identifies ajoin column.

identifies a primary key column.

identifies a column on which a hierarchy filter is defined.

identifies a column on which a column transformation is defined.

identifies a column on which a hierarchy transformation is defined.

2. If you want to turn off the display of all graphics next to columns, deselect
View > Model Icons > All.

Y ou can aso choose to turn off the display of individual column graphics; for
example, to turn off the display of all primary key graphicsin the OLAP
model, deselect View > Model Icons > Primary Key.

3. To closethe column lit, right-click and select View Columns.
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Editing Columns

Y ou can perform avariety of basic editing procedures on columns. Y ou can
rename columns, hide and show columns, and del ete columns. When you edit
columns, you can select an individual column, or you can select multiple columns
on which you want to perform the same editing procedure.

Renaming Columns

Y ou can rename any column in adimension table or in the fact table. Renaming a
column in the OLAP model does not affect the relational data source.

» To rename a column:

1. Intheright frame of the OLAP Model main window, select the column.

If the column is not visible, drag down the corner of the dimension table
containing the column until the column isvisible.

2. Click the column name.
3. Enter the new column name.

Follow the rules described in “ Observing Naming Rules’ on page 3-28.
4. Press Enter to record the new name.

Hyperion Integration Server displays the new name in the selected table.

Hiding and Showing Columns

6-6 B

Typicaly, relational data source tables contain some columnsthat you do not want
to include in a Hyperion Essbase database. Hiding a column removes it from an
OLAP model in the sense that the column is not available to a metaoutline as
member level, ameasure, an alias, or a Drill-Through column.

Y ou canjoin dimension tables on hidden columns. Y ou can also show apreviously
hidden column if you change your mind and want to make the column available to
ametaoutline. Hiding columns does not affect the relationa data source.

Note: Inan OLAP model, you cannot hide a column that is used in an
associated metaoutline.
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» To hide or show acolumn:
1. Choose one of the following options:

e Select thefact table or dimension table, and then select
View > Properties > Table.

e Drag the corner of adimension table until its columns are visible,
right-click the table name within the column view, and select Properties.

Hyperion Integration Server displaysthe Gener al tab of the Table Properties
dialog box.

2. Select the Columnstab.

The Columnstab displaysall columnsavailableinthe OLAP model. For each
hidden column, the Hidden field containsa Y (Yes), as shownin Figure 6-3.

Table Properties [ %]

General Columns | PhysicalJoinsI

Narme | TableMa.. [ Column M... [ Hidden [ Diil-Tk~
e: CAFFEINATED  TEC.LOO.. CAFFEIN.. v Edit.. |

Be: DIET TECLOO.. DIET
BmINTRO_DATE  TBCLOO.. INTRO_D.. ¥ Add..
Bz DUNCES TBCATT.. OUNCES

Bz DUNCES_ID TBC.LOO.. OUNCES.. Y Delete. . |

Bi: PACKAGE_TY.. TECLOD.. PACKAGE.. A

Be:PRODUCT_D.. TECLOD.. PRODUC.. [rate-Hierarcty |

B PRODUCT_G.. TECLOD.. PRODUC..

Be: PRODUCT_G.. TECLOD.. PRODUC... Hide |

B PRODUCT_ID  TECLOD.. PRODUC...

B SENDINARYS TecLo0.. PRODUC. A — Drill-Through |

B SIZE TBCATT.. SIZE
| R, TR ATT e hl
< | _>l_I

QK I Cancel | Help |

Figure 6-3: Viewing Hidden Columns on the Columns Tab
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3. Choose one of the following settings:

e To hide one or more available columns (columns without aY in the
Hidden column), select each appropriate column, and click Hide.

e To show one or more hidden columns (columnswith aY in the Hidden
column), select each appropriate column, and click Hide to reverse the
setting.

To select multiple columns, see “Working with Multiple Columns’ on
page 6-8.

If you select acombination of columns (some with and somewithout the Y in
the Hidden column) and then click Hide, all selected columns are hidden.

If you select acolumnwith aY inthe Drill-Through column, the Y is
removed from the Drill-Through column and placed in the Hidden column
because columns cannot be both hidden and Drill-Through.

Working with Multiple Columns

Y ou can apply a procedure to an individual column or to multiple columns. If you
want to apply a procedure to multiple columns, use the Table Properties dialog
box to select the members.
» To select multiple, contiguous columnsin the Table Properties dialog box:
1. Click thefirst column name.
2. Shift-click the last column name.
Thefirst, last, and all columns between are selected.

» To select multiple, non-contiguous columns in the Table Proper ties dialog box:
1. Click the name of the first column.

2. Hold down Ctrl and click the individual names of the other columns.
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Deleting Columns

Y ou can del ete unwanted columns from dimension tables and from the fact
table. Deleting columnsis different from hiding columns; deleted columns are
permanently removed from the OLAP model. If you later decide to include the
deleted columns, you must re-create the OLAP model.

Deleting columns from an OLAP model does not affect the relational data source.

Note: You cannot delete columnsthat are currently used in joins,
hierarchies, or associated metaoutlines.

» To delete a column from a dimension table or from the fact table:

1. Select the dimension table or the fact table, and then select
View > Properties > Table.

Hyperion Integration Server displays the Table Properties dialog box.

Tip: You can also delete a column by selecting it in the OLAP Mode
main window, right-clicking, and selecting Delete.

2. Select the Columnstab.
3. Select the column to delete.

To select multiple columns, see “Working with Multiple Columns’ on
page 6-8.

4. Click Delete.
Hyperion Integration Server displays a delete confirmation dialog box.

CAUTION: Use caution when deleting. You cannot undo the deletion
of acolumn.

5. Click Yesto confirm the deletion.

The selected column name is removed from the list of namesin the
Columnstab.
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Using a Column to Create Time Hierarchies

Y ou can create predefined time hierarchies automatically from a single column.
For example, you can select a column containing atimestamp, such aspec 29
1999 0733aM and use the values of the timestamp to create a hierarchy that
includes the year (1999), quarter (Qtr_4) and month (December).

» To transform a date column into a hierarchy:

1. Select the dimension table that contains the column that you want to use to
create a hierarchy and then select View > Properties > Table to display the
Table Properties dialog box.

2. IntheTable Properties dialog box, select the Columnstab.

Table Properties [ %]
General EOngns | PhysicalJoinsI
| TableMa.. [ ColumnM... [ Hi. | DilThe.. |

TBC.FAC.. TRANSD.. Edit... |

TBC.FAC.. TRANSD..
Ao TRANSDATE  TECFAC. TRANSD.. Y Add...

B vear TECFAC..  TRANSD..

Delete... |

[rate-Hierarchy |

Hide |

Dill-Through |

QK I Cancel | Help

Figure 6-4: Columns Tab, Table Properties Dialog Box
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3. Select the appropriate date or time column, and click Date-Hierarchy.
The Date Hierarchy dialog box, as shown in Figure 6-5, is displayed.

Date Hierarchy [ %]

To create a date hierarchy from a single table column, select from the

lizt below
“rear, Huarter la oK I
‘Vear, Quarter, Month —
‘ear, Quarter, Month, Week |
‘Year, Quarter, Maonth, Day Capee!
“ear, Quarter, Morth, Week, Day Hel |
“rear, Month il

‘Year, Month, Week

‘Year, Month, Week, Day

“ear, Month, Day

‘ear, Week

Year, Day

Quarter, Maonth —
Quarter, Month, Week

Guarter, Month, wWeek, Day LI

Figure 6-5: Date Hierarchy Dialog Box

4. Select the hierarchy to create from the selected column; for example, Year,
Quarter, Month.

If you attempt to create a hierarchy that includes a column that already exists
within the OLAP model, Hyperion Integration Server displays an error
message. Y ou cannot create a hierarchy with a duplicate column name,
whether the duplicate column is contained in the source data or an OLAP
model fact table or dimension table (including user-defined columns).

5. Toreturn to the OLAP Model main window, click OK twice.
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Defining Drill-Through Columns

6-12

Drill-Through columns are not available as member levels, aliases, or measuresin
metaoutlines. Therefore, Drill-Through columns are not available to Hyperion
Essbase databases. However, Drill-Through columns are available to Hyperion
Essbase database users as additional information in reports.

For example, if you set the PRODDESC column as Drill-Through, PRODDESC
is not available to the Hyperion Essbase database. However, when Hyperion
Esshase Spreadsheet Add-in users drill through to areport that contains the
PRODDESC column, they see the product descriptions as a part of the detail. For
more information about Drill-Through reports, see the Hyperion Integration
Server Desktop OLAP Metaoutline User’s Guide.

Use the following guidelines when creating Drill-Through columns:

e You cannot define columnsin the accounts dimension table and the fact table
as Drill-Through.

e You cannot define a column as Drill-Through if the columnisusedin an
associated metaoutline.

e You can define hidden columns as Drill-Through.

CAUTION: Do not define columns as Drill-Through if you want to use
the columns as aliases, member levels, or measuresin a
metaoutline.
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» To change the Drill-Through property of a column:

1. Choose one of the following methods to display the Gener al tab of the Table
Properties dialog box:

e Select the dimension table, and select View > Properties > Table.

e Drag the corner of adimension table until its columns are visible,
right-click the table name within the column view, and select Properties.

2. Select the Columnstab.

The Columns tab displays all columns of the OLAP model, as shown in
Figure 6-6. Each Drill-Through column displaysaY (Yes) in the
Drill-Through field. All numeric columns in the accounts dimension table
and the fact table show NA under Drill-Through. An NA indicates that a
column is not available as a Drill-Through column.

Table Properties [ %]
General Columns | PhysicalJoinsI
| Table Na.. | Column . [ Hid_. [ Dril-Thraugh |
e: CAFFEINATED  TBCLOO.. CAFFEIN.. Y Edit. |
DIET : TECLOO.. DIET W
| TECLOO.. INTRO_. ¥ Add..

Bz DUNCES TBCATT.. OUNCES

Pee OUNCES_ID  TBCLOO.. OUNCE... W Deleten. |

P PACKAGE_T.. TBCLOO.. PACKAG.. Y

B FRODUCT_D... TECLOO.. PRODU.. D ate-hierarhy |

B, FRODUCT_G.. TECLOO.. PRODU..

P FRODUCT_G.. TECLOO.. PRODU.. Hidle |

B FRODUCT_ID  TEBCLOO.. PRODU..

P..PRODUCT_K.. TBCLOO.. PRODU.. ¥

B SIZE TBCATT.. SIZE

B SIZE_ID TBCATT.. SIZE_ID

QK I Cancel | Help |

Figure 6-6: Viewing Drill-Through Columns on the Columns Tab

3. Select one or more columns for which you want to add or remove the
Drill-Through property.

To select multiple columns, see “Working with Multiple Columns’ on
page 6-8.
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4. Click Drill-Through.

e If you select only columns that do not havea Y (Yes) inthe
Drill-Through column, each selected column receivesay.

e If you select only columnsthat haveaY inthe Drill-Through column,
the Y of each selected column is removed.

e If you select acombination of columnsthat do and do not haveay inthe
Drill-Through column, each selected column receives or retainsaY (as
determined by its previous status).

e If youselect acolumnthat hasay inthe Hidden column, theY is
removed from the Hidden column and placed in the Drill-Through
column because columns cannot be both hidden and Drill-Through.

Creating User-Defined Columns

6-14 W

User-defined columns are columns that you create, based on existing columnsin
the relational database. Y ou may want to add user-defined columns to dimension
tables for several reasons. For example, assume that you want to split out a
specific portion of the PRODCODE column. To accomplish this, you create a
SHORTPROD column from the first six characters of the PRODCODE column.
As aresult, when the value of PRODCODE is 100-10-C001-S0003, the value of
SHORTPROD is 100-10.

Another reason to add user-defined columns isto use the columns as levelsin a
time hierarchy. If you want monthly and quarterly aggregations in the Hyperion
Essbase database, you need monthly and quarterly columnsin the dimension table
for the time dimension. Y ou can add the columns as user-defined columns and
derive their values from a single transaction date column contained in the same
dimension table.

Y ou must base a user-defined column on existing columnsin adimension table. A
user-defined column assumes anumeric, string, or datetime datatype, based onthe
data type of the source column, as discussed in “ About Column Data Types’ on
page 6-3. You cannot change the data type of a column.

Adding user-defined columns to a dimension table includes two major steps:

e Selecting an existing column asthe source for the new column and naming the
new column

e Applying transformation rules that determine how the data values of the
user-defined column are derived from the source column
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» To add a user-defined column to a dimension table;

1. Select thetable that contains the source column on which you want to base a
new column.

2. Choose one of the following methodsto display the Gener al tab of the Table
Properties dialog box:

e Select thefact table or dimension table and then select
View > Properties > Table.

e Drag the corner of adimension table until its columns are visible,
right-click the table name within the column view, and select Properties.

3. Select the Columnstab, shown in Figure 6-7.

Table Properties E
General Columns | PhysicalJoinsI Dimensionsl

N | TableMa.. | ColumnM... [ Hi. [ Dil-The. «

TBC.FAC..  ADDITIO.. M Edit... |
Be.CITY_ID TBC.FAC.. CITY_ID e M
B cOGS TBC.FAC.. COGS M Add...
e EMDING_INV.. TECFAC. ENDING_... M
Bz« MARKETING TBC.FAC..  MARKETI. M Delete... |
Be.MiSC TBC.FAC.. MISC M
fe. OPEMING_IN.. TECFAC.. OPENIN.. M [ ate-Hieranety |
Bz. PavROLL TBC.FAC.. PAYROLL M
f:. PRODUCT_KEY TECFAC. PRODUC. ¥ [T — Hide |
B salEsS TBC.FAC.. SALES M
Be.SCEMARIOID TECFAC. SCEMARL. ¥ M& e [l -Titragt |
4 |_>|_I

QK I Cancel | Help |

Figure 6-7: Table Properties Dialog Box, Columns Tab
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4. Click Add.

Hyperion Integration Server displaysthe Add New Column to Table dialog
box, as shown in Figure 6-8.

Add New Column to Table 'FACT_TABLE"
M ame:
IF'hysicaI Table: Cancel |
| TBC.FACT_TABLE =1 Help |
Physical Columi:
|aDDITIONS =l
Type:

INumeric

Figure 6-8: Adding a User-defined Column to a Dimension Table

5. Enter the name of the user-defined column; for example, NETSALES.
Follow the rules described in “ Observing Naming Rules’ on page 3-28.

6. FromthePhysical Tablelist, select the sourcetable that contains the column
on which you are basing the user-defined column; for example,
TBC.FACT_TABLE.

7. From the Physical Column list, select the source column that contains the
data values from which you want to derive the values of the new column; for
example, ADDITIONS.
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8. Click OK.

Hyperion Integration Server displays the General tab of the Column
Propertiesdialog box, asshownin Figure 6-9. Thetab listsinformation about
the column that you are creating.

Column Properties [ %]

General | Transfarmation Hulel

Fhysical Table:
ITBE.FAET_TAB LE

Physical Column:

}AD DITIONS

Type:

I Murneric j
Aggregation:

|sum =l

QK I Cancel | Help |

Figure 6-9: Specifying General Properties for a User-defined Column

The General tab displays the name that you just entered, the names of the
source (physical) table and column, and the data type of the column.

If the user-defined column isin the accounts dimension and the column has a
numeric datatype, the dialog box also contains an Aggr egation drop-down
list. Aggregation options are methods for consolidating column data.
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9. If the user-defined column belongs to the accounts dimension table, from the
Aggregation drop-down list, select an aggregation option.

SUM: addsthe datafor each reporting level. SUM isthe default selection.

<NONE>: prevents a column from being available as measures to the
metaoutline. Typically, <NONE> isthe aggregation option specified for a
join column.

AV G, MIN, or MAX: reports, respectively, the average, minimum, or
maximum value computed from the datain the column.

COUNT: reports, for each reporting level, acount of the source datacells
that are not NULL.

10. To define the transformation rule for the user-defined column, click the
Transfor mation Rule tab.

Hyperion Integration Server displays the Transformation Rule tab
appropriate to the data type of the column with which you are working.
For more information about transformations for each data type, see one
or more of the following subtopics:

6-18

“Defining Transformations that Use Substrings to Create String
Columns’ on page 7-3

“Defining Transformations that Use Concatenations to Create String
Columns” on page 7-5

“Defining Transformations for Numeric Columns” on page 7-9
“Defining Transformations for Datetime Columns’ on page 7-12
“Defining Pass-Through Transformations’ on page 7-14
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Y ou use transformation rules to define how the datain columnsis derived.

Y ou can perform transformations that are common to most relational database
management systems (RDBM Ss) and define transformations that are specificto a
particular RDBMS. OLAP Integration Server performs column transformations
when it loads members into a Hyperion Essbase outline.

This chapter describes how to transform columns in the right frame of the
OLAP Model main window. For information on editing columns, see Chapter 6,
“Editing Columnsin Dimension Tables and the Fact Table.” For information on
transforming columns that are part of ahierarchy, see Chapter 9, “ Creating and
Working with Hierarchies.”

This chapter contains the following topics:
e “Understanding the OLAP Model Workflow” on page 7-2

e “Defining Transformationsthat Use Substringsto Create String Columns’ on
page 7-3

e “Defining Transformations that Use Concatenations to Create String
Columns’ on page 7-5

e “Defining Transformations for Numeric Columns’ on page 7-9
e “Defining Transformations for Datetime Columns’ on page 7-12
e “Defining Pass-Through Transformations’ on page 7-14

e “Editing Column Transformation Rules’ on page 7-17
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Understanding the OLAP Model Workflow

Figure 7-1 illustrates the workflow for creating an OLAP model. This workflow
includes creating and working with an OLAP model; creating afact table, an
accounts dimension, and atime dimension; creating and working with dimensions;
editing and transforming the columns of dimension tables; joining dimension
tables; and creating and working with hierarchies. This chapter focuses on
transforming columns in dimension tables and the fact table.

Creating and working
with OLAP models

* . Hyperion Integration Server Desktop - [TBC Model]
::= File Edit “iew Connections Toolz ‘Window Help

DEHE|S|- - |E 22| /
TECATTRIBUTE_OUMCES /
TECATTRIBUTE_PACKAGE

* . Hyperion Integration Server Desktop - [TBC Model]
::= File Edit “iew Connections Toolz ‘Window Help

Creating a fact table,
an accounts dimension,
and a time dimension

DEE[&[: [#] 2] 2 | /
+--FJ TBCATTRIBUTE_OUMCES | - /
: -3 TBCATTRIEUTE_PACKAGE d FACT_TABLE
L
Creating and working 48 FACT TABLE 7 Accounts |
with dimensions
[ Product___|| [ Scenario ||

Tahle Properties
General | Columns ~ Physical Joins | Dimensionsl
@ Editing and
transforming

Mame Table Mame | Colurn Ma... | Hidden | Diill-Thro...
You Are Here  columns

R

TBCFAC..  ADDITIO..
TBCFAC.. CITY_ID Y

General | Columns ~ Physical Joins | Dimensionsl

[ {

Table Mame | Colurnn Ma... | Hidden
TBC.FAC..  ADDITIO..
TBC.FAC.. CITY_ID e

TBCFAC.. COGS

Joining dimension tables

E% YEAR-QUARTER-MONTH
EH&) Time.v'ear
EH&) Timne. Quarter

----- B¢ Time.Month

Creating and working
with hierarchies

Figure 7-1: OLAP Model Workflow
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Defining Transformations that Use Substrings
to Create String Columns

Y ou can define astring column as a substring of another column, provided that the
two columns are in the same dimension. For example, if only the six characters at
the beginning of the PRODCODE column are meaningful to your analysis, you
can create a SHORTPROD column that contains only thefirst six characters. Asa
result, when the value of PRODCODE is 100-10-C001-S0003, the val ue of
SHORTPROD is 100-10.

To define atransformation rule for a user-defined column, see “Creating
User-Defined Columns’ on page 6-14.

To use a pass-through transformation, see “Defining Pass-Through
Transformations” on page 7-14.
» To define atransformation rule that uses a substring to create a string column:

1. Select the appropriate dimension table and then select View > Properties >
Table

2. IntheTable Properties dialog box, select the Columnstab.

3. Double-click the column that you want to transform to display the Column
Properties dialog box.
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4. Inthe Column Propertiesdialog box, select the Transformation Rule tab.

Column Properties [ ]

General Transformation Rule |

™ Passthrough [Databass Specifich D ate-part l <Nones LI

Function:

Substring
Concatenate

QK I Cancel | Help

Figure 7-2: Transformation Rule Tab for a String Column

The Function list displays the options that you can use to derive the new
column from the source data.

For numeric and string columnsin thetime dimension, thedial og box contains
aDate-part drop-down list. Use the optionsin the Date-part list to use a
column to define a Dynamic Time Series member and to report to-date totals,
such as week-to-date totals, in the Hyperion Essbase database. For more
information about defining Dynamic Time Series members, see the Hyperion
Integration Server Desktop OLAP Metaoutline User’s Guide.

5. Ifthecolumnisatime-related column of thetime dimension, inthe Date-part
drop-down list, select the part of the date that you want the column to
represent.

For example, if you want the substring to contain the year, select Y ears.
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6. IntheFunction list, select Substring.

Two text boxes, Start and Length, are displayed to theright of the Function
list, as shown in Figure 7-3.

Function: Start:

Concatenate

Figure 7-3: Adding a Column that Is a Substring
of Another Column

7. Inthe Start text box, enter a number that identifies the position in the source
column at which you want to start the substring.

For example, to start at the first position of the product code string, type 1.

8. IntheLength text box, enter a number that identifies how many characters
from the source column are needed in the new column.

For example, to use the first six positions of the product code, type 6.
9. Click OK.

Defining Transformations that Use
Concatenations to Create String Columns

Y ou can define the datain a string column by concatenating one or more string
columns provided that all columns are from the same dimension. For example,
assume that you want to create a single column, COLA_|ID-DESCRIPTION,
that contains values from both the PRODUCT _ID and the PRODUCT_DESC
columns. When the value of the PRODUCT _ID columnis 100-10 and the value of
the PRODUCT_DESC columnisKoolKola, the value of the concatenated column
becomes 100-10-KoolK ola.
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To define the transformation rule for a user-defined column, see “Creating
User-Defined Columns’ on page 6-14.

To use a pass-through transformation, see “Defining Pass-Through
Transformations” on page 7-14.
» To define atransformation rule that uses a concatenation to create a string column:

1. Select the appropriate dimension table and then select View > Properties >
Table.

2. IntheTable Propertiesdialog box, select the Columns tab.

3. Double-click the column that you want to transform to display the Column
Properties dialog box.

4. Inthe Column Propertiesdialog box, select the Transformation Rule tab.

Column Properties [ ]

General Transformation Rule |

™ Passthrough [Databass Specifich D ate-part l <Nones LI

Function:

Substring
Concatenate

QK I Cancel | Help

Figure 7-4: Transformation Rule Tab for a String Column

The Function list displays the options that you can use to derive the new
column from the source data.
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For numeric and string columnsin thetime dimension, thedial og box contains
aDate-part drop-down list. Use the optionsin the Date-part list to use the
column to define aDynamic Time Series member in the metaoutline and thus
toreport to-datetotals, such asweek-to-date total's, from the Hyperion Essbase
database. For more information about defining Dynamic Time Series
members, see the Hyperion Integration Server Desktop OLAP Metaoutline
User’'s Guide.

5. If thecolumnisatime-related column of thetime dimension, inthe Date-part
drop-down list, select the part of the date that you want the column to
represent.

For example, if you want the column to contain the year, select Y ears.
6. IntheFunction list, select Concatenate.

As shown in Figure 7-5, two list boxes, Column Names and Concate
Columns, are displayed to the right of the Function list box.

Column Properties [ %]

General Transformation Rule |

™ Pass-through [Database Specific)

Function: Column Mames Concate Columns
FRODUCT_DESC FRODUCT.FRODUCT I
- FRODUCT_GROUP_DESC
iLoncatenate
] |
=« i
I e b B s N

QK I Cancel | Help

Figure 7-5: Concatenating Columns

The Column Names list displays the name of the source table (PRODUCT)
as a column name prefix and the names of the columns that you can include
in the concatenated column (DESC and GROUP_DESC). The Concate
Columnslist initially displays the source column you selected to transform
(in this case, PRODUCT _ID).
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7.

8.
9.

In the Column Names list, select the name of the next column to includein
the concatenated column (PRODUCT_GROUP_DESC in this example), and

click the =l button.

The new column is placed at the end of the Concate Columnslist.

Tip: Tomove morethan one column at atime, select multiple columns.
See “Working with Multiple Columns” on page 6-8. Asthe
columns moveto the Concate Columnslist, they retain the same
sequence of the Column Nameslist.

To include additional columns, repeat step 7 for each column.
As necessary, complete and repeat one or both of the following actions:
e Toremove acolumn from the Concate Columns list, select the column

and click the _<| button. The sdlected column returns to the Column
Names list.

e To change the sequence of the column names in the Concate Columns

list, select a column name and then click the _Al button or the _"l button
until the columnisin the desired location.

10. When the Concate Columnslist displays all columnsto be concatenated and

7-8 1

they are sequenced in the correct order, click OK.

In the example shown, which produces a concatenated value of
100-10-K oolK ola from the sample database OLAP model columns, the
Concate Columnslist contain the following two columnsin the order
that they are listed:

TBC.LOOKUP_PRODUCT.PRODUCT_ID
TBC.LOOKUP_PRODUCT.PRODUCT_DESC
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Defining Transformations for
Numeric Columns

Numeric column transformations are the most common transformations for
columns of the accounts dimension table. A numeric column transformation isthe
result of acalculation that involves a source column and anumeric column that is
located in the same dimension. For example, you can add, subtract, multiply, or
divide the value of anumeric source column from the accounts dimension table by
the value of another numeric column from the accounts dimension table to derive
the value that you want to report.

For example, assume that you want to define a transformation rule for a new
column named NETPRICE. NETPRICE can be derived from the SALES and
DISCOUNTS columns of the TBC samplefact table called TBC.FACT_TABLE.
For the transformation rule, OLAP Integration Server uses the source

column, in this case, TBC.FACT_TABLE.SALES, asthefirst operand in the
calculation. Y ou specify the subtract operator (-) and the other operand, the
TBC.FACT_TABLE.DISCOUNTScolumn. Thus, thecalculationfor NETPRICE
isasfollows:

TBC.FACT_TABLE.SALES - TBC.FACT_TABLE.DISCOUNTS

Asaresult, for arow with avalueof 15.80 for SALESand 3.50 for
DISCOUNTS, thevalue of NETPRICE is12.30.

To define the transformation rule for a user-defined column, see “Creating
User-Defined Columns’ on page 6-14.

To use a pass-through transformation, see “Defining Pass-Through
Transformations’ on page 7-14.

» To define atransformation rule for a numeric column (a column with a numeric
datatype):

1. Select the appropriate dimension table and then select View > Properties >
Table.

2. IntheTable Properties dialog box, select the Columnstab.

3. Double-click the column that you want to transform to display the Column
Properties dialog box.
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4. Inthe Column Properties dialog box, click the Transformation Rule tab.

Column Properties [ ]

General Transformation Rule |

™ Passthrough [Databass Specifich D ate-part l <Nones LI
Operator: Colurnm:

| —

I Irvoert Parameters

QK I Cancel | Help

Figure 7-6: Transformation Rule Tab for a Numeric Column

The Operator list displays the types of operations available. The Column
drop-down list displays the names of all other numeric columnsin the
dimension table. Y ou can use any one of the numeric columns as the second
operand in the calculation.

For numeric and string columnsin thetime dimension, the dialog box contains
aDate-part drop-down list. Use the optionsin the Date-part list to use a
column to define aDynamic Time Series member in ametaoutline and thusto
report to-date totals, such as week-to-date totals, in the Hyperion Esshase
database. For more information about defining Dynamic Time Series
members, see the Hyperion Integration Server Desktop OLAP Metaoutline
User’s Guide.

5. Ifthecolumnisatime-related column of thetime dimension, inthe Date-part
drop-down list, select the part of the date that you want the column to
represent.

For example, if you want the column to contain the year, select Y ears.
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6. IntheOperator list, select an operator; for example, minus (-).

By default, the source column is the first operand in the calculation.

Note: Inthelist of available operators, the % operator is the modulus
function. The % operator returns the remainder of adivision
calculation; the % operator does not stand for percentage.

7. Inthe Column drop-down list, select a column to be the other operand; for
example, TBC.FACT_TABLE.COGS.

The calculation is displayed in the box below the Operator box, as shown in
Figure 7-7; for example:

TBC.FACT _TABLE.SALES - TBC.FACT_TABLE.COGS

Column Properties E

General Transformation Rule |

™ Pass-through [Database Specific)

Operator: Colurnm:

<Mone> i ABLE COGS
N ~
. ™ Invert Parameters

4
4

TBC.FACT_TABLE.SALES - TBC.FACT_TABLE.COGS

QK I Cancel | Help |

Figure 7-7: Defining a Transformation Rule for a Numeric Column
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8. Asnecessary, complete either or both of the following actions:

e Tochangetheoperator, fromthe Operator list, select adifferent operator.
The calculation reflects the change.

e To reverse the sequence of the operands, select Invert Parameters.
The operands switch their positions.
hyperion.SALESINVACT.SALES - hyperion.SALESINVACT.COGS
changesto
hyperion.SALESINVACT.COGS - hyperion.SALESINVACT.SALES

9. Whenthecaculation iscorrect, click OK.

Defining Transformations for Datetime Columns

7-12 1

For atime-related column, select atransformation rule that maps the content of the
new column to the appropriate portion of a date, such as the year or month. For
more information about columns in the time dimension, see “ Creating Time and
Accounts Dimensions’ on page 2-20.

Typicaly, time-related columns have a datetime data type. Time-related data can
also be stored with a string data type, with or without formatting. For example,

a string column can contain the date formatted with slashes, 03/24/1999, or
without slashes, 03241999. Time-related data can a so be stored with anumeric
data type, without formatting; for example, 19990324.

In most cases, you work with columns with a datetime data type in the time
dimension table and in the fact table. If you include a column with adatetime data
type in another type of dimension, you can use the column as ajoin column or as
a column to be used in Drill-Through spreadsheet reports (see “About Joins” on
page 8-3 and “ Defining Drill-Through Columns’ on page 6-12).

If your fiscal year starts at any month other than January, you must use a
user-defined calendar to tie measures data to time-related columns such as month
or quarter. For information, see “Creating Time and Accounts Dimensions’ on
page 2-20.

To define the transformation rule for a user-defined column, see “Creating
User-Defined Columns’ on page 6-14.

To use a pass-through transformation, see “Defining Pass-Through
Transformations” on page 7-14.
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» To define atransformation rule for a datetime column:

1.

Select the appropriate dimension table and then select View > Properties >
Table.

In the Table Properties dialog box, select the Columnstab.

Double-click the column that you want to transform to display the Column
Properties dialog box.

In the Column Properties dialog box, select the Transformation Rule tab.

Column Properties [ ]

General Transformation Rule |

™ Passthrough [Databass Specifich D ate-part l <Mones LI

Category: Function:

ears
Quarters
Manths
wheeks

QK I Cancel | Help

Figure 7-8: Transformation Rule Tab for a Datetime Column

In the Category list, select the time category for the column.

Select the part of the date that you want the new column to contain. For
example, if you select the Quarters category, OLAP Integration Server inserts
the quarter of the year into the new column. If the value in the source column
is04/21/1999, which isin the second quarter, OLAP Integration Server
inserts in the new column the value 2.

To copy the full date into the column, select <None>.
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6. IntheFunction list, select how to represent the date.

Category: Function:

M
MONTH

Description of
selected function ——Twa digit manth

Figure 7-9: Selecting the Transformation for Month Values

As shown in Figure 7-9, if you select Months from the Category list, the
Function list displays three possible formats: MM, MMM, and MONTH. If
the date value in the source columnisapril 15, 1999, and you select MM,
OLAP Integration Server inserts in the new column the value 04. Select
MMM for athree-character abbreviation; for example, apr. Select MONTH
for afull name, for example, April. Thetext box at the bottom of the
Transformation Rule tab describes the selected function.

7. Click OK.

Defining Pass-Through Transformations

7-14 1

If you need to extract data values for a column in ways other than those provided
in the Hyperion Integration Server Desktop standard user interface, use SQL
functions specific to the source RDBMS. When you define a pass-through
transformation rule, you provide a statement that OL AP Integration Server passes
through as a part of the SQL SELECT statement that it usesto build and load the
Hyperion Essbase outline and database.

For example, assume that a new column, SALESVAR, isbased on the SALES
column. Y ou want the value of the new column to equal the variance of the values
in the SALES column. The Hyperion Integration Server Desktop standard user
interface does not provide a variance transformation rule because the variance
function isnot common to all RDBM Ss supported by Hyperion | ntegration Server.
However, if the RDBM Syou are using supportsthe variance function, you can use
the pass-through transformation rule to calculate the variance of the valuesin the
SALES column.
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Y ou can use any function or stored procedure that isvalid for the source RDBMS.
For example, you can include a stored procedure that determines, based on certain
parameters that you include in the procedure, which of two columnsto use as an
alias column.

Y ou can also use stored procedures to perform calculations rel ated to the database
asawhole. Such a stored procedure might reduce the number of rowsincludedin
member load and dataload. For example, the standard procedure might restrict the
load to those products whose profit is greater than 30 percent.

Note: If you define a pass-through transformation in an OLAP model, you
must use the OLAP model with the RDBM S that you were using
when you defined the pass-through transformation.

» To define a pass-through transformation:

1. Select the appropriate dimension table and then select View > Properties >
Table.

2. Inthe Table Properties dialog box, click the Columns tab.

3. Double-click the column that you want to transform to display the Column
Properties dialog box.

4. Inthe Column Propertiesdialog box, select the Transformation Rule tab.
Click Pass-through (Database Specific).

The Transfor mation Rule tab changes to display atext box, shown in
Figure 7-10, for specifying the pass-through transformation.

6. Inthetext box, enter the command or the information needed to perform the
pass-through function.

Y ou can enter anything that you can validly insert in the SELECT clause of an
SQL statement in the source RDBMS. Make sure that the text that you enter
is not enclosed in quotation marks.

Note: For column names, always enter the user 1D, the dimension table
name, and the column name. Place periods between the elements;
for example, TBC.FACT_TABLE.SALES.

In the statement that you enter, do not type the word SELECT; enter only the
text that you want to add to the SELECT clause.
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The performance of the pass-through function produces the value of the new
column. Here are two examples of using the pass-through feature:

e Asshown in Figure 7-10, to derive the variance of the SALES column,
type VARIANCE (TBC. FACT TABLE. SALES)

¥ Pass-through [D atabase Specific)

ARIANCE(TBC FACT _TABLE SALES)

Figure 7-10: Using a Variance Pass-through Transformation

e Asshown in Figure 7-11, to derive the month portion of a date that
is stored in a numeric column (if the source RDBM S supports the %
operator as a modulus operator), type

(TBC.LOOKUP_TIME.TRANSDATE%10000)/100)

¥ Pass-through [D atabase Specific) Date-part:|<NDne> VI

[TEC.LOOKUP_TIME. TRANSDATE310000)/100)

Figure 7-11: Using a Calculation as a Pass-through Transformation

Note: For some RDBMSs, you usethe MOD or MODULUS operators
instead of the % operator.

7. Click OK.
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Editing Column Transformation Rules

Column transformation rules can be changed. The rulesthat are available for use
vary, depending upon the data type of the selected column. For more information
on data types, see “About Column Data Types’ on page 6-3.

» To change the transformation rule for a column:
1. Select the appropriate dimension table, right-click, and select View Columns.
2. Select the column to edit, right-click, and select Properties.

3. Inthe Column Properties dialog box, select the Transformation Rule tab
and make the appropriate changes.

For more information, see one of the following subtopics:

e “Defining Transformations that Use Substrings to Create String
Columns’ on page 7-3

e “Defining Transformations that Use Concatenations to Create String
Columns’ on page 7-5

e “Defining Transformations for Numeric Columns’ on page 7-9
e “Defining Transformations for Datetime Columns’ on page 7-12
e “Defining Pass-Through Transformations’ on page 7-14
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Joining Dimension Tables

This chapter describes tasks that you can perform on joins between tables that an
OLAP model contains. A join establishes a relationship between the data of one
table and the data of another table. Thejoin is based on column values common
to each table. The two tables can be one fact table and a dimension table, two
dimension tables, two source tables consolidated within a dimension table, or a
tablejoined toitself. Join relationships provide information that OL AP Integration
Server usesto retrieve datafromrelational sourcetables. OLAP Integration Server
then uses the data to build Hyperion Essbase outlines and load Hyperion Essbase
databases.

Note: Tasksthat you perform on the joins of an OLAP model do not affect

the relational data source.

This chapter contains the following topics:

“Understanding the OLAP Model Workflow” on page 8-2
“About Joins’ on page 8-3
“Joining Dimension Tables Directly to the Fact Table” on page 8-6

“Joining Dimension Tables to Create or Expand a Dimension Branch” on
page 8-8

“Joining Dimension Tables to Combine Table Columns’ on page 8-10
“Working with Joins” on page 8-13

“Defining a Recursive Table” on page 8-15
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Understanding the OLAP Model Workflow

82l

Figure 8-1 illustrates the workflow for creating an OLAP model. This workflow
includes creating and working with an OLAP model; creating afact table, an
accounts dimension, and atime dimension; creating and working with dimensions;
editing and transforming the columns of dimension tables; joining dimension
tables; and creating and working with hierarchies. This chapter focuses on
defining relationships between tables through joins.

Creating and working
with OLAP models

* . Hyperion Integration Server Desktop - [TBC Model]
::= File Edit “iew Connections Toolz ‘Window Help

DEHE|S|- - |E 22| /
TECATTRIBUTE_OUMCES /
TECATTRIBUTE_PACKAGE

* . Hyperion Integration Server Desktop - [TBC Model]
::= File Edit “iew Connections Toolz ‘Window Help

Creating a fact table,
an accounts dimension,
and a time dimension

DEE[&[: [#] 2] 2 | /
TECATTRIBUTE_OUMCES | - /
TEBCATTRIBUTE_PACKAGE ‘F'ACT—TABLE
L
Creating and working @ FACT TABLE 8 Accounts |
with dimensiorns [T Product___| [T Scenario__|

Table Properties
General | Columns ~ Physical Joins | Dimensionsl

Mame Table Mame | Colurn Ma... | Hidden | Diill-Thro...
] TBC.FAC..  ADDITIO..
TBC.FAC.. CITY_ID e

R

Editing and transforming
columns

@ Joining
dimension

You Are Here  tables

General | Columns ~ Physical Joins | Dimensionsl

[ {

Table Mame | Colurnn Ma... | Hidden
TBC.FAC..  ADDITIO..
TBC.FAC.. CITY_ID e

TBCFAC.. COGS

E% YEAR-QUARTER-MONTH
EH&) Time.v'ear
EH&) Timne. Quarter

----- B¢ Time.Month

Creating and working
with hierarchies

Figure 8-1: OLAP Model Workflow
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About Joins

Joins between two tables are formed through related columns called join columns.
Thejoin columns of the two tables represent the same entity. For example, assume
that two tables contain information about products. One table stores information
about product suppliers. The other table stores information about the number of
product units in the warehouse. Because both tables have a column that contains
product numbers, you can join the tables by using the product number columns as
join columns.

When a data value of ajoin column matches the data value of the corresponding
join column, the information contained in the associated rows of both tablesis
related. For example, in Figure 8-2, the datavaluesin join columns PRODUCTID
and PRODNO match, so al information in the KC-100 row of the PRODUCTS
table appliesto the KC-100 row of the ORDERS table. Thus, you know that the
supplier, Beverage Distrib. supplies the product Kool Colaat 1.10 per case.

PRODUCTID PRODDESC SUPPLIERID UNITOFMEASURE

PRODUCTS | KC-100 Kool Cola SUP440 case

ORDERS

I— Join columns

PRODNO SUPPLIERID SUPPLIERDESC CONTRACTPRICE
KC-100 SUP440 Beverage Distrib. 1.10

Figure 8-2: Join Columns Between Two Tables

Note: The names of the joined columns do not have to match.

e If the dimension table automatically joins to the fact table, and you want to
join the dimension tableto adimension tablein adimension branch, deletethe
join line between the dimension table and the fact table. You can now join the
dimension table to whatever table you select (see “ Joining Dimension Tables
to Create or Expand a Dimension Branch” on page 8-8).
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Why You May Need to Define Multiple Joins

Y ou may need more than one pair of join columnsto define ajoin relationship. For
example, if a product number, as used by two suppliers, indicates two different
products, you need to create two pairs of join columns, as shown in Figure 8-3.
Each pair of join columnsis called a column join. One column join includes the
product number columns of both tables. The other column join includes the
SUPPLIERID columns of both tables. The second column join ensures unique

joins.
PRODUCTID PRODDESC SUPPLIERID UNITOFMEASURE
PRODUCTS | KC-100 Kool Cola SUP440 Case
Iﬁ Column joins 7/
PRODNO SUPPLIERID SUPPLIERDESC CONTRACTPRICE
ORDERS KC-100 SUP440 Beverage Distrib. 1.10

Figure 8-3: Using Multiple Sets of Join Columns

In this example, for product KC-100 and supplier SUP440, the data of the
two rowsisrelated. If more than one supplier supplies Kool Cola, thejoin
on SUPPLIERID ensures that the price and supplier name retrieved from the
PRODUCTS table are correct for each supplier.
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How Joins Are Displayed in an OLAP Model

A join line between two tables indicates ajoin relationship. As shownin

Figure 8-4, asolid join lineindicates afully-defined join; that is, the join columns
of both dimension tables are specified (see “ About Joins’ on page 8-3). A broken
lineindicates that the dimension tables are joined but that the join columns are not
specified.

Note: If every dimension table is not joined either to another dimension
table or to the fact table, the OLAP model isinvalid. You can save an
invalid OLAP model, but you cannot use an invalid OLAP model to
create a metaoutline.

Any dimension table that you join to the fact table becomes adimension in the
OLAP model. Any dimension table that you join to another dimension table
becomes part of the dimension of that dimension table. For more information, see
“Adding Source Tables to Create Dimension Branches’ on page 5-6.

8 Accounts | j

Solid join line for a
fully-defined join

32 FACT TABLE / _l ——— Unjoined dimension

table (no join line)

[FACT_TABLE PRODUCT_KEY - LODKUP_PRODUCT.PRODUCT_KEY]+— Join tool tip listing

& LO0KUP_PRODUCT join colurmns
; Broken join line for
. an undefined join
OE—
« | _’I_I

Figure 8-4: Working with Joins in the OLAP Model

To seethepropertiesof ajoin, select thejoinline, right-click, and select Properties.
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To seethejoin columnsin ajoin, move the cursor over thejoin line. A tool tip
displays the names of the table and join columns. To hide the tool tip, deselect
View > Enable Join Tool Tips.

Note: If ajoin relationship exists between tables in the relational data
source, the columns join automatically when you add a new source
table to an existing dimension table in the OLAP model.

Joining Dimension Tables Directly to
the Fact Table

When you join adimension table to the fact table, the joined tableis called the
primary dimension table. The primary dimension table becomes a dimension to
form adimension branch. In adimension branch, only the primary dimension joins
directly to the fact table.

» Tojoin adimension table to the fact table:

1. Clickthejointooal, - , (inthe upper right of the OLAP Model main window)
to enter Add Joins mode, and draw aline between the dimension table and the
fact table.

Tip:  Another way to switch to Add Joins modeisto right-click in a
blank space of the right frame and select Add Joins Mode.

Hyperion Integration Server displaysthe Create New Dimension dial og box.
Note: If the predefined primary-foreign relationship exists between the
table that you drag to the right frame and the fact table, Hyperion

Integration Server creates ajoin automatically and displays the
Create New Dimension dialog box.
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2. Specify the dimension name and dimension type and click OK.
For more information, see “Creating Dimensions’ on page 5-3.

Hyperion Integration Server displaysthe Edit Join Info dialog box, as shown

in Figure 8-5.
Edit Join Info for FACT_TABLE and LOOKUP_PRODUCT E

FACT_TABLE LOOKUP_PRODUCT

MISC - INTRO_DATE ;I Close
OPEMING_INVENTORY OUNCES_ID

PavYROLL PACKAGE_TYPE_ID

PRODUCT_KEY PRODUCT_DESC &I
SALES PRODUCT_GROUP_DESC

SCENARIO_ID PRODUCT_GROUP_ID

TIME_ID PRODUCT _ID

TRAMSDATE - PRODLICT KEY -

4 I I 3 4 3

Current Jain Infarmation:
Colurnm 1 | Colurmn 2

FACT_TABLE.PRODUCT_KEY LOOKUP_PRODUCT.PRODLC... |

- = = Welete,
Help |

Figure 8-5: Specifying Column Joins Between the Fact Table and a New
Dimension

Above the left list box is the name of the fact table (in this case,
FACT_TABLE). Above theright list box is the name of the table
that you joined to the fact table (in this case, LOOKUP_PRODUCT).

Each box lists the columns of itstable. If a predefined primary-foreign key
relationship exists between the tables that you are joining, the Current Join
Information list box contains one entry for each column join between the two
tables.

For information about del eting joins, see “ Deleting Joins Between Dimension
Tables” on page 8-14 or “Deleting Joins Within Dimension Tables’ on
page 8-14.
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3. From eachtablelist, select ajoin column, and click Add.

For example, select PRODUCT_KEY in both tables. A solid line between the
selected columns connects the two tables.

The columns that you select are displayed in the Current Join Information
box.

Tip: Double-click acolumn in one table to select its corresponding
column in the other table.

4. For each column join that you want to add to the join definition, repeat Step 3.

Whenthe Current Join Information box listsall required columnjoins, click
Close.

Note: If you plan to create arecursive hierarchy from a newly-created
dimension, the table that you use to create the dimension must
have a self-join defined (see “ Defining a Recursive Table” on

page 8-15).

If you close the dialog box without defining a column join, the join line
displaysasabrokenline. The OLAP model isinvalid. Y ou can savethe OLAP
model, but you cannot useit to create a metaoutline until all joins are defined.
If you see abroken line, create avalid join. See “Working with Joins” on
page 8-13.

Joining Dimension Tables to Create or
Expand a Dimension Branch

Y ou can join adimension table to a primary dimension table, thus forming a
dimension branch (see “ About Dimension Branches’ on page 5-5.) You can aso
join adimension table to any table of adimension branch, thus expanding the
branch.
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» Tojoin two dimension tables:

1. Clickthejointooal, < , (inthe upper right of the OLAP Model main window)
to enter Add Joins mode, and drag the tool between the two tables.

Tip:  Another way to switch to Add Joins modeisto right-click in a
blank space of the right frame and select Add Joins Mode.

Hyperion Integration Server displays the Edit Join Info dialog box for the
join, as shown in Figure 8-6.

Edit Join Info for LOOKUP_PRODUCT and ATTRIBUTE_DUNCES [<]
LOOKUP_PRODUCT ATTRIBUTE_DUNCES

CAFFEINATED - OUNCES s

DIET DUNCES_ID [ e |

INTRO_DATE
STt

OUNCES D
PACKAGE_TYPE_ID
PRODUCT_DESC
PRODUCT_GROUP_DESC

PRODUCT, GHDUPJD_ILI
<| I 3

Current Jain Infarmation:

Colurnm 1 | Colurmn 2
LOOKUP_PRODUCT.OUNCES_ID ATTRIBUTE_OUNCES.OUNCE... Helie |

Help |

Figure 8-6: Specifying or Verifying Join Information for a
New Join Between Dimension Tables

At the top of the dialog box are the names of the original dimension

table and the table that you are joining to the original table (in this case,
LOOKUP_PRODUCT and ATTRIBUTE_OUNCES). Thelist boxes contain
the columns of their respective tables. If a predefined primary-foreign key
relationship exists between the tables that you are joining, the Current Join
Information list box contains one entry for each column join.

For example, in Figure 8-6, the Current Join I nfor mation list box showsthat
LOOKUP_PRODUCT table and the ATTRIBUTE_OUNCES table are
joined on the OUNCES ID column in both tables.
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2. From each tablelist, select acolumn to join, and click Add.

For example, select OUNCES |ID in both tables.

Tip: Double-click acolumn in one table to select its corresponding
column in the other table.

The columns that you select are displayed in the Current Join I nformation
list box.

For each column join that you want to add to the join definition, repeat Step 2.
Y ou can create column joinsin any sequence.

When the Current Join Information list displays al required column joins,
click Close.

In theright frame of the OLAP Model main window, asolid join line connects
the two joined tables.

Note: If you plan to create a recursive hierarchy from a newly-created
dimension, the table that you use to create the dimension must
have a self-join defined (see “ Defining a Recursive Table” on

page 8-15).

If you close the dialog box without defining a column join, the join line
displays as abroken line. An OLAP model that contains unjoined tablesis
invalid. You can save the OLAP model, but you cannot use it to create a
metaoutline until al joins are defined. If you see abroken line, create avalid
join. See “Working with Joins’ on page 8-13.

Joining Dimension Tables to Combine
Table Columns

8-10 W

Y ou can add a source table to a dimension by dragging the source table directly
onto an existing dimension table. When you use this process, the columns from the
second table are combined with the columns of the existing dimension table. When
you drop adimension table directly onto the fact table or onto another dimension
table, you must join the two tables. For more information, see “ Adding Source
Tablesto Create Dimension Branches’ on page 5-6.
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» To add and join a dimension table to another dimension table or to the fact table:

In the left frame of the OLAP Model main window, select a source table.

2. Dragthe sdlected source tableto theright frame, and drop it on the dimension

table to which you want to join it.

When you add a source tableto an existing dimension table or to thefact tabl e,

Hyperion Integration Server displays the Physical Joinstab of the Table
Properties dialog box, as shown in Figure 8-7.

Table Properties [ %]

Generall Colurnre  Physical Jains |

Tahle Tahle
|TBCATTRIBUTE_OUNCES x| [TBCLOOKUP_PRODUCT x|

Column | Calumn | -

OUNCES CAFFEINATED

OUNCES_ID DIET Add
INTRO_DATE |

FACKAGE TYPE_ID
PRODUCT_DESC =

Colurnm 1 | Colurmn 2
TEC.LOOKUP_PRODUCT.OUN... TBCATTRIBUTE_OUNCES.O..

Welete, |
Eecursian... |

QK I Cancel | Help |

Figure 8-7: Table Properties Dialog Box, Physical Joins Tab

Two drop-down lists at the top of the dialog box contain the names of the
joined tables. The Column lists display the names of the columns of their
respective tables. The join information box below lists the column joins.
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3. Ifyouwanttofind and correct incorrectly joined columns shown at the bottom
of the dialog box or if you want to join columns that are not already joined,
complete steps a. and b., as appropriate; otherwise, proceed to step 4.

a. If thetablesto bejoined are not already displayed, from the drop-down
Table lists, select the appropriate tables.

b. From each Column list, select a column to join, and click Add.

For example, in Figure 8-7, the Current Join I nfor mation list box showsthat
the TBC.ATTRIBUTE_OUNCES table and the TBC.LOOKUP_PRODUCT
table are joined on the OUNCES _ID column in both tables.

Tip: Double-click acolumn in one table to select its corresponding
column in the other table.

The columns that you select to join are displayed in the join information box
at the bottom of the dialog box.

If aprimary-foreign key relationship exists between one or more columns of
the selected tables, the join information box contains one entry for each
column join. In this example, the OUNCES _ID columns from the two tables
arejoined.

4. Repeat Step 3 for each column join at the bottom of the dialog box that you
want to add to the join definition.

Y ou can create column joinsin any sequence.

5. When thejoin information box lists al required column joins, click OK.
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Working with Joins

Y ou can view existing joins and edit them, as needed, to add new joinsto existing
dimension tables and to the fact table and to delete existing joins.

This topic contains the following subtopics:

e “Viewing Joins Information” on page 8-13

e “Deéleting Joins Between Dimension Tables’ on page 8-14
e “Deéleting Joins Within Dimension Tables’ on page 8-14

Viewing Joins Information

Toview join information for joins between tables, right-click the join line between
two dimension tables or between the fact table and a dimension table. Hyperion
Integration Server displays the Edit Join Information dialog box. (A different
dialog box is displayed if you click the dimension table rather than the join line.)

When the Edit Join Information dialog box opens, you can review the following
join property information:

e Names of joined tables
e Names of columns within the joined tables

e Names of joined columns

If you want to add column joins between tables, follow the same procedure as
described in Step 2 of “Joining Dimension Tables to Create or Expand a
Dimension Branch” on page 8-8.

If you want to delete column joins, see “ Deleting Joins Between Dimension
Tables” on page 8-14 and “Deleting Joins Within Dimension Tables” on
page 8-14.
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Deleting Joins Between Dimension Tables

Deleting ajoin between two dimension tables or between a dimension table and
the fact table results in an unjoined dimension table or dimension branch. An
unjoined dimension table or dimension branch makes an OLAP model invalid.

Y ou cannot create a metaoutline from an OLAP model that contains a dimension
table that is not joined either directly to the fact table or to adimension table that
joins, in series, to the fact table.

» To delete ajoin between two dimension tables or between a dimension table and
the fact table:

1.

Right-click the join line and select Delete.

Hyperion Integration Server displays a delete confirmation dialog box.
Click Y esto confirm the deletion.

Thejoin line disappears.

Tip:  Another way to delete ajoin between dimension tablesisto select
the join line and press Delete.

Deleting Joins Within Dimension Tables

8-14 N1

» To delete joins within adimension table:

1.
2.

Select the appropriate dimension, right-click, and select View Columns.
In the column view, select and double-click the dimension table name.

Hyperion Integration Server displaysthe General tab inthe Table Properties
dialog box.

Select the Physical Joins tab.

Click the column join that you want to delete, for example,
FACT_TABLE.PRODUCT_KEY, and click Delete.

In the OLAP model, the column join is removed from the table.
Note: If you delete all column joins, an OLAP model becomesinvalid.
To delete atable from within adimension table, delete all the

columns from the dimension table, as described in “ Deleting
Columns’ on page 6-9.

Hyperion Integration Server Desktop OLAP Model User’s Guide



Defining a Recursive Table

Joining Dimension Tables

A recursive table describes the hierarchical relationship of a Hyperion Essbase
dimension in just two columns. One column functions as a parent column and the
other column functions as a child column. Information in one row relates to
information in another row.

For example, assume that a payroll database includes an EMPLOY EES table that
contains a child column, EMPLOY EE_ID, and a parent column,

REPORTS TO_ID. Asshownin Figure 8-8, the data value (100101) is included
in two rows, one row in the child column and another row in the parent column.

EMPLOYEES

Table

Parent Column Child Column
REPORTS_TO_ID EMPLOYEE_ID
<NULL> 100101

100101 273645

273645 978663

Figure 8-8: Example of Parent and Child Columns in a Recursive Table

To define arecursive table, you need to join the table to itself. In relational
databases, this processis called a self-join. See “Joining a Table to Itself” on

page 8-19.

For more information about recursive tables, see “Building Hyperion Essbase

Hierarchies from Recursive Tables’ on page 2-8.
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Preparing Recursive Tables to Be Used with
Aliases and User-Defined Attributes

Table

A recursive table can contain additional information that relates to the parent
column or child column values. In Figure 8-9, the additional information provided
inthe FULL_NAME column and the TITLE column relates to the employees
named in the child column, EMPLOY EE_ID.

Parent Column Child Column Additional Information
EMPLOYEES REPORTS_TO_ID | EMPLOYEE_ID FULL_NAME TITLE
<NULL> 100101 John Smith CEO
100101 273645 Mary Lee VP Sales
273645 978663 James White Dir Sales,
Eastern Region

8-16 W

Figure 8-9: Example of a Recursive Table Containing Additional Information

OLAP Integration Server can use the values of the columns that provide the
additional information as aliases or as user-defined attributes (UDAS). A UDAis
aword or phrase that describes a member level.

In ametaoutline, you can assign an alias column to a parent or child column.
OLAP Integration Server then substitutes the value of the aias column for the
value of the parent or child column. Aliasesimprove the readability of Hyperion
Essbase outlines or reports. For example, if you use the product description
column (PRODUCT_DESC) as an dlias for the product code column
(PRODUCT_ID), users see the description, Root Beer, instead of the product
code, 200-10, on their reports.

In ametaoutline, you can create a UDA for a member level. For example, you
might create a UDA called Under Forecast for regions whose sales are less than
the forecast.

Hyperion Integration Server Desktop OLAP Model User’s Guide



Joining Dimension Tables

Whether you can define aliases or create UDASs for columns in a recursive table
depends on the nature of the data and on how you define thejoins for therecursive
table. To use aliases and UDAS, you must define joins as follows:

e Theinformation of an aiasor aUDA column must be related either to the
value in the parent column or to the value in the child column. (You cannot
apply an dias or aUDA column to both the parent column and the child
column.)

e Inmost cases, the datain the column for which you are defining the alias or
UDA must be fully defined. For example, in Figure 8-9, the child column is
fully defined and the parent column is not.

For more information about fully defined columns in recursive tables, see
“Building Hyperion Essbase Hierarchies from Recursive Tables’ on page 2-8.

In some cases, the parent and child columns and the columns with additional
information are not in the same table. For example, in Figure 8-10, the
EMPLOY EE RELATIONSHIPS table and the EMPLOY EE DETAILStable
show such adifferentiation.

Parent Column Child Column
EMPLOYEE
RELATIONSHIPS | REPORTS_TO_ID | EMPLOYEE_ID
Table <NULL> 100101
100101 273645
273645 978663
Additional Information
EMPLOYEE
DETAILS EMPLOYEE_ID FULL_NAME TITLE
Table 100101 Jean Smith CEO
273645 Mary Lee VP Sales
978663 James White Dir Sales, Eastern
Region

Figure 8-10: Example of a Recursive Table with
Additional Information in a Separate Table
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Table 8-1 describes how to define arecursive table that can be used with aliases or
UDAs. In Table 8-1, the Data value char acteristics column includes only those
situations for which OLAP Integration Server can work with aliases or UDAS.

For more information about aliases and UDAS, see the Hyperion Integration
Server Desktop OLAP Metaoutline User’s Guide.

Table 8-1: Defining a Recursive Table Associated With Additional

Information in Alias or UDA Columns

To define arecursive
table when the alias or
UDA columns and the
parent and child

To define arecursive table
when the alias or UDA columns

Data value columns are in one and the parent and child
characteristics recursive table: columns are in separate tables:
Theadditional | 1. Definetherecursive | 1. Definetherecursivetablewith aself-join.
mf?]rmatlon applies teblewith aself-join. | 2 30in the foreign key column of the table
tolt e parer(;t h 2. Hidethe child column. containing the alias or UDA column to
column and the the parent column of the recursive table.
parent column . .

is fully defined. 3. Hidethe child column.
Theadditiona | 1. Definetherecursive | 1. Definetherecursivetablewith aself-join.
;nf:)hrmart]! ﬁ;‘ aplpll&s teblewithaself-join. | 2 join the foreign key column of the table

0 d ehc Ih'Igo UM 15 Hidethe parent containing the alias or UDA column to
?QI urtnr? chi column. the child column of the recursive table.
is fully defined. 3. Hidethe parent column.
Theadditional | Youcannotuseandiasor | 1. Definethe recursivetablewith aself-join.
mfo_rmatlonapph&s aUDA in this situation. 2. Join the foreign key column of the table
to Ielther thte ptr;\]rmt containing the alias or UDA column to
column or o the the parent column of the recursive table.
child column and ) i

3. Join the foreign key column of the table

neither columnis

containing the alias or UDA column to

fully defined. . )
the child column of the recursive table.
* Do not hide the parent column.
e Do not hide the child column.
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For further details, see:
e “Joining aTableto Itself” on page 8-19
e “Hiding and Showing Columns’ on page 6-6

Joining a Table to Itself

» Tojoin atableto itself:

1. Intheright frame of the OLAP Model main window, select the dimension
table to be joined to itself, and select View > Properties > Table.

Hyperion Integration Server displays the Table Properties dialog box.
2. Select the Physical Joinstab, shown in Figure 8-11.

Table Properties [ %]

Generall Colurnre  Physical Jains |

Table Table

|TBCLOOKUP_MARKET x| [TBCLOOKUP_M2RKET =]

Calumn | - Calumn |:|
|EITY POPULATION

T 1D REGION i
POPOLATION REGION_TYPE_ID —
REGION I |size_p

REGION_TYPE_ID STATE

SIZE_ID x| |sTATE_TYPEID ~

Colurnm 1 | Colurmn 2 |

Eecursian... |

QK I Cancel | Help |

Figure 8-11: Joining a Table to Itself

Onthe Physical Joinstab, two Table drop-down lists display the name of the
physical table that you are joining to itself. Two Column lists display the
columnsin the table.
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3. Inthe Column list on the left, select the name of the column representing the
lower level of the relationship; for example, as shown in Figure 8-12, CITY.

4. IntheColumn list ontheright, select the name of the column representing the
higher level of the relationship; for example, as shown in Figure 8-12,
STATE.

Table Properties

Generall Colurnre  Physical Jains |

Tahle Tahle
|TBCLOOKUP_MARKET x| [TBCLOOKUP_M2RKET =]
Column | - Calumn |:|
Ty POPULATION
CITY_ID REGION Add
POPOLATION REGION_TYPE_ID =
REGION I |size D
REGION_TYPE_ID STATE
SIZE_ID x| |sTATE_TYPEID ~
Colurnm 1 | Colurmn 2 |

Eecursian... |

QK I Cancel | Help |

Figure 8-12: Selecting Join Columns in a Recursive Table

8-20 W Hyperion Integration Server Desktop OLAP Model User’s Guide
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Joining Dimension Tables

The two join columns are displayed in the Recur sion dialog box.

Recursion E

Parent Columi:

|S TATE

Child Calumi:

Cancel

Help |

|EITY

Swap |

Figure 8-13: Defining Parent and Child Relationships in a Recursive Table

If thewrong columns are displayed in the Parent Column and Child Column
list boxes, click Swap to switch the columns.

If you make a mistake, click Swap to switch the columns again.

Hyperion Integration Server displays the Physical Joinstab of the Table
Properties dialog box, with the table and column names in the Current Join
Information box, as shown in Figure 8-14.

Table Properties

Generall Colurnre  Physical Jains |

Tahle Tahle

|TBCLOOKUP_MARKET x| [TBCLOOKUP_M2RKET =]
Column | - Calumn |:|
Ty POPULATION

CITY_ID REGION

POPOLATION REGION_TYPE_ID

REGION I |size D
REGION_TYPE_ID STATE
SIZE_ID x| |sTATE_TYPEID ~
Colurnm 1 | Colurmn 2

TBC.LOOKUP_MARKET.CITY

TBC.LOOKUP_MARKET STATE

Welete, |
Eecursian... |

ok |

Cancel | Help |

Figure 8-14: Joined Columns in a Self-Joined Table
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6. Click Close.

Note: In most cases, either the Parent Column or the Child Columnis
the significant column in the table. After defining a self-join for
arecursive table, hide the column that is not significant (see
“Hiding and Showing Columns’ on page 6-6).

CAUTION: Be surethat the joins are correctly defined. Otherwise, the
Hyperion Essbase outline built from the table may not load
correctly.
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Creating and Working
with Hierarchies

Within adimension in an OLAP model, you can arrange columnsinto hierarchies.
In an OLAP model, hierarchies define a tree-structure relationship of the datain
columns. In ametaoutline, this structure determines the member levels of a
dimension and the children of those member levels. Y ou can specify column
filters, sorts, and transformations on columns in hierarchies to define how data
appearsin the Hyperion Essbase outline.

This chapter contains the following topics:

“Understanding the OLAP Model Workflow” on page 9-2
“About Hierarchies” on page 9-3

“Creating Hierarchies’ on page 9-8

“Editing and Deleting Hierarchies’ on page 9-11
“Filtering Datain Hierarchies’ on page 9-13

“Sorting Datain Hierarchies’ on page 9-22
“Transforming Datain Hierarchies’ on page 9-23
“Previewing the Hyperion Essbase Outline” on page 9-28
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Understanding the OLAP Model Workflow

9-2

Figure 9-1 illustrates the workflow for creating an OLAP model. This workflow
includes creating and working with an OLAP model; creating afact table, an
accounts dimension, and atime dimension; creating and working with dimensions;
editing and transforming columns of the dimension tables; joining dimension
tables; and creating and working with hierarchies. This chapter focuses on
defining hierarchies, including creating filters, sorts, and data transformations.

Creating and working
with OLAP models

* . Hyperion Integration Server Desktop - [TBC Model]
::= File Edit “iew Connections Toolz ‘Window Help

DEHE|S|- - |E 22| /
TECATTRIBUTE_OUMCES /
TECATTRIBUTE_PACKAGE

* . Hyperion Integration Server Desktop - [TBC Model]
::= File Edit “iew Connections Toolz ‘Window Help

Creating a fact table,
an accounts dimension,
and a time dimension

DEE[&[: [#] 2] 2 | /

+--FJ TBCATTRIBUTE_OUMCES | 5 /
7] TECATTRIBUTE_PACKAGE O FACT_TABLE
|

R

Creating and working §E FACT TABLE B8 Accounts |
with dimensions
= Product | + Scenario |

Table Properties
General | Columns ~ Physical Joins | Dimensionsl

Mame Table Mame | Colurn Ma... | Hidden | Diill-Thro...
] TBC.FAC..  ADDITIO..
TBC.FAC.. CITY_ID e

Editing and transforming
columns

General | Columns ~ Physical Joins | Dimensionsl

[ {

Table Mame | Colurnn Ma... | Hidden
TBC.FAC..  ADDITIO..
TBC.FAC.. CITY_ID e

TBCFAC.. COGS

Joining dimension tables

E% YEAR-QUARTER-MONTH
EH&) Time.v'ear
EH&) Timne. Quarter

----- B¢ Time.Month

@ Creating and
working with

You Are Here  hierarchies

Figure 9-1: OLAP Model Workflow
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About Hierarchies

In Hyperion Essbase, hierarchies determine how datais consolidated. For
example, many businesses summarizetheir datamonthly, roll up the monthly data
to get quarterly figures, and then roll up the quarterly datato get annual figures.
Some businesses may also summarize databy zip code, and then by city, state, and
country. Any dimension can be used to consolidate data for reporting purposes.

For example, ahierarchy for a GEOGRAPHY dimension in an OLAP
model might look like the hierarchy shownin Figure 9-2. Inthishierarchy,
MARKETS.REGION is a child of the dimension GEOGRAPHY .
MARKETS.STATE isachild of MARKETS.REGION, and
MARKETS.CITY isachild of MARKETS.STATE.

The structure of the hierarchy carries over to the Hyperion Essbase outline where
you can report on sales for individual cities, consolidate city figures to report on
salesfor states, and consolidate state figures to report on regional sales.

Figure 9-2: Sample Hierarchy

Hierarchies provide named structures that contain:

e Thehierarchical structureitself—alevel-by-level sequence for consolidating
data. For example, salestotalsby CITY roll up to salestotalsby STATE, and
salestotals by STATE roll up to sales totals by REGION.

e Thedatafiltersthat are placed on selected columns within the hierarchy—a
way to select specific categories of information. For example, you can filter
the REGION column to include only information on sales in the USA.

e Theorganizational sequence of the data—the sort sequence for a column. For
example, you can sort the MONTH column in descending sequence to see the
most recent totals first.

e Transformations—away to control column data values, which become
Hyperion Essbase member names. For example, to ensure unigue member
names, you can prefix each CITY value with an appropriate value from the
STATE column. You can then differentiate between NYALBANY and
GAALBANY.
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After ahierarchy is created in an OLAP model, it can be dragged directly onto a
metaoutline. By creating hierarchiesin OLAP models, you can customize an
OLAP model for each user group. For example, assume that you use hierarchical
filtersin the OLAP model that you provide to users from a specific corporate
division. With such an OLAP model, the users can more easily create metaoutlines
that contain only the data rel evant to their specific division. For information about
how to use hierarchiesto create metaoutlines, seethe Hyperion Integration Server
Desktop OLAP Metaoutline User’s Guide.

About Recursive Tables

9-4 1

A recursive table (parent and child table) contains information in one row that
isrelated to information in another row. For example, assume that you have a
recursive table named GEOGRAPHY that contains the columns GEO_CHILD
and GEO_PARENT. Thefact that thetableis recursiveindicates that, within each
row, the child geographical areais part of the parent geographical area. Any value
can serve as both parent and child, a parent in one row and a child in another row.

For example, in Figure 9-3, zip code area 01010 iswithin Bangor, which iswithin
Maine, which iswithin East. A <NULL> parent value defines the corresponding
child value as the highest level in the branch, in this case, USA.

GEO_CHILD GEO_PARENT
USA <NULL>

East USA

Maine East

Bangor Maine

01010 Bangor

Figure 9-3: Example Recursive Table
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Whenever OLAP Integration Server finds a<NULL> parent, the child vaueis

considered the parent of anew branch. Thus, the datain Figure 9-3 generates the
hierarchy shown in Figure 9-4:

Ausa
L [A]East
L [A]Maine
L [A]Bangor
o1

Figure 9-4: Hierarchy Generated from
a Recursive Table

About Shared Members in Recursive Tables

When OLAP Integration Server finds a child with two parents, one parent in each
of tworecords, it creates ashared member. In Hyperion Essbase, a shared member
isamember that shares storage space with another member of the same name. The
use of shared members prevents Hyperion Essbase from making extracal culations
on members that are in more than one location in the outline.
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For example, the relational table shown in Figure 9-5 generates a Hyperion
Essbase outline hierarchy where 100-20 (Diet Cola) is a shared member of Diet
becauseit isaready achild of 100 (Colas), and 200-20 is a shared member of Diet
because it is already a child of 200 (Fruit Drinks).

Child Column | Child Description Parent Column
100-10 Regular Cola 100
100-20 Diet Cola 100
100-30 Caffeine-free Cola 100
200-10 Regular Fruit-Orange 200
200-20 Diet Fruit-Orange 200
200-30 Regular Fruit Lime 200

100 Colas <NULL>
200 Fruit Drinks <NULL>
Diet Diet Drinks <NULL>
100-20 Diet
200-20 Diet

Figure 9-5: Sample Recursive Table Resulting in Shared Members
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The outline hierarchy based on Figure 9-5 includes the shared members 100-20
and 200-20 under Diet, as shown in Figure 9-6:

IA|PRODUCTS

[~)100 (Colas)
1DD 1D
1DD 20
100-30

[~]200
200-10
ZDD-ZD
200-30

[A)Diet
100-20
ZDD-ZD

Figure 9-6: Shared Member Hierarchy
Generated from a Recursive Table

If arelational database contains recursive tables, you need to join each recursive
tableto itself (self-join) to access any related information and to consolidate the
data properly. Detailed procedures for creating a self-join are provided in
“Defining a Recursive Table” on page 8-15.

About Ragged Hierarchies

Ragged (asymmetrical) hierarchies occur when branches within adimension have
different numbers of levels. Figure 9-7 illustrates aragged hierarchy where the
East branch contains four levels, and the West branch contains five levels:

AEast
L [A]Maine
L [A]Bangor
o1
[AJwvest
L [A] california
L [A]santa Clara County

L [A]san Jose
L [Jos129

Figure 9-7: Sample Ragged Hierarchy

OLAP Integration Server can handle tables that create ragged hierarchies.
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Creating Hierarchies

» To create a hierarchy:

1. Double-click the dimension for which you want to create a hierarchy; for
example, MARKET.

Hyperion Integration Server displays the Dimension Properties diaog box.

2. Inthe Dimension Properties dialog box, select the Hierar chies tab.

Dimension Properties [ ]

General Hierarchies |

Edit...

Add... |
Delete... |

QK I Cancel | Help |

Figure 9-8: Dimension Properties Dialog Box, Hierarchies Tab

The box lists any hierarchies that have been defined for the selected
dimension.

9-8 | Hyperion Integration Server Desktop OLAP Model User’s Guide



Creating and Working with Hierarchies

3. To openthe Edit Hierarchy diaog box, click Add.

Edit Hierarchy [ %]

I ame:
IHierarchy‘I 1

B Maket Ty, Hisrarchyl e |
=R OI0KLIP MARKET -

Tiransfarm.. |

Wiew Table Data... |

Wiew Sample... |

Cancel |
Help |

Figure 9-9: Edit Hierarchy Dialog Box

The box on the left displays the dimension name above the name of the
dimension table. The hierarchy graphic in the right box contains the default
name for the hierarchy.

4. Inthe Name text box, enter the name for the hierarchy; for example,
Geography.

The hierarchy name that you enter replaces the default name (Hierarchyl).
5. Todisplay the columnsof the selected dimension, in theleft box, click the plus
sign, [#, in front of the table.

To view thedatain acolumn, in the left box, select a column and click View
Table Data.

For more information, see “Viewing Table Data’ on page 3-17.
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6. To placeacolumn at thetop of the hierarchy, in the left box, double-click the
column name.

The name of the selected column is displayed in the right box immediately
below the name of the hierarchy. For example, double-click the REGION
columnto placeit at the top of the hierarchy. Column namesin ahierarchy are
prefaced with the name of the dimension table to which they belong; for
example, MARKET.REGION.

7. To place acolumn at the next level in the hierarchy, double-click the column.

The column is displayed in the right box immediately below the previously
selected column. In the example shown in Figure 9-10, STATE was sel ected
for the next level.

Y our hierarchy should look similar to the one shown in Figure 9-10.

Edit Hierarchy [ %]

I ame:

IHegion, State, City

E|EE’ b arket % Region, State City Fiter

-5 LODKUP_MARKET 5B LODKUP_MARKET REGION —I-
P (R E-Bhee LOOKUP_MARKET STATE
~Be. REGION ~Ple LOOKUP_MARKET.CITY _ Lo |
e, REGION_TPE _
Pl REGION_TYPE_AGE Wiew Table Data... |
Pl REGION_TYPE_ID
- Phee SIZE Wiew Sample... |
g STATE
P STATE_TYPE
- Phee STATE_TYPE_AGE
P STATE_TYPE_ID

Cancel |
KN [ Hep |

Figure 9-10: Edit Hierarchy Dialog Box with Completed Geography Hierarchy
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8. Toview or perform additional operations on a completed hierarchy, proceed
with any of the following options:

e To create afilter or sort on the selected column, click Filter (see “ About
Hierarchy Filters’ on page 9-14 or “ Sorting Datain Hierarchies’ on

page 9-22).

e Totransform the datain the selected column, click Transform (see
“Transforming Datain Hierarchies’ on page 9-23).

e Toview thehierarchy asit will appear in the Hyperion Essbase database,
click View Sample. For more information, see“ Previewing the Hyperion
Essbase Outline” on page 9-28.

9. Click OK twiceto return to the OLAP Model main window.

Editing and Deleting Hierarchies

You can delete or edit any existing hierarchy.

» To delete ahierarchy:

1. Double-click the dimension that contains the hierarchy; for example,
MARKET.

2. When the Dimension Propertiesdialog box opens, select the Hierar chies
tab.

Select the name of the hierarchy.
4. Click Delete to delete the selected hierarchy.

Hyperion Integration Server Desktop OLAP Model User’s Guide H 9-11



Creating and Working with Hierarchies

» To edit ahierarchy:

1. Complete steps 1 through 3 of the delete a hierarchy procedure.

2. IntheHierarchiestab of the Dimension Properties dialog box, click Edit.

The Edit Hierar chy dialog box opens.

Edit Hierarchy

I ame:

IHegion, State, City

Bl Market

-E LOOKUP_MARKET

E1-%, Region, State, City
2B LOOKUP_MARKET REGION
=B LOOKUP_MARKET STATI
(I | (1P MARKET CI

1 |

Filter.... |
Transform... |
Wiew Table Data,. |
Wiew Sample... |

Cancel |

Help

Figure 9-11: Edit Hierarchy Dialog Box

The hierarchy graphic in the right box contains the name of the hierarchy that
you are editing; for example, Geography.

3. Todisplay thecolumns of adimension tablein theleft box, click the plussign,

[+, in front of the table to expand the view.

4. Toview thedatain acolumn, intheleft box, select the column and click View

Table Data.

Hyperion Integration Server displaysthe View Table Data dialog box
showing the first 100 rows of datain the selected column.

For more information, see “Viewing Table Data” on page 3-17.

9-12 W

Hyperion Integration Server Desktop OLAP Model User’s Guide



Creating and Working with Hierarchies

5. To make changes to an existing hierarchy, proceed with any of the following
options:

To delete a column from the hierarchy, right click the column in the
hierarchy and select Delete.

To add acolumn or to move acolumn to somelevel abovethelowest level
in the hierarchy, delete the columns located above the level where you
want to add or move a column and then add columnsin the order that you
want them listed.

To create or edit afilter or sort on the selected column, click Filter (see
“About Hierarchy Filters’ on page 9-14 or “ Sorting Datain Hierarchies”
on page 9-22).

To create or edit data transformations on the selected column, click
Transform (see “ Transforming Datain Hierarchies’ on page 9-23).

To view the hierarchy asit will appear in the Hyperion Esshase database,
click View Sample. For more information, see“ Previewing the Hyperion
Essbase Outling” on page 9-28.

6. Click OK to close the dialog box.

Filtering Data in Hierarchies

Thistopic describes how to createfilterson columnsin hierarchies. Y ou usefilters
to determinewhat datavalues are returned. When transforming datavalues, OLAP
Integration Server performsfilters before it performs sorts and transformations.

This topic contains the following subtopics:

e “About Hierarchy Filters’ on page 9-14

e “About Recursive Table Filters’ on page 9-15

e “Creating Filtersin Hierarchies’ on page 9-16
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About Hierarchy Filters

You can apply filters to the columnsin a hierarchy to restrict the data values that
arereported. For example, you can create afilter for each regional officein the
United States so that regional managers can view sales totals only for their
respectiveregions. At headquarters, you can view salesfor each region and for the
total USA.

A filter contains the following components:

WMARKET.REGION = ('Central')
T

column being filtered operator  condition

Figure 9-12: Components of a Filter

Inan OLAP model, you can define afilter only at the column level of ahierarchy.
Any filter that you define on a parent value applies to the children of that parent
value; for example, if you defineaREGION column filter that selects valuesfrom
the Central region, values from the cities (children) of the Central region are
automatically selected.

Thefilters that you define in an OLAP model are used to create related
metaoutlines and are then used to create related Hyperion Essbase outlines.

Inametaoutline, you can definefiltersfor member levelsin dimension hierarchies,
for member levels created from columns contained in an OLAP model, or for
measures contained in an OLAP model. For details, see the Hyperion Integration
Server Desktop OLAP Metaoutline User’s Guide.

Note: If you make changesto afilter in ahierarchy in an OLAP model, the
changes do not carry through to metaoutlines previously created from
that OLAP model.

Y ou can a so define the sequence in which you want to see information. To define
the sort order of a column, see “Sorting Datain Hierarchies’ on page 9-22.
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About Recursive Table Filters

Y ou can most easily define afilter for acolumn of arecursivetablein the process
of defining a metaoutline. For more information, see the Hyperion Integration
Server Desktop OLAP Metaoutline User’s Guide.

However, one advantage of an OLAP model is the fact that you can select and
reuse its predefined dimensions and hierarchies in more than one metaoutline. If
you plan to use afilter in more than one metaoutline, you may want to consider
creating thefilter inan OLAP model. Remember that, to create afilter on acolumn
of arecursive tablein areusable OLAP model, you must first create a hierarchy.
Y ou can definefilters in an OLAP model only through hierarchies.

When you create a hierarchy from arecursive table, filter on only the parent
column or the child column. For more information on creating filters, see
“Filtering Datain Hierarchies’ on page 9-13.

CAUTION: If you place both the parent and child columns of a
hierarchy into an OLAP model, you lose the recursive tie
between the rows of the table. Consequently, thetableisno
longer recursive.

To understand what to expect when you filter from arecursive table, consider the
following example based on data shown in Table 9-1.

Table 9-1: Filtering on Columns in a Recursive Table

Row Number GEO_CHILD GEO_PARENT
1 USA <NULL>

2 East USA

3 Maine East

4 Bangor Maine

5 01010 Bangor

6 New York East

7 Buffalo New York

8 30092 Buffalo
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When you filter on avalue in aparent column, OLAP Integration Server retrieves
only records that include the filter value as the parent. For example, on the
GEO_PARENT column, filtering for the value East retrieves the two rows that
include East as the parent, rows 3 and 6, which contain Maine and New York in
the GEO_CHILD column. No other rows are retrieved or reported on in the
Hyperion Essbase database.

When you filter on avaluein achild column, OLAP Integration Server retrieves
only records that include the filter value as the child. For example, on the
GEO_CHILD column, filtering for the value East retrieves only row 2, the row
that includes East in GEO_CHILD and USA in GEO_PARENT.

If you filter on the parent column, hide the child column as described in “Hiding
and Showing Columns’ on page 6-6. If you filter on the child column, hide the
parent column.

For more information about working with parent and child relationshipsin
recursive tables, see “ About Recursive Tables’ on page 9-4.

Creating Filters in Hierarchies

9-16 W

» To create afilter for acolumn in ahierarchy:

1. Inthe Dimension Properties dialog box, select the Hierarchiestab.
a. Select the hierarchy to filter and click Edit.
The Edit Hierarchy dialog box is displayed.

b. Intheright-hand box, click the plussign, [, in front of ahierarchy name;
for example, Geography.

The columnsin the hierarchy are displayed, as shown in Figure 9-11.
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2. From the hierarchy, select the column to filter (for example,

MARKET.REGION) and click Filter.

Hyperion Integration Server displaysthe Edit Filter dialog box, as shown in
Figure 9-13. Use the dialog box to specify conditions and operators for the
selected conditions. A condition that you apply to afilter is like an SQL

WHERE clause.

If you enter a condition value directly into the Filter s text box, you must use
the syntax rules of the SQL for the relational database management system

(RDBMS) that you use.
Edit Filter - LOOKUP_MARKET.REGION E
Filters |Drdering|
Colurnm: Operator: Condition:
FEGION =] [in =l [
Add Type
|  And : |
Add & Q? Werify [}S
Filters:
=
=
Freview Results... |
QK I Cancel | Help |

Figure 9-13: Edit Filter Dialog Box

The Column drop-down box displays the selected column. Notice that the
Add button is not selectable; you cannot add afilter until you have selected
the condition to use to create the filter, as described in steps 3 and 4.
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3. Click the browse button ;l.

Hyperion Integration Server displays the Select VValues dialog box, as shown
in Figure 9-14. The Select Values dialog box lists the values that you can

select.
Select ¥alues From LOODKUP_MARKET REGION. E
Walue | R
e [oe
East Cancel |
South
west Help |

Figure 9-14: Select Values Dialog Box

9-18 W Hyperion Integration Server Desktop OLAP Model User’s Guide



Creating and Working with Hierarchies

4. Select one or more vauesto include in the filter, for example, Central, and
click OK.

The number of values (conditions) that you can select depends on the type
of operator that you want to apply. Y ou can select more than one value
(condition) when applying the in or not in operator. Y ou can select only
asingle value (condition) when applying any other operator. Available
operators are described in Table 9-2.

Table 9-2: Condition Filter Operators

Operator Description

in Use to select one or more values; for example, Region in
United States or Europe Selects regionsin both the
United States and Europe.

not in Use to eliminate one or more values (see in operator).

like Selects values with similar characters. For example, to select
all products that begin with P without specifying all characters
in the name, set the condition Like “P%” (thewildcard
character may vary with the RDBMS).

not like Selects values without similar characters (see Like operator).

= Equal to.

<> Or ! = Not equal to.

> Greater than.

>= Greater than or equal to.
< Less than.

<= Lessthan or equal to.
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5. Click OK.

The values (conditions) that you selected are displayed in the Condition text
box of the Edit Filter dialog box.

The Add button of the Edit Filter dialog box is now selectable, as shown in

Figure 9-15.

Edit Filter - LOOKUP_MARKET.REGION E
Filters |Drdering|
Colurnm: Operator: Condition:
[REGION == =] [rcentan [

Add Type————
4idd € And veity |
& o Werify
Filters:

Breview Hesults...l

QK I Cancel | Help |

Figure 9-15: Defining Filters
6. From the Operator drop-down list, select an operator; for example, =

(equal to).
For adescription of available Operator options, see Table 9-2.
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The condition and the operator that you selected are displayed in the Filters

list box, as shown in Figure 9-16.

Edit Filter - LOOKUP_MARKET.REGION E
Filters |Drdering|
Colurnm: Operator: Condition:
[REGION == =l [
Add Type————
fdd C And veity |
& o Werify
Filters:
LOOKUP_MARKET.REGIONM = ['Central’] ;I
Breview Hesults...l

0K

| Cancel | Help |

Figure 9-16: Selected Values Displayed in Filters List Box

8. To add another condition to the filter, in the Add Type box, click And or Or
to determine how the filters are combined, and repeat steps 3 through 7.

Y ou can group And and Or clauses by typing them directly into the Filters
text box. Be sure to use complete SQL WHERE clauses with the valid SQL

syntax for the RDBMS that you use.

9. To view the datathat will be returned by the filter, click Preview Results.

For more information, see “Previewing the Hyperion Essbase Outline” on

page 9-28.

10. To apply thefilter to the column and return to the Edit Hierar chy diaog box,

click OK.
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Sorting Data in Hierarchies

Y ou can specify a sequence for sorting the values of any column. Y ou can select
ascending, descending, or none (no sort order). The default sort order is none. If
you select ascending or descending, dataisretrieved faster than if you select none
for no sort order. If you make a change to asort in an OLAP model hierarchy, the
changes do not carry through to metaoutlines previously created from that OLAP
model.

Note: Whileretrieving data, OLAP Integration Server sorts columns after it
filters and before it performs transformations. For example, if the
MONTH column contains numeric values for the month (01, 02, 03,
and so on) and you specify atransformation that substitutes month
abbreviations, (Jan, Feb, Mar, and so on), OLAP Integration Server
sortscolumnsby their pre-transformation numeric values. April totals
are displayed after March totals because 04 sorts after 03.

» To define a sort order for column values:
1. OpentheHierarchiestab of the Dimension Propertiesdiaog box.
a. Select ahierarchy and click Edit.

The Edit Hierarchy dialog box is displayed.

b. Toexpand theview, intheright box, click theplussign, [, in front of the
hierarchy (for example, Geography).

2. Todisplay the Edit Filter dialog box, select the column for which you want
to sort values, and then click Filter.

Select the Ordering tab.
4. Fromthe Sort Order drop-down list, select Ascending, Descending, or None.
Click OK threetimes to return to the OLAP Model main window.

To change the way data values are represented when reported by Hyperion
Essbase, see “Replacing Data’ on page 9-23.
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Transforming Data in Hierarchies

After you create adimension hierarchy, you can change the way the data val ues of
the hierarchy are represented when reported by Hyperion Essbase. For example,

perhaps the date values of the OLAP model hierarchy are numeric and you want
the corresponding Hyperion Essbase members to be alphabetic.

A transformation that you define on a hierarchy in an OLAP model is used

to create first a metaoutline and then a Hyperion Essbase outline. If you change
atransformation in an OLAP model, the change does not carry through to
metaoutlines previously created from the OLAP model. OLAP I ntegration Server
performsfilters and sorts before transformations.

For more information about transforming data in hierarchies, see:
e “Replacing Data’ on page 9-23
e “Prefixing and Suffixing Column Values’ on page 9-26

Replacing Data
Y ou can change column data by replacing current values with new values,
changing capitalization, and removing leading and trailing spaces.
» To transform datavaluesin ahierarchy:

1. Double-click the dimension that contains the hierarchy with which you want
to work.

2. Todisplay the Edit Hierarchy dialog box, select the Hier ar chiestab, then
select the appropriate hierarchy, and click Edit.
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3. IntheEdit Hierarchy dialog box, select from the hierarchy the column for
which you want to transform data values (for example, MARKET.CITY), and
click Transform.

Hyperion Integration Server displays the Replace tab of the Edit OLAP
Model Transformations dialog box, as shownin Figure 9-17.

Edit OLAP Model Transformations - REGION E

Feplace | PrefisdSuffig I

Search for —Case
Il & Driginal
: " Upper Case
Replace with  Lower Caze
I " Capitalize First Letters
™ Case Sensitive [C] — Space:
[T Match whale \wWard [w) V' Drop Leading/Trailing Spaces
¥V Replace All Dccurences [4) V' Convert Spaces to Underscores
fdd talist EdiDea | Deee |
Search | Feplace | Conditions
Freview Hesults...l QK I Cancel | Help |

Figure 9-17: Replace Tab of the Edit OLAP Model Transformations Dialog Box
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To replace text, change the capitalization of the text, or replace spaces, follow
the stepsin Table 9-3, and click OK.

Table 9-3: Editing Text in Hierarchy Data

To replace...

Do...

Text

1. Inthe Replacetext box, enter the original value and, in the With text box,
enter the text to replace the value.

Specify the conditions for making the replacement by checking one or
more of the following options:

Case Sensitive (C). Replaces only text strings that match the capitalization
of the string in the Replace text box.

Replace All Occurrences (A). Replaces every occurrence of the text
string. For example, if you replace all occurrencesof 10 inthestring 100
10 1 withan a, the string changesto a0 A 1.

Match WholeWord (W). Replacesthe text string only when it occurs as a
whole word. For example, when replacing the 10 inthe string 100 10 1
with an a, if you set the Match Whole Word option, the string changes to
100A 1.

2. Click Addtoadd thetransformation to the value specified. The entriesmove
to the Replace box.

Capitalization

To change the case of the data value, select one of the following options:
» Original. Does not change the case. This setting is the default.

» Upper Case. Changesthe value to upper case; for example, january or
January to JANUARY .

* Lower Case. Changes the value to lowercase; for example, JANUARY or
January to january.

» Capitalize First Letters. Changesthefirst letter of the value and the first
letter following a space or an underscore to upper case; for example,
gtrl january changesto Qtrl January.

» Toomit spacesbefore or after the datavalue, select Drop Leading/Trailing
Spaces.

» To convert spacesthat exist in the original data value to underscores( _),
select Convert Spacesto Under scores.

Hyperion Integration Server Desktop OLAP Model User’s Guide B 9-25



Creating and Working with Hierarchies

5. Toview thedataasit will appear in the Hyperion Essbase outline, click
Preview Results.

For more information, see “ Previewing the Hyperion Essbase Outline” on
page 9-28.

6. Click OK threetimesto return to the OLAP Model main window.

Prefixing and Suffixing Column Values

Y ou can use aprefix or suffix to generate unique member names from the columns
of ahierarchy. Hyperion Essbase requires unique member names to report data
values accurately. For example, if you use the same month names for multiple
years, you can add ayear suffix to the month column names of each hierarchy to
ensure that Hyperion Essbase reports the correct value for each month of each
year.

Note: The default setting for columnsin atime hierarchy is parent name.

» To define prefixes or suffixes for datavaluesin ahierarchy:

1. Double-click the dimension that contains the hierarchy that you want to work
with.

2. Todisplay the Edit Hierarchy dialog box, select the Hier ar chiestab, then
select the appropriate hierarchy, and click Edit.

3. IntheEdit Hierarchy dialog box, select the hierarchy column that you want
to transform (for example, MARKET.CITY) and click Transform.

The Edit OLAP Model Transformations dialog box opens.
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Hyperion Integration Server displays the Prefix/Suffix tab, as shown in

Figure 9-18.

Edit DLAP Model Transformations - REGION

Feplace Prefis/Suffiz |

Grandparent Mame
All Ancestors' Mames
Dimenszion Mame
uztom Prefis

C B
-
L]
-
C

— Suiffi
i+ Mone [w]
= Parent Mame [Y]
" Grandparent Name [£]
= Al Ancestors' Names

— Prefix Separator

= Underscore [ _ ]
 Pipe[1]

= Caret[ "]

* Mo separator

Freview Prefiz
’7 member

— Suffix Separator

= Underscare [ _ ]
" Pipe[l]

= Caret[ "]

* Mo separator

= Dimenszion Marme

Custom Suffis [¥] Preview Suffiz
I ’7 member

Freview Hesults...l QK I Cancel | Help |

Figure 9-18: Prefix/Suffix Tab

5. Toaddaprefix or suffix to adatavalue, select the valueto prefix or suffix, as
listed in Table 9-4.

Table 9-4: Prefix and Suffix Values

Prefix/Suffix Definition

None Uses the column value as the full name. Nothing is
attached.

Parent Name Attaches the immediate parent; for example,

Florida Miami.

Grandparent Name Attaches the parent and the parent of the parent; for

example, Central_Florida Miami.

All Ancestors' Names | Attaches all parents; for example,
Market Central Florida Miami.

Hyperion Integration Server Desktop OLAP Model User’s Guide m 9-27



Creating and Working with Hierarchies

Table 9-4: Prefix and Suffix Values (Continued)

Prefix/Suffix Definition

Dimension Name Attaches the dimension name; for example,
Market Miami.

Custom Prefix Attaches your own prefix or suffix. Type the prefix or

Custom Suffix suffix in the text box; for example, SKU_.

6. Toinsert acharacter between the prefix or suffix and the member value, inthe
Prefix Separator or Suffix Separator box, select the character to insert.

For example, to prefix the valuefor Y ear to the quarter members and insert an
underscore between the prefix and the quarter member, select Parent Name
and Under scor e. This procedure creates member names like 1998 Quarter4.

7. Toview thedataasit will appear in the Hyperion Essbase outline, click
Preview Results.

For more information, see “Previewing the Hyperion Essbase Outline” on
page 9-28.

8. Click OK three times to return to the main window.

Previewing the Hyperion Essbase Outline

Y ou can preview the Hyperion Essbase outline that will be created from a
hierarchy. The preview includes the results of filtering and transformation
operations. For example, you can create afilter and then view the column values
that will be returned by the filter.

» To preview the Hyperion Essbase outline:

1. Choose one of the following options:

e If you arecreating afilter in the Edit Filter dialog box, click Preview
Results.

e If you are creating a transformation in the Edit OLAP M odel
Transformation dialog box, click Preview Results.

e If you are creating a hierarchy in the Edit Hierarchy dialog box, click
View Sample.
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Hyperion Integration Server displays adialog box similar to the onein

Figure 9-19. Y ou can click the plus sign, , in front of each member to
expand and view the full member hierarchy within the sample outline.

Preview Transformation Results [ %]
- Markst
= E_entral Help |
B- Calorada
L Aspen
Sarple Build SOL:
SELECT aREGION. aSTATE, aCITY ;I

FROM TEC.LODOKUP_MARKET a

-]

Figure 9-19: Viewing a Sample Hyperion Essbase Outline

Thetop list box displays the members that will show up in the Hyperion
Essbase outline. The SampleBuild SQL list box displaysthe SQL that OLAP
Integration Server uses to retrieve the members from the data source.

2. When you finish viewing the members and the SQL, click Close.
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#MISSING. See missing data.

accountsdimension. A dimension type that makes accounting intelligence
available. Y ou can tag only one dimension as accounts; you do not have to have
an accounts dimension.

Add Joinsmode. In Hyperion Integration Server, a state in which you can draw
lines to define joins between objectsin the OLAP model.

agent log file. A record of actions performed by the agent (server).
aggregate. See consolidate.

aggregation level. See consolidation level.

alias. An dternative name for a dimension, member, or description.

alias column. In Hyperion Integration Server, acolumn in the data source that
contains the aliases for a member level in the metaoutline.

alternate name. Seeadlias.

ancestor. A branch member that has members below it. For example, in a
dimension that includes years, quarters, and months, the members Qtr2 and 2001
are ancestors of the member April.

application. InHyperion Essbase, acontainer for one or more Hyperion Essbase
databases and files, such as calc scripts and data load rules, that are related to the
databases.

ARBORPATH. An environment variable that specifies the Hyperion Esshase
root directory.

Architect. See Hyperion Integration Server Desktop.
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attribute. A classification of amember in adimension. Y ou can specify an
attribute to select and group members with a specified attribute and to perform
calculations and application-specific functions. For example, aProduct dimension
can have several attributes, such as Size and Flavor. A specific member of the
Product dimension can have the Size attribute 8 and the Flavor attribute Cola.

base dimension. A standard dimension that is associated with an attribute
dimension. To classify amember of a base dimension, you associate it with a
member of an attribute dimension that describes the classification, such as a
specific flavor. For example, assuming products have flavors, the Product
dimension is the base dimension for the Flavors attribute dimension.

block. The primary storage unit within Hyperion Essbase. A datablock isa
multidimensional array representing the cells of all dense dimensions.

branch. A member of ahierarchy that may or may not contain leaf members.
Builder. See Hyperion Integration Server Desktop.
calc script. See calculation script.

calculation script. A text file containing a set of instructions telling Hyperion
Essbase how to calculate a database.

Catalog. See OLAP Metadata Catalog.

cell. A unit of data representing the intersection of dimensionsin a
multidimensional database; the intersection of arow and a column in aworksheet.

child. A member that has a parent above it in the database outline. A child may
have peers (siblings) that exist at the same layer of the database outline.

column. Inrelationa databases, avertical part of atable. Also known as afield.
A column contains all the values for a specific type of information. Every column
has a name and a particular data type. For example, a column may contain the
name or employee number for each employee.

Command Interface. See OLAP Command Interface.

concatenation. An operation that joins two characters or stringsin the order
specified, forming one string whose length is equal to the sum of the lengths of the
two characters or strings. For example, the strings “New York “ and “Library”,
when concatenated, become “New Y ork Library”.

condition. Inrelational databases, a data extraction criterion. For example, you
can apply a condition to extract only the data that begins with the letter A.
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consolidate. The process of gathering data from dependent entities and
aggregating the data up to parent entities. Once you enter or load data into child
entities, you perform a consolidation to aggregate the data through the
organization. As data consolidates, intercompany processing, conversion
methods, equity adjustments, and minority ownerships perform cal cul ations on the
data.

consolidation level. The top of an aggregation hierarchy or any branch or
sub-branch below the top, including the input (leaf) portion of the hierarchy.

data block. See block.

data cleansing. The process of making inconsistent data consistent. Examples of
inconsistent data are data in which some values are incorrect or not of the correct
datatype.

datafile. A file containing data blocks; Hyperion Essbase generates the datafile
during adataload and stores it on disk.

dataload. The process of populating a Hyperion Essbase database with data.
L oading data establishes actual valuesfor the cellsdefined by the structural outline
of the database.

dataload rules. A setof criteriaor rulesthat Hyperion Essbase usesto determine
how to load data from a text-based file or arelational data set into a Hyperion
Essbase database.

data point. Seecell.

data source. External data, such as atext file, spreadsheet file, or SQL database
that will be loaded into a Hyperion Essbase database.

datatype. Definesthe kind of datathat a column can contain. For example,
columns with the Numeric data type contain numbers.

datavalue. Seecell.

database. A collection of related information. Each unit (record) of the database
istypically organized in afixed format to makeit easy to retrieve selected portions
of the dataon demand. Each record is made up of one or more datafields, and each
datafield can hold one piece of data (known as a value).

database administrator. Anindividua who administers database servers, such
as Hyperion Essbase, and who may also design, maintain, and create databases.

database outline. See outline.
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DateTimetransformation. A set of instructions that defines how to change or
reformat arelational database DateTime data type to your choice of date format.

DBMS. Seerdational database management system.

denormalization. The process of adding redundancy to datain a database,
typically by joining tables to form more complete sets of datain the individual
tables. This process is performed for the purpose of increasing data retrieval
performance. Contrast with normalization.

dense dimension. A dimension likely to contain data for every combination of
dimension members. For exampl e, atime dimension is adense dimension because
it contains all combinations of all members. Contrast with sparse dimension.

descendant. Any member below aparent in the database outline. For example, in
adimension that includesyears, quarters, and months, the members Qtr2 and April
are descendants of the member Y ear.

detail member. Seeleaf member.

dimension. A datacategory that isused to organize businessdatafor retrieval and
consolidation of values. Each dimension usually contains a hierarchy of related
members grouped within it. For example, a'Y ear dimension often includes
members for each time period, such as quarters and months. Other common
business dimensions may be measures, natural accounts, products, and markets.

dimension branch. A collection of dimension tables organized in a hierarchical
structure, with one of the dimension tables joined directly to the fact table. A
dimension branch defines asingle, potential Hyperion Essbase dimensionin a
Hyperion Integration Server metaoutline.

dimension build rules. In Hyperion Essbase, a set of operations similar to data
load rules. Instead of |oading data, the dimension build rules modify the outline
based on data in the external data source file.

dimension table. A container in the OLAP model for one or more relational
tables that define a potential Hyperion Essbase dimension. When one dimension
table joinsto another dimension table, forming adimension branch, the dimension
iscomposed of the columns of all of the dimension tablesin the dimension branch.

dimension type. A property in the OLAP model and in the metaoutline that
defines which tables form the Hyperion Essbase accounts, time, and standard
(default) dimensions.

Glossary-4 W Hyperion Integration Server Desktop OLAP Model User’s Guide



Glossary

duplicate member. The second occurrence of amember name in a data source.
Users can determine whether Hyperion Integration Server ignores duplicate
members or adds them as shared members. See also shared member.

Dynamic Calc And Store members. A member that the Hyperion Essbase
server calculates only upon thefirst retrieval of the value. The server then stores
the calculated valuein the database. Subsequent retrievals of aDynamic Calc And
Store member do not require calculating.

Dynamic Calc members. A member that the Hyperion Essbase server calculates
only at retrieval time. The server discards calculated values after the retrieval
reguest is complete.

dynamic calculation. In Hyperion Essbhase, a calculation that occurs only when
you retrieve data on a member that has been tagged as Dynamic Calc or Dynamic
Calc And Store. The member’ s values are calculated at retrieval time instead of
being precal culated during batch calculation.

Dynamic Time Series. A processthat isused to perform dynamic period-to-date
reporting.

Dynamic Time Series members. Predefined members that are used to perform
Dynamic Time Series reporting.

Esshase database. A repository of datawithin Hyperion Essbase that contains a
multidimensional data storage array. Each database consists of a defined storage

structure (a database outline), data, security definitions, and other associated files,
such as calc scripts or data load rules. See also application.

Essbase OLAP server. A database server that locates and accesses
multidimensiona data.

Essbase outline. See outline.

fact table. In Hyperion Integration Server, a container for one or more relational
tables that define the data values for each dimension intersection in the OLAP
model. For example, if the OLAP model contains Products, Region, and Y ear
dimensions, the fact table might include data values for the number of units of
Product A sold in New Y ork in January.

field. (1) InHyperion Essbase, avalueor itemin adatasourcefilethat isretrieved
from a Hyperion Essbase database. (2) In relational databases, a space allocated
for aparticular item of information. Fields are the smallest units of information
you can access. Most fields have certain characteristics associated with them. For
example, some fields are numeric, whereas others are textual. Every field hasa
name.
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file delimiter. Oneor more characters, such asacommayf(,), separating fieldsina
data source.

filter. (1) In Hyperion Essbase, amethod for controlling access to database cells.
A filter isthe most detailed level of security, allowing you to define the varying
access levelsthat users can haveto data. (2) In Hyperion Integration Server and in
relational databases, a method for controlling which data you retrieve from a
relational database. For example, you can choose to retrieve products only in the
Product A product family. A filter contains one or more conditions.

foreign key. Inrelational databases, a column whose data values correspond to
the values of akey column in another relational table. See also key column,

primary key.

formula. In Hyperion Esshase, a combination of operators and functions as well
asdimension names, member names, and numeric constants. Formulas are used to
calculate rel ationships between members of a Hyperion Essbase database.
@VAR(Actual, Budget) is an example of aformula.

generation. A layer in ahierarchical tree structure that defines member
relationships in a Hyperion Essbase database. Hyperion Essbase orders
generations incrementally from the dimension (generation 1) down to the leaf
members.

generation name. A unique name that describes a generation.

hierarchy. A set of multidimensional relationshipsin an outline, often created in
atree formation. For example, parents, children, and generations represent a
hierarchy.

Hyperion Essbase kernel. A layer of the Hyperion Essbase server that provides
the foundation for a variety of functionality, including dataloading, calculations,
spreadsheet lock& send, partitioning, and restructuring. The Hyperion Esshase
kernel reads, caches, and writes data; manages transactions; and enforces
transaction semantics to ensure data consistency and data integrity.

Hyperion Integration Server Desktop. The client component of the Hyperion
Integration Server product family. Thistool is used to create OLAP models and
metaoutlines, and load data into Hyperion Essbase databases.

index. (1) In Hyperion Essbase, a method of retrieving data based on sparse
dimensions. Also refersto theindex files, collectively. (2) In relational databases,
pointersthat arelogically arranged by the values of akey. Indexes optimize access
to relational data.

index cache. In Hyperion Esshase, a buffer in memory that holds index pages.
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index entry. In Hyperion Essbase, a pointer to an intersection of sparse
dimensions. Each index entry pointsto ablock on disk and locates a particul ar cell
within the block by means of an offset.

index file. In Hyperion Esshase, afile used to store data retrieval information. It
resides on disk and contains index pages.

index page. InHyperion Essbase, asubdivision of anindex file containing entries
that point to data blocks.

input block. A type of data block that has at least one loaded data value.

input data. Any datathat isloaded from a data source and is not generated by
calculation.

Integration Server. See OLAP Integration Server.

integrity constraint. Inrelational databases, arule stating that each row should
have an entry for each required key column.

intersection level. Inthe Hyperion Essbase Spreadsheet Add-in, a Hyperion
Essbase member combination that defines a specific value. For example, the
member combination Actual, Root Beer, Sales, Jan, East represents the actual
January sales value for root beer in the Eastern region.

join. Inrelational databases, arelationship between two tables based on matching
key column values.

join columns. In Hyperion Integration Server, two relationa table columns that
are joined from one table to another.

key column. Inrelational databases, a column or columns that form a unique
identifier for each row. For example, EMPLOY EE_ID might be akey column.

leaf member. A member that has no children.

left frame. (1) In the Hyperion Integration Server Desktop OLAP Metaoutline
main window, the area on the | eft that enables you to view alist of dimensions
previously defined in the OLAP model. (2) Inthe OLAP Modd main window, the
areaon the left that displays alist of the tables and views available in your source
relational database.
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level. (1) In Hyperion Essbase, alayer of ahierarchical tree structure that defines
database member relationships. Hyperion Essbase numbers levelsincrementally
from the leaf member (level 0) up to the dimension member. (2) In Hyperion
Integration Server, the distance of adimension table from the fact table in the
OLAP model. For example, if atableislevel 2, it is separated from the fact table
by two links.

level 0 block. A datablock that is created for sparse member combinations when
al of the members of the sparse combination are level 0 members.

level 0 member. Seeleaf member.
level name. A unique name that describes alevel.

load member. InHyperion Integration Server, amember in a user-defined
dimension into which datais loaded. Only user-defined dimensions require load
members. For all non user-defined dimensions, Hyperion Integration Server
knows how to load members and data into the Hyperion Essbase database.

load properties. In Hyperion Integration Server, aset of rules that determine
what actions the product performs on member level names and data as they are
loaded.

logical column. In Hyperion Integration Server, a column created by
manipul ating the data in one or more physical columns. Contrast with physical
column. See also column.

logical table. Inrelational databases, atable created by manipulating columns
from one or more physical tables. Thelogical tableis only aview of the data; the
columns remain stored in the original tables and are not physically duplicated in
the logical table. Contrast with physical table. See also view.

mathematical operator. A symbol that defines how datais calculated. A

mathematical operator can be any of the standard mathematical or Boolean
operators, for example, +, -, *, /, and %. Mathematical operators are used in
formulas, outlines, and scripts.

MDDB. See multidimensiona database.

measures. Datavaluesthat a user wantsto track, such as Unit_Price and
Discount. By default, measures values map to the accounts dimension in the
OLAP model, which maps to the measure dimension in the OLAP metaoutline,
which in turn maps to the accounts dimension in the Hyperion Essbase outline.

measures dimension. In Hyperion Integration Server, a dimension that, by
default, maps to the accounts dimension in the Hyperion Essbase outline.
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member. A discrete component within adimension. For example, atime
dimension might include members such as Jan, Feb, and Qtrl.

member combination. In Hyperion Essbase, alist of member names used to
specify a set of data at the intersection of two or more dimensions. A member
combination is specified by using the cross-dimensional operator -> (a hyphen
followed by aright-angle bracket). For example, the actual salesdatafor the month
of January in Sample Basic is Sales->Jan->Actual.

member level. A hierarchical level of detail within adimension. For example, in
adimension that defines geographic areas by nation, which are then subdivided
into provinces, the nation and province categories each represent a member level.
A member level correspondsto alevel in aHyperion Essbase outline. The
measures dimension contains actual members that are also member levels.

member load. The process of adding new dimensions or members (without data)
to a Hyperion Essbase outline. Contrast with data load.

metadata. The components of a database outline that describe and hold data.
Examples of metadata are dimension names, member names, properties, time
periods, security, and so on.

metaoutline. In Hyperion Integration Server, atemplate containing the structure
and rules for creating a Hyperion Essbase outline from an OLAP modd.

missing data (#M1SSING). A marker indicating that datain the labeled location
does not exist, contains no meaningful value, or was never entered or loaded. For
example, missing data exists when an account contains data for a previous or a
future period but not for the current period.

Move mode. In Hyperion Integration Server, a state in which you can pick up,
move, and drop objectsin the OLAP Model main window.

multidimensional. Describesamethod of referencing datathrough three or more
dimensions. Anindividual datavalueistheintersection of one member from each
dimension.

multidimensional database (MDDB). A method of referencing data through
three or more dimensions. Anindividual record is the intersection of apoint for a
set of dimensions. Contrast with relational database.

normalization. The process of grouping and removing redundancy from data so
that each entity isin itsappropriate place in the database and only initsappropriate
place. Contrast with denormalization.
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numeric transformation. In Hyperion Integration Server, a set of instructions
that define how to change or reformat arelational database numericfield type. For
example, you may choose to divide numeric data by 100.

ODBC. See Open Database Connectivity.

ODBC data source. Location of the data that you are accessing and the
information necessary to access the data using ODBC. For example, an ODBC
datasourcethat connectsto an SQL Server might requireaserver name, adatabase
name, a user name, and a password. See also Open Database Connectivity.

OLAP. Seeonlineanalytical processing.

OLAP Architect. See Hyperion Integration Server Desktop.
OLAP Builder. See Hyperion Integration Server Desktop.
OLAP Catalog. See OLAP Metadata Catalog.

OLAP Command Interface. In Hyperion Integration Server, acommand-line
tool that you can use to perform common operations on the Hyperion Essbase
outline and the data in the Hyperion Essbase database. For example, you can use
the LOADDATA command to load data.

OLAP Integration Server. The server component of the Hyperion Integration
Server product family. OLAP Integration Server usesthe information stored in the
OLAP Metadata Catalog to extract the dimension names and member names
needed to build a Hyperion Essbase outline from the data source. When the
Hyperion Essbase outlineiscomplete, OLAP Integration Server extractsdatafrom
the data source, performsthe operations specified in the metaoutline, and loadsthe
datainto the Hyperion Esshase database.

OLAP Metadata Catalog. InHyperion Integration Server, arelational database
containing metadata describing the nature, source, location, and type of data that
you pull from the relational data source. OLAP Integration Server accesses the
OLAP Metadata Catal og to generate the SQL statements and the information
required to generate a Hyperion Essbase database outline.

OLAP model. InHyperion Integration Server, alogical model (star schema) that
you create from tables and columnsin arelational database. Y ou can then use the
OLAP mode to generate the structure of a multidimensional database.

OLTP. Seeonline transaction processing.
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online analytical processing (OLAP). A multidimensional, multi-user,
client-server computing environment for users who need to analyze consolidated
enterprise datain real time. OLAP systems feature drilling down, data pivoting,
complex calculations, trend analyses, and modeling.

online transaction processing (OLTP). OLTP applications are commonly
referred to as data capture, data entry, or data collection applications. OLTP
applications enable an organi zation to capture the large amounts of data resulting
from its daily activities but provide limited capability for reporting on the data.

Open Database Connectivity (ODBC). Standardized application programming
interface (API) technology that allows applications to access multiple third-party
databases.

outline. The structure that defines all elements of a database within Hyperion
Essbase. For example, an outline contains definitions of dimensions, members,
and formulas.

parent. A member that has an aggregated branch below it.

pass-through transformations. In Hyperion Integration Server, afeature that
allows you to use functions specific to your relational database management
system (RDBMS) to extract data valuesfor columns. Y ou can provide a statement
that Hyperion Integration Server passes through to your RDBMS as a part of the
SQL SELECT statement. Y ou provide the statement as a property of acolumn and
the pass-through feature returns a value for the column.

permission. A specia privilegethat must be assigned to users or groupsto enable
them to access or modify secure data. Permissions include Read, Read/Write and
None.

physical column. A column that is stored in arelational database. See also
column. Contrast with logical column.

physical table. A combination of rows and columns stored in arelational
database. Contrast with logical table.

pointer. Inrelational databases, adata element that indicates the location of data
in storage.

primary dimension table. A dimension tablethat joinsdirectly to the fact table.
Additional dimension tables may join to the primary dimension table to create a
dimension branch.

primary key. Inrelational databases, acolumn (key) that uniquely identifiesa
row. For example, Employee ID.
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qguery governor. In Hyperion Integration Server, a parameter that you set to
control the time and size of the queries made to the data source.

RDBMS. Seerelationa database management system.

record. A set of information in a data source. Records are composed of fields,
each of which contains one item of information. A set of records constitutes a
table. A single record constitutes arow in the table. For example, atable
containing personnel information might contain records (rows) that have three
fields: aNAME field, an ADDRESS field, and a PHONE_NUMBER field.

recursivetable. A source relational table that contains information in one

row that is a parent or child of information in another row. For example, in
arelational source table containing the columns EMPLOY EE_ID, NAME,

and MANAGER _ID, the columns EMPLOYEE_ID and MANAGER _ID are
recursive because MANAGER_ID refers back to the EMPLOYEE_ID. Using
Hyperion Integration Server, you can build a Hyperion Essbase outline hierarchy
from arecursive source table.

relational database. A type of database that stores datain the form of related
tables. A single database can be spread across several tables, and can beviewed in
many different ways. Contrast with multidimensional database.

relational database management system (RDBM S, DBMS). A system for
accessing datain arelational database. Thisterm is often used to describe systems
for management of multiple relational databases or tables.

restructure. In Hyperion Essbase, an operation to regenerate or rebuild the
database index and, in some cases, the data files.

right frame. Inthe Hyperion Integration Server Desktop OLAP Metaoutline
main window, the areaon theright, in which you build ametaoutling; Inthe OLAP
Model main window, the area on the right, in which you build an OLAP model.

roll-up. See consolidate.

schema. In relational databases, alogical model that represents the data and the
relationships between the data.

server. See Essbase OLAP server, OLAP Integration Server.

shared member. A member that shares storage space with another member of the
same name. The shared member has a property that designates it as shared. The
use of shared members prevents duplicate cal culation of members that appear
more than once in a Hyperion Essbase outline.
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sibling. A child member with the same parent as another child member. For
example, the members East and West are both children of the Markets dimension
and siblings of each other.

sparsedimension. A dimension unlikely to contain data for all combinations of
dimension members. For example, product and market dimensions are sparse if
not all products are sold in all markets. Contrast with dense dimension.

SQL. See Structured Query Language.

staging area. A database that you create to meet the needs of a specific
application. A staging areais a snapshot or restructured version of one or more
RDBM Ss.

standard dimension. A dimension that is not an attribute dimension.

star schema. InHyperion Integration Server, alogical model that representsyour
relational datain aform that mirrors OLAP. A star schema contains a fact table
and one or more dimension tables.

storage manager. See Hyperion Essbase kernel.
string. A sequence of characters treated as a unit.

Structured Query Language (SQL). A computer language used to access data
in relational databases.

supervisor. A defined type of user who has full accessto all applications,
databases, related files, and security mechanisms for a server.

system administrator. A person who maintains the hardware, software, disk
space distribution, and configurations for running software applications such as
Hyperion Essbase.

table. Inrelational databases, aform of data storage in which datais stored in
rows and columns.

timedimension. A dimension type that defines how often datais collected and
updated, such as fiscal or calendar periods. Only one dimension may be tagged as
time; atime dimension is not required.

transformation rules. In Hyperion Integration Server, a set of instructions that
define how to change or reformat the member names and data you extract from the
source relational database.

two-pass calculation. A Hyperion Essbase property that is used to recalculate
members that are dependent on the calculated val ues of other members. Two-pass
members are calculated during a second pass through the database outline.
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UDA. Formerly called user-defined attribute. A UDA is aterm associated with
members of an outlineto describe aparticular characteristic of the members. Users
can specify UDAs within calc scripts and reports to return lists of members that
have the specified UDA associated with them. UDAs can be applied to dense as
well as sparse dimensions.

unary operator. A group of mathematical indicators (+, -, *, /, %) that define
how roll-ups take place on the database outline.

union. Inrelational databases, atype of join that combines the results of two
SELECT statements. A union is often used to merge lists of values contained in
two tables.

upper-level block. A type of datablock that is created for sparse member
combinations when at least one of the sparse membersis a parent-level member.

user-defined attribute. See UDA.

user-defined dimension. Dimensions that you explicitly create in Hyperion
Integration Server, rather than dimensions obtained or built from the relational
data source.

user -defined member. Members that you explicitly create in Hyperion
Integration Server, rather than obtaining and building them from therelational data
source.

validation. (1) In Hyperion Essbase, aprocess of checking arulesfile against the
outline to make sure the rulesfile isvalid. (2) In Hyperion Integration Server, a
process of checking the OLAP model and metaoutine.

view. Inrelational databases, alogical table created by combining columns from
one or more tables.
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Sym bols — (dashes), in dimension and member names, 3-28
' (single quotation mark), in dimension and member
names, 3-28
, (commas), in dimension and member names, 3-28

1= (not equd to) operator, 9-19

" (double quotation marks), in dimension and
member names, 3-28

#MISSING, as reserved word, 3-28

% (percent) operator, modulus function, 7-11 A
& (ampersand), in dimension and member names, access
3-28 o changing, for OLAP models, 3-25
() (parentheses), in dimension and member names, specifying for OLAP models, 3-24
328 accessing
* (asterisks), in dimension and member names, 3-28 data sources, 3-4, 3-5
+ (plussigns), in dimension and member names, 3-28 online help, xii
. (periods), in dimension and member names, 3-28 tablesin OLAP Metadata Catalog, 2-23
< (lessthan) - accounts dimension
in dimension and member names, 3-28 columns, adding to, 4-7
operator, 9-19 creating automatically, reasons for, 4-7
<= (lessthan or equal to) operator, 9-19 creating manually, 4-9
<> (not equal to) operator, 9-19 data types and, 5-10
<NONE> aggregation option, 6-18 defined, 4-8
= (equal signs) deleted columns, 5-10
in dimension and member names, 3-28 deleting, 5-16
= (equal to) operator, 9-19 dimension branches and, 5-6
> (greater than) operator, 9-19 effects of hiding or deleting columns, 6-6
>= (greater than or equal to) operator, 9-19 fact table, relation to, 4-4
@ (at signs), in dimension and member names, 3-28 graphic, 3-14
\ (backdlashes), in dimension and member names, hidden columns, 5-10
3-28 measures and, 4-8
_ (underscores) overview, 4-8
converting spacesto, 9-25 relationship to fact table, 5-10, 5-11
in dimension and member names, 3-28 rules for adding tables or views, 5-10
{} (braces), in dimension and member names, 3-28 sample hierarchy, 2-11
| (vertical bar), in dimension and member names, source tables and views to use, 4-8
3-28 switching with time dimension, 4-15
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use in Hyperion Essbase outline, 2-20
use in metaoutlines, 4-8
when not to create automatically, 4-7
Add Accounts Dimension command, 4-9
Add Joins mode
defined, 5-15
jointool, 3-13
joining tables, 8-6, 8-9
Add New Column to Table dialog box, 6-16
Add Time Dimension command, 4-11
aggregation
choosing level of, 2-2
defined, 1-3
filters, creating in metaoutlines, 9-14
options, defining for measures, 6-18
aliases
availahility of columns as, 6-6, 6-12
concatenating, 2-19
creating for dimension or member names, 2-19
defining, 8-16
member levels, 8-16
pass-through transformations and, 2-19
recursive tables and, 2-8, 8-16
All command, View > Model |cons menu, 6-5
ampersands (&), in dimension and member names,
3-28
ancestors, prefixing or suffixing names, 9-27
and, using to combine filter conditions, 9-21
ascending sort, hierarchies and, 9-22
asterisks (*), 3-28
at signs (@), in dimension and member names, 3-28
audience, for this guide, ix
automatic joins, how created, 4-4
AV G aggregation option, 6-18

B

backslashes (1), in dimension and member names,
3-28

batch processing, OLAP Command Interface, 1-9
bitmapped indexes, defined, 2-14
braces ({ }), in dimension and member names, 3-28
branches

dimension, defined, 5-5

recursive hierarchies and, 9-5

Index-2 M

C

calculations, Numeric data types and, 7-12
calendar, user-defined, example, 4-13
capitalization, changing, 9-25
case, changing, 9-25
case-sensitive names, 3-28
characters
forbidden at the beginning of aname, 3-28
maximum in dimension names, 3-28
maximum in member names, 3-28
child column
filtering example, 9-16
filtersand, 9-15
cleansing data, 2-6
clock graphic, 3-14
closing OLAP models, 3-27
collapsed view, source data, 3-14
column joins
adding, 8-10
changing, 8-12
defined, 8-1
deleting, 8-14
viewing, 8-7
Column Properties dialog box
adding user-defined columnsto dimensiontables,
6-17
General tab, 6-17
Transformation Rule tab
DateTime data type, 7-13
Numeric datatype, 7-10
pass-through transformations, 7-15
String data type (concatenations), 7-6
String data type (substrings), 7-3
Column Transformation command, View > Model
Icons menu, 6-5
column transformations
DateTime datatype, 7-12
graphicsfor, 6-5
Numeric datatype, 7-9
String data type as concatenation, 7-5
String data type as substring, 7-3
columns
accounts dimension, adding to, 4-7
adding, 6-14
availability, aliases, 2-19
capitalization, xi
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child, 8-15

combining, 7-5

defining as Drill-Through, 6-12
deleted, fact table and accounts dimension, 5-10
deleting, 5-16, 6-9

dimension tables, adding to, 5-8, 8-10
displaying names and properties, 6-4
displaying source keys, 3-16

fact table, adding to, 8-10

filtering, 9-14

fully-defined in recursive tables, 2-9
graphics, 6-5

graphics, displaying, 6-5

hidden, fact table and accounts dimension, 5-10
hiding, 6-6

indexes, 2-14

key, time-related, 4-12

measures, 5-10

multiple sources, 2-4, 4-4

multiple tables and, 5-7

parent, 8-15

renaming, 6-6

restricting, 9-14

rules for naming, 3-28

sorting in hierarchies, 9-22
timedatain, 4-15

time dimension and fact table, 5-10
time dimension, adding to, 4-7
time-related, defining in source data, 2-20
tipsfor joining, 8-8

transposing with rows, 2-10

Index

OLAP Metadata Catalog > Delete Locks
command, 3-31
consolidation
defined, 1-3
drill down and, 1-4
example, 1-3
hierarchies and, 9-3
members, 1-3
consolidation levels, dimension branches and, 5-5
consulting services, xv
conventions
naming, 3-28
used in this book, xiii
copying OLAP models, 3-27
COUNT aggregation option, 6-18
Create New Dimension dialog box
creating a standard dimension, 5-4
joining dimension table to the fact table, 8-6
manually creating atime dimension, 5-4
switching time and accounts dimensions, 4-17
Create New Table dialog box, 4-16
creating
automatic joins, 4-4
hierarchies, 2-8, 9-8
Hyperion Essbase databases, workflow, 1-10
indexes, 2-14
joins, 8-8
self joins, 8-19
standard dimensions, 5-3, 8-6
time dimension manually, 5-4
curly braces. See braces

Columns tab, Table Properties dialog box, 6-7
commas (,), in dimension and member names, 3-28

customer comparisons, 1-2

compound key, defined, 4-3 D

concatenation
aliases, 2-19 dashes (-), in dimension and member names, 3-28
example, 7-5 data

calculation operatorsin, 7-9
cleansing, 2-6
combining multiple sources, 2-4
problems with, 3-6 concatenation example, 7-6
to data sources or OLAP Metadata Catalog, 3-4, denormalizing, 2-12
35 drill down, 1-4
Connections menu ensuring consistency, 2-6

OLAP Metadata Catalog > Connect command, hiding values, 6-6
3-30 pass-through transformations on, 7-14

String data type transformations, 7-5
conditions, combining, 9-21
connecting
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pivoting to change view, 1-4
preparing for time analysis, 2-20
source preparation, 2-1
source, switching views, 3-16
transforming in columns, 7-1
transforming in data source, 2-14
transforming in hierarchies, 9-23
types of, 2-2
viewing hidden, 3-15
viewing source columns and keys, 3-16
data sources
accessing, 3-4, 3-5
build levels, 2-8
collapsed view, 3-14, 3-16
column quick-view, 3-18, 6-4
defining, 2-3
OLTP databases, 1-5
parent-child, 2-8
spreadshest files, 1-5
SQL, 1-5
text files, 1-5
viewing column names, 3-14
viewing column namesin left frame, 3-15
viewing column names in right frame, 3-15
workflow for transferring, 1-10
data types
accounts dimension and, 5-10
cleansing, 2-6
supported, 6-3
time dimension and, 5-10
user-defined columns, 6-14
viewablein OLAP Model, 6-3
column joins
See alsojoins
data values
See also measures
calculated using pass-through transformations,
7-14
numeric, 4-1
numeric, accounts dimension and, 4-8
prefixing, 9-26
replacing, 9-25
sorting, 9-22
suffixing, 9-26
transforming, 9-23
user-defined columns and, 7-1
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data warehouse, diagram, 2-5
database management systems, pass-through
transformation rules, 7-15
databases, multidimensional. See multidimensional
databases
databases. See data sources
Date Hierarchy dialog box, 6-11
dates
format, specifying, 7-14
formatting in source data, 2-21
parts, setting, 7-4
rows, in user-defined calendars, 4-14
DateTime data type
graphicsfor, 6-5
mapped to ODBC data types, 6-3
transforming columnsin dimension tables, 7-12
DB2, tables displayed in, 2-16
default dimensions, creating, 5-3
Deletean OLAP Model/Metaoutline dialog box, 3-30
Delete Locks command, 3-31
deleting
accounts dimensions, 5-16
columns, 5-16, 6-9
dimension table columns, 6-9
dimension tables, 5-16
fact table, 5-16
OLAP models, caution, 3-31
OLAP models, confirming, 3-31
OLAP models, open by other users, 3-25, 3-31
OLAP models, procedures, 3-30
denormalizing data, 2-12
descending sort, hierarchies and, 9-22
descriptions, entering for OLAP models, 3-24
desktop. See Hyperion Integration Server Desktop
detail data
choosing level of, 2-2
retrieving, 1-4
dialog boxes
Add New Column to Table, 6-16
Column Properties, 7-6, 7-10, 7-13, 7-15
Create New Dimension, 4-17, 5-4, 8-6
Create New Table, 4-16
Date Hierarchy, 6-11
Delete an OLAP Model/Metaoutline, 3-30
Edit Filter, 9-17
Edit Filter, Ordering tab, 9-22
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Edit Hierarchy, 9-9, 9-10, 9-12, 9-16
Edit Join Info, 8-7, 8-9
Edit OLAP Modd Transformations, 9-24, 9-27
OLAP Modd Assistant, 1-7, 3-7
OLAP Model Properties, 3-25, 3-26
OLAP Model Validation Errors, 3-19
Preview Filter Results, 9-29
Preview Transformations dialog box, 9-29
Recursion, 8-21
Sample Outline, 9-29
Save New OLAP Model, 3-23
Select Vaues, 9-18
TableProperties, 5-8, 5-13, 5-14, 6-9, 8-11, 8-14,
8-19
View Sample, 9-29
View Table Data, 3-17
dimension branches
consolidation levels and, 5-5
creating, 8-9
defined, 2-18, 5-5
diagrams, 5-5
fact table and, 5-6
levelsin, 5-5
time dimension and, 5-6
dimension hierarchies. See hierarchies
dimension names
creating aliases, 2-19
maximum length, 3-28
Dimension Properties dialog box
Hierarchies tab, 9-8
Member Info tab, 4-18
dimension table columns. See columns
dimension tables
adding columns, 6-14
adding to existing dimension tables, 8-10
defined, 1-12, 2-18
deleting, 5-16
deleting joins between, 8-14
deleting joins within, 8-14
joining, 8-6
joining to dimension tables, 8-9
joins between, 8-8, 8-14
moving, 5-15
names, changing, 5-15
OLAP models, 1-12
properties, viewing, 5-13

Index

relationship to fact table, 4-3
renaming, 5-15

rules for naming, 3-28

self joins, 8-19

source tables, adding to, 5-8
user-defined columns, 6-14
views, 5-10

dimensions

accounts, 4-8

adding tablesto, 5-7
choosing, 2-2

choosing tables for, 2-18
creating, 5-3

creating columnjoins, 8-7, 8-9
creating in ametaoutline, 1-13
creating standard, 8-6
defined, 1-3, 1-10, 2-18
examples, 1-3

frequency of change, 1-3
joining to fact table, 5-3
joining, about, 8-5
member hierarchies, 9-8
members, 1-3

names, changing, 5-14
naming, 3-28, 5-4, 8-7
prefixing name, 9-28
renaming, 5-14

rules for naming, 3-28
Scenario, 1-13

standard, creating, 5-3
standard, defined, 5-1
suffixing name, 9-28

time, 4-9

time, when required, 4-9
usein consolidation, 1-3
using in metaoutlines, 1-12
viewing, 5-14

dimensions and members, 3-28
directories

default OLAP Model, 3-3
is, 3-3

documentation

Hyperion Essbase Spreadsheet Add-in, xii
Hyperion Integration Server and Hyperion
Esshase, xi
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double quotation marks (*), in dimension and
member names, 3-28
drill down, 1-4
drill up, 1-4
Drill-Through columns
defining, 6-12
graphicsfor, 6-5
Drill-Through command, View > Model Icons menu,
6-5
Dynamic Time Series, 7-4

E

Edit Filter dialog box, 9-17
Edit Filter dialog box, Ordering tab, 9-22
Edit Hierarchy diaog box, 9-9, 9-10, 9-12, 9-16
Edit Join Info dialog box, 8-7, 8-9
Edit OLAP Model Transformations dialog box
Prefix/Suffix tab, 9-27
Replace tab, 9-24
equal signs (=) in dimension and member names,
3-28
equal to operator (=), 9-19
examples, 9-7
Exclusive Access
saving with, 3-21
executable name
for Hyperion Integration Server Desktop, 3-3
for OLAP Model, 3-3

F

fact table
accounts dimension, relation to, 4-4
adding tablesto, 5-4
adding to, 8-10
as basis for creating time dimension, 4-11
choosing tables for, 2-17
compared with dimensions, 2-2
compound key, 4-3
contents of, 4-4
creating, 4-6
defined, 1-12, 2-17, 4-3
deleting, 5-16
diagram, 4-3
dimension branches and, 5-6
graphic, 3-14

Index-6 M

hidden or deleted columns, 5-11
joining columns from newly added tables or
views, 5-12, 8-11
joining dimensions, 8-6
measures and, 2-17, 4-3
name, automatic, 4-6
name, changing, 5-14
options for completing, 4-8
properties, viewing, 5-13
relationship
to accounts dimension, 4-7, 5-10, 5-11
to dimension tables, 4-3
to time dimension, 5-11
renaming, 5-14
requirement for, 4-4
rolein OLAP model, 1-12
rules for adding tables or views, 5-11
tables, adding to, 5-11, 5-12
time dimension and, 4-10
facts, defined, 1-10
File menu
Delete command, 3-30
New command, 3-4
Open command, 3-4
Print command, 3-29
Save As command, 3-22, 3-27
Validate command, 3-18
Filter command, View > Model |cons menu, 6-5
filters
changing, 9-14
child column and, 9-15
combining conditions, 9-21
components of, 9-14
condition operators, 9-19
example, 9-14
graphicsfor, 6-5
hierarchy, 9-14
indexes on columns, 2-14
metaoutlines and, 9-14
operators and, 9-19
order performed, 9-22
parent column and, 9-15
recursive tables and, 9-15
SQL, 9-17
viewing results, 9-28
fiscal year, non-standard, 4-12, 4-14
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flat files

as adata source, 2-3

combining with SQL data sources, 2-4
forecasting, 1-4
formatting dates, specifying, 7-14
fully defined columns, defined, 2-9
functions, pass-through, 7-16

G

general ledger
data, 2-22
switching time and accounts, 4-15
General tab
Column Properties dialog box, 6-17
OLAP Mode Properties dialog box, 3-25

grandparent, prefixing or suffixing name, 9-27

graphics
accounts dimension, 3-14
column transformation, 6-5
column, displaying, 6-5
columns, 6-5
DateTime column, 6-5
Drill-Through column, 6-5
fact table, 3-14
filter column, 6-5
hidden column, 6-5
hierarchy transformation, 6-5
join column, 6-5
Numeric columnsin the fact table, 6-5

Numeric columns not in the fact table, 6-5

OLAP model components, 3-14
primary key column, 6-5
standard dimension, 3-14
String column, 6-5
time dimension clock, 3-14
greater than operator (>), 9-19
greater than or equal to operator (>=), 9-19

H

Help menu, Help Topics command, xii
help, accessing onlineg, xii

Hidden Column command, View > Model |cons

menu, 6-5
hidden columns
accounts dimension, 5-10
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defining, 6-6
fact table, 5-10
graphicsfor, 6-5

hierarchies
adding a data value prefix or suffix, 9-27
adding or editing, 9-9, 9-12
ascending sort and, 9-22
building from recursive tables, 2-8
changing data value character case, 9-25
components of, 9-3
consolidation and, 1-3, 9-3
converting spaces to underscores, 9-25
creating, 2-8, 9-8

Index

data sources for building to a specific level, 2-8

data value transformations, defined, 9-23
defined, 9-1

deleting, 9-11

descending sort and, 9-22

editing, 9-11

filter example, 9-21

filter operators, 9-19

filters, 9-14

filters, components of, 9-14
Hyperion Essbase, 9-3

inheritance, 9-14

metaoutlines, 9-1

naming, 9-9

omitting leading or trailing spaces, 9-25
operators, specifying, 9-19

ragged, 9-7

recursive and branches, 9-5
recursive tables, 9-4

replacing column data values, 9-25
sorting, 9-22

specifying filter conditions, 9-17
time dimensions, 4-10
transformation and, 9-23
transformation, graphicsfor, 6-5
using in metaoutlines, 9-4
viewing, 9-8

Hierarchies tab, Dimension Properties dialog box,

9-8
hierarchy filters, combining, 9-21

Hierarchy Transformation command, View > Model

Icons menu, 6-5
Hyperion Essbase
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accounts dimension, 2-20
databases, workflow, 1-10
designing a database for user needs, 2-2
documentation, Xi
hierarchies, 9-3
hierarchies, creating, 2-8
OLAP Server, defined, 1-2
overview of, 1-3
users, 1-3
Hyperion Essbase outlines, 9-14, 9-23, 9-28
Hyperion Integration Server
components, 1-8
data warehouse, 2-5
defined, 1-5
documentation, xi
OLAP Command Interface, defined, 1-9
OLAP Metadata Catalog, defined, 1-9
OLAP Modd, defined, 1-8
product family
defined, 1-5
diagram, 1-7
workflow, 1-10
standard user interface, defined, 1-8
workflow, 1-6, 1-10, 1-13
Hyperion Integration Server Desktop
defined, 1-1
executable name, 3-3
hyphens (=) in dimension and member names, 3-28

icons, OLAP Model startup, 3-3
in operator, 9-19
indenting, 1-3
indexes, working with, 2-14, 2-15
inheritance, hierarchies and, 9-14
initial capitalization, setting, 9-25
Integration Server. See Hyperion Integration Server
integrity constraints, cleansing data, 2-6
intersections, defined, 1-3
invalid OLAP models

correcting, 3-19

saving, 3-20
is directory, 3-3
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J

join columns
defined, 8-3
deleting, 8-14
graphicsfor, 6-5
multiple sets, 8-4
Join command, View > Model Icons menu, 6-5
joinlines, 8-5
Join tool
using to join tables, 8-6
join tool
Add Joins mode, 3-13
description, 3-13
Move mode, 3-13
joins
adding column joins, 8-10, 8-14
dliasesin recursive tables, 8-17
automatic, 4-4
between dimension tables, 8-8
changing, 8-3, 8-14
creating, 8-8
defined, 8-1
deleting, 5-16
deleting between dimension tables, 8-14
deleting column joins, 8-14
deleting within dimension tables, 8-14
joining atableto itself, 8-15
joining tablesin your RDBMS, 2-13
multiple, 8-4
natural, defined, 4-4
OLAP models, 8-5
overview, 8-3
properties, viewing, 8-5
recursive, 8-19
reducing through denormalization, 2-13
tool tips and, 8-6
UDAsand, 8-17
unions, removing, 2-10
viewing, 8-6

K

keys
columns, transformations and, 2-15
compound, defined, 4-3
foreign, 4-4
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primary, 4-4
viewing source columns, 3-16

L

|eft frame, 3-14
legacy data
preparing, 2-22
switching time and accounts, 4-15
less than operator (<), 9-19
less than or equal to operator (<=), 9-19
lessthan signs (<), in dimension and member names,
3-28
levels
data sources for building, 2-8
dimension branches and, 5-5
in OLAP models, 5-5
time hierarchy, 4-11
like operator, 9-19
logical model, description, 1-10
lower case, setting, 9-25

M

MAX aggregation option, 6-18
measures
accounts dimension and, 4-8
bitmapped indexes and, 2-14
creating filtersin metaoutlines, 9-14
data, associating with time periods, 2-20
defined, 2-3
examples of, 4-1
fact tableand, 2-17
values, 4-3
Member Info tab, Dimension Properties dialog box,
4-18
member levels
aliasesfor, 8-16
UDAsfor, 8-16
member names
creating aliases, 2-19
maximum length, 3-28
members
consolidation, 1-3
creating filtersin metaoutlines, 9-14
defined, 1-3
dimensions, 1-3
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examples, 1-3
naming, 3-28
OLAP models, 1-3
rules for naming, 3-28
menu
bar, defined, 3-13
right-click, 3-13
metadata
accessing OLAP Metadata Catalog, 2-23
defined, 1-9
metadata repository. See OLAP Metadata Catal og
metadata, OLAP Metadata Catalog storage, 1-9
metaoutlines
and invalid OLAP models, 3-25
creating dimensions, 1-12
defined, 1-8
defining time structure, 4-9
filtersand, 9-14
Hyperion Integration Server sample, xi
invalid OLAP models and, 3-25
printing, 3-29
saving with Exclusive Access, 3-21
MIN aggregation option, 6-18
minus signs (-), in dimension and member names,
3-28
#MISSING, as reserved word, 3-28
models. See OLAP models
modulus function, 7-11
monthly total, 4-9
Move mode
defined, 5-15
join tool, 3-13
multidimensional databases
defined, 1-3
source data, 1-5
uses, 1-3
workflow, 1-5, 1-10
multiple
columns, selecting, 6-8
joins, 8-4

N

names
dimension tables, changing, 5-15
dimension, changing, 5-14
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displaying column names in dimension tables,
6-4
fact table, 4-6
fact table, changing, 5-14
prefixing, 9-27
suffixing, 9-27
naming
conventions, 3-28
dimensions, 3-28
hierarchies, 9-9
members, 3-28
natura join, defined, 4-4
NETPRICE example, 7-9
<NONE> aggregation option, 6-18
non-NULL values, consolidation of, 6-18
normalized data, denormalizing, 2-12
not equal to operator (<>), 9-19
not in operator, 9-19
not like operator, 9-19
null parents, recursive hierarchies and, 9-5
Numeric columns
graphicsin the fact table, 6-5
graphics not in the fact table, 6-5
numeric data
caculations and, 7-12
indexes and, 2-14
values, 4-1
Numeric datatype
column transformations, 7-9
mapped to ODBC data types, 6-3
transforming columns in dimension tables, 7-9

O

OobBC
SQL versions supported, 1-5
supported data types, 6-3
OLAP Architect. See OLAP Model
OLAP Catalog. See OLAP Metadata Catalog
OLAP Command Interface
batch processing, 1-9
defined, 1-9
OLAP Integration Server
connection problems, 3-6
defined, 1-9
OLAP Metadata Catalog

accessing tables, 2-23

configuring for ODBC, 1-9

connecting to, 3-30

connection problems, 3-6

defined, 1-9

locks, deleting, 3-31
OLAP Metaoutline Assistant, 1-8
OLAP metaoutlines

saving with Exclusive Access, 3-21
OLAP Modéd

choosing which tables are displayed, 2-16

defined, 1-8

executable file name, 3-3

|eft frame source tables and views, 3-12

main window, 3-11

right frame modeling area, 3-12

starting, 3-3

startup programs necessary, 3-3

uses, 1-1

using icon to start, 3-3

workflow to create an OLAP model, 1-13
OLAP Mode Assistant, 1-7, 3-7
OLAP Model main window, 1-11, 3-11
OLAP Model main window, illustration, 4-6
OLAP Model Properties dialog box

General tab, 3-25

Optimization tab, 3-26

Properties tab, 3-26
OLAP Mode Validation Errors dialog box, 3-19
OLAP models

accounts dimension, 4-8

choosing which tables are displayed, 2-16

closing, 3-27

columns, renaming, 6-6

components, 1-10, 1-11

compound key, 4-3

confirming a deletion, 3-31

copying, 3-27

creating, 1-8, 3-11

defined, 1-12

deleting, 3-30

deleting, caution, 3-31

dimension branches, 5-5

dimension tables, 1-12

dimensions, 1-3

dimensions, naming, 5-14
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entering a storable description, 3-24
fact table, 1-12
graphic illustration, 1-12
graphicsin, 3-14
hierarchies, 9-3
Hyperion Integration Server sample, xi
invalid, 3-25
joining dimensions to the fact table, 8-6
levelsin, 5-5
locks, deleting, 3-31
measures, 4-3
members, 1-3
prerequisites for creating, 1-13
Save As, using to save, 3-18
saving under adifferent name, 3-27
saving when closing, 3-27
specifying user access permissions, 3-24
time dimension, 4-9
validating manually, 3-18
validation errors, 3-19
validation, checks performed, 3-19
validation, conditions, 3-18
workflow, 1-13, 1-15
OLAP. See Online Analytical Processing
olaparch.exe file, using to start OLAP Model, 3-3
OLTP. See Online Transaction Processing
Online Analytical Processing (OLAP), defined, 1-2
online guide, displaying and searching, xii
online help, accessing and printing, xii
Online Transaction Processing (OLTP) data,
examples of contents, 1-5
operational data, 1-5
operators
filtersand, 9-19
specifying for Numeric column transformations,
7-9
Optimization tab, OLAP Model Properties dialog
box, 3-25
or, using to combine filter conditions, 9-21
Ordering tab, Edit Filter dialog box, 9-22
outlines. See Hyperion Esshase outlines;
metaoutlines

P

parent-child data source, 2-8
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parent-child tables
defining, 8-21
description, 9-7
examples, 9-7
joining atableto itself, 8-21
parentheses (), in dimension and member names,
3-28
parents
filtering example, 9-16
filtersand, 9-15
prefixing name, 9-27
recursive tables and, 9-5
suffixing name, 9-27
pass-through transformations
aliases and, 2-19
defined, 7-14
defining in OLAP model, 7-14
example, 7-16
functions, 7-15
percent operator (%), modulus function, 7-11
performance
bitmapped indexes and, 2-14
increasing through denormalization, 2-13
sorting and, 9-22
periodic reporting, 4-9
periods (.) in dimension and member names, 3-28
periods, time, examplein user-defined calendar, 4-12
permissions
required in the SQL data source, 2-16
saving metaoutlines and, 3-24
perspective, changing, 1-4
Physical Joinstab
joinsin adimension table, 8-14
Table Properties dialog box, 8-11, 8-14
pivoting, using to change dataview, 1-4
plussigns(+), in dimension and member names, 3-28
Prefix/Suffix tab, Edit OLAPModel Transformations
dialog box, 9-27
prefixes
data values, 9-26
names, ancestors, 9-27
prerequisites
for OLAP Moddl, ix
for using this guide, ix
Preview Filter Results dialog box, 9-29
Preview Transformation Results dialog box, 9-29
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previewing Hyperion Essbase outline, 9-28
primary dimension table, defined, 5-5, 8-6
primary key columns
defined, 4-3
graphicsfor, 6-5
Primary Key command, View > Model |cons menu,
6-5
Print button, OLAP Metaoutline toolbar, 3-29
printing metaoutlines, 3-29
privileges. See permissions
problems, connecting, 3-6
product code, example, 2-15
product comparisons, 1-2
properties
displaying column, 6-4
displayingjoin, 8-5
displaying table, 5-13
Propertiestab, OLAP Model Properties dialog box,
3-26

Q

quarterly totals, 4-9
quotation marks, in dimension and member names,
3-28

R

ragged hierarchies, 9-7
read access, setting, 3-24
read-only access, SQL data sources and, 2-16
Recursion dialog box, joining atable to itself, 8-21
recursive hierarchies

branches, 9-5

example, 9-5

filtersand, 9-15

multiple parents and, 9-5

null parents and, 9-5

shared members, example, 9-7
recursive hierarchies, shared members and, 9-5
recursive tables

adliases and, 2-8, 8-17

as sdlf joins, 8-15

creating Hyperion Esshase hierarchies from

recursive tables, 2-8
defined, 2-8, 8-15
defining for alias or UDAS, 2-8, 8-16

Index-12 M

description, 9-7
example, parent-child, 9-7
filtering on columns, 9-15
fully-defined columns for, 2-9
hierarchies and, 9-4
multiple, 8-17
rulesfor, 2-8
sdlf joinsand, 9-7
redundant data, denormalizing, 2-12
relational data sources
viewing column namesin left frame, 3-15
viewing column names in right frame, 3-15
viewing datain left frame, 3-15
relational databases. See data sources
relationship. Seejoins
removing. See deleting
renaming
columns, 6-6
dimension tables, 5-15
dimensions, 5-14
fact table, 5-14
Replace tab, Edit OLAP Model Transformations
dialog box, 9-24
repository. See OLAP Metadata Catalog
reserved words, 3-28
right-click menus, xiv, 3-13
roll-ups, defined, 1-3
rows, transposing with columns, 2-10

S

sample
applications, xi
hierarchy, accounts dimension, 2-11
metaoutline, description, xi
OLAP model, description, xi
Sample Outline dialog box, 9-29
Save New OLAP Model dialog box, 3-23
saving
OLAP models, open by other users, 3-22
OLAP models, using different name, 3-27
OLAP models, using Save As, 3-18
scenarios, 1-4
seasonal comparisons, example, 4-9
seasons, user-defined calendars and, 4-14
security
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SQL data sources, 2-16
views and, 2-6
SELECT
permission, 2-16
statements, combining, 2-10
Select Vaues dialog box, 9-18
self joins
creating, 8-19
joining atableto itself, 8-15
recursive tables and, 9-7
shared members, recursive hierarchies and, 9-5
Show Tables command, 3-16
Show Views command, 3-16
single quotation mark ("), in dimension and member
names, 3-28
skills required, for this guide, ix
snapshoat, staging area, 2-4
sorting
columnsin hierarchies, 9-22
data values, 9-22
filters, 9-22
hierarchies, 9-22
order performed, 9-22
viewing results, 9-28
source data
collapsing view, 3-16
column quick-view, 3-18, 6-4
denormalizing, 2-12
multidimensional databases, 1-5
switching views, 3-16
transforming, 2-14
viewable data types, 6-3
viewing column namesin left frame, 3-15
viewing column namesin right frame, 3-15
viewing columns and keys, 3-16
viewing hidden, 3-15
viewing in |eft frame, 3-15
sources. See data sources
spaces
converting to underscores, 9-25
deleting, 9-25
in dimension and member names, 3-28
spreadsheet files, data sources, 1-5
SQL
combining filter conditions, 9-21
data sources, 1-5
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filtersand, 9-17
pass-through transformations, 7-16
SQL 89, 1-5
versions supported, 1-5
viewable data types, 6-3
viewing sample, 9-29
WHERE clausesinfilters, 9-17
SQL data sources
combining, 2-4
combining flat files, 2-4
consolidating multiple, 2-3
read-only accessto, 2-16
required permission for, 2-16
security, 2-16
staging area, 2-4
SQL Drill-Through. See Drill-Through columns
staging area
advantages of, 2-4
deciding whether to create, 2-4
defined, 2-4
diagram, 2-5
Y 2K issues and, 2-5
standard dimensions
creating, 5-3, 8-6
graphic, 3-14
star schemas. See OLAP models
starting OLAP Model, 3-3
Status Bar, 3-13
stored procedures, pass-through transformations,
7-15
strategic planning, 1-4
String data type
columns as concatenations, 7-5
columns as substrings, 7-3
graphicsfor, 6-5
mapped to ODBC data types, 6-3
strings, replacing, 9-25
substrings, String data type transformations, 7-3
suffixes
data values, 9-26
names, ancestors, 9-27
SUM aggregation option, 6-18
summary source data, associating with time periods,
2-21
synonyms, viewing, 3-12
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T

tab character, in names, 3-28
Table Properties dial og box
Columnstab, 6-7, 6-9, 6-15
deleting columns, 6-9
Dimensionstab, 5-14
General tab, 5-13, 8-14
hiding columns, 6-7
joining atable to itself, 8-19
joining another table to adimension table, 8-11
Physical Joinstab, 5-8, 8-11, 8-14, 8-19
renaming dimension tables, 8-14
viewing from the fact table, 5-13
tables
See also dimension tables
accessing tablesin OLAP Metadata Catal og, 2-23
adding to dimension tables, 5-8
capitalization, xi
choosing which tables are displayed in OLAP
models, 2-16
collapsing view, 3-12
creating to denormalize data, 2-12
deciding whether to create new tables, 2-6
denormalizing, 2-12
expanding to show columns, 3-12
fact table, adding to, 5-11
joining, 2-13
reasons to create, 2-7
recursive
aliasesand, 2-8
as self joins, 8-15
defined, 2-8
fully-defined columns for, 2-9
rulesfor, 2-8
UDASs or dliases, 2-8
rules for naming, 3-28
viewing, 3-12
TBC, xi
TBC Metaoutline, xi
TBC Moddl, xi
TBC_MD, xi
text
files, data sources, 1-5
replacing, 9-25
time
analysis, preparing data for, 2-20
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associating with measures data, 2-20
data, columns, 4-15
time-related columns, defining in source data,
2-20
time dimension
clock graphic, 3-14
columns, adding, 4-7, 5-10
components of, 4-10
creating automatically, reasons for, 4-7
creating from fact table, 4-11
datatypes and, 5-10
defined, 2-20, 4-9
deleting, 5-16
dimension branches and, 5-6
examples, 4-9
hierarchies, 4-10, 7-12
hierarchy, default prefix for, 9-26
hierarchy, levels, 4-11
OLAP models, 4-9
overview, 4-9
prefix default value, 9-26
relationship to fact table, 5-11
requirements, 5-10
switching with accounts dimension, 4-15
tables, adding, 5-10
transformations, 7-12
use in Hyperion Essbase outline, 2-20
when required, 4-9
when to create automatically, 4-7
to-date totas, 7-4
tool tips, joinsand, 8-6
toolbar, 3-13
Toolbar command, 3-13
toals, join, 3-13
training services, xv
Transformation Rule tab, Column Properties dialog
box, 7-3, 7-6, 7-10, 7-13, 7-15
transformations
columns with Numeric data type, 7-9
datavaluesin hierarchies, 9-23
defining in OLAP models, 7-1
defining in SQL data sources, 2-15
example in data source, 2-15
hierarchies and, 9-23
indexes and, 2-15
key columns and, 2-15
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order performed, 9-22 values. See data values
pass-through, 7-14 variables, defined, 2-3
reviewing results, 9-28 vertical bar (| ), in dimension and member names,
rules for columns, 7-1 3-28
rules for columns, changing, 7-17 View All Columns command, 3-18
rules for DateTime columns, 7-12 View Columns command, 3-18, 6-4
rules for Numeric columns, 7-9 View menu
rules for String columns, 7-3, 7-5 Enable Join Tool Tips command, 8-6
transposing columns and rows, 2-10 Model Icons > All command, 6-5
trends, 1-2, 4-9 Properties> OLAP Model command, 3-26
troubleshooting, connecting, 3-6 Show Synonyms command, 3-12
Show Tables command, 3-12
U Show Views command, 3-12
Status Bar command, 3-13
UDAs Toolbar command, 3-13
defined, 8-16 View All Columns command, 3-18
member levels, 8-16 View Columns command, 3-18, 6-4
recursive tables, 2-8, 8-16 View Table Data command, 3-12
underscores (1) View Sample dialog box, 9-29
converting spaces to, 9-25 View Table Data command, 3-12
in dimension and member names, 3-28 View Table Data dialog box, 3-17
unions, removing, 2-10 views
UNIVERSE, asreserved word, 3-28 See also tables
unjoined dimension tables, 5-16 adding to dimension tables, 5-8
upper case, setting, 9-25 collapsing columns, 3-12
user needs, defining, 2-2 deciding whether to create new views, 2-6
user privileges. See permissions expanding to show columns, 3-12
user-defined attributes. See UDAS reasons to create, 2-7
user-defined calendar viewing, 3-12
defined, 4-12
determining need, 4-12 W
example, 4-13
table requirements, 4-12 weekly totals, 4-9
time-related key column, 4-12, 4-13 what if scenarios, example, 1-4
user-defined columns WHERE clausesin filters, 9-17
adding to dimension tables, 6-14 whitespace. See spaces
defined, 6-14 Windows Start menu, using to start OLAP Model,
user-defined dimensions, defined, 1-13 3-3
users, Hyperion Esshase, 1-3 wizard. See OLAP Model Assistant; OLAP
Metaoutline Assistant
V workflow
Hyperion Integration Server, 1-6
validation Hyperion Integration Server product family, 1-10
checks performed for OLAP models, 3-19 OLAP models, creating, 1-15
OLAP models, automatic, 3-18 write access, setting, 3-24
problems, 3-19

troubleshooting, 3-19
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Y

Y 2K issues and staging area, 2-5
yearly totals, 4-9

Z

zoom in. Seedrill down
zoom out. Seedrill up
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